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[1] Using the Monarch 
Documents 

The Monarch documentation consists of a Learning Guide and a Help file. 

Monarch Learning Guide 
The Monarch Learning Guide contains a short introduction to Monarch and Data Prep Studio, 
collectively called Monarch Complete, along with a series of lessons designed to quickly 
acquaint you with the program. The lessons will first introduce you to Data Prep Studio and 

continue with each of the Monarch views: Report, Table, Summary, and Export. Monarch Table 
Extractor, a new component available in Monarch version 14.2, is also discussed.  

Each of the chapters describes a major area of Monarch. First-time users will be well rewarded 
for the time they spend working through these sections. Advanced topics should be tackled 
after you become familiar with the basic concepts of Monarch, as these topics will leverage 
what you learned in previous sections. Each lesson should take from 20 to 30 minutes to 

complete. 

Monarch Help File 
The Monarch Help file provides detailed information and step-by-step instructions for 
performing numerous tasks in Monarch and Data Prep Studio. It also includes information on 

automating Monarch operations, preparing files for input to Monarch, and technical 
specifications. To access the file while within Monarch, select File, click on the drop-down 

button of the Help  menu, and then select Help Topics from the options that display. You 
can also launch relevant Help topics from within the Monarch windows by simply clicking the 

 button located on the upper right-hand corner of most views.   

Monarch Training 
Datawatch provides Monarch training courses to help anyone in your organization rapidly 
improve his or her Monarch proficiency skills. Available in locations around the country, these 
training classes are designed for all levels of expertise. Whether you are just getting started 
and need the basics, or you would like to hone your skills and learn new ways to use Monarch, 
Datawatch is ready to help you reach new levels of Monarch proficiency. Our objective is to 
help Monarch users succeed as quickly as possible. 

http://docs.datawatch.com/monarch/desktop/
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Taught by Datawatch’s seasoned staff of Monarch experts, the training courses guide you 
through all aspects of Monarch’s features and capabilities, including tips and techniques on 
effective, timesaving shortcuts. There is also a lab session at the end of class where you can 
bring in your own files and receive individual instruction and suggestions for using Monarch to 

meet your specific requirements. 

Monarch onsite training and personal web-based training courses are also available.  

To learn more about training, call the Training Department directly: 

 Phone: +1-800-445-3311 

 Email: training@datawatch.com 

Monarch Model Building Service 
Datawatch provides a model building service for its Monarch customers. Free up your time and 
let the Monarch experts create your models for you. Datawatch’s highly trained team of 
Monarch experts will work with you one on one to create a model that meets your 
specifications and satisfaction. 

Are you puzzled by a really complex report? Datawatch’s Monarch professionals will be happy 

to create your Monarch models for you. When you view your new Monarch model, you will be 
able to learn from the experts by viewing the way they have trapped your report, created 
calculated fields and filters, defined summaries, and more. Best of all, this is all done from 
your own report.  

To learn more about the Monarch Model Building Service, contact the Model Building Services 
team directly: 

 Phone: +1-978-441-2200 

 Email: model@datawatch.com  

mailto:training@datawatch.com
mailto:model@datawatch.com
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[2] Introducing Monarch  

What is the Monarch Application? 
Datawatch MonarchTM (Monarch) is a multi-component application that allows you to model 
and extract analytical assets from both structured and less-than-structured sources, such as 
PDFs, reports, and EDI streams, and then use the data obtained in a self-service manner on 

your desktop for broader analytical use. 

When a computer generates a report, it creates a report file that contains all of the characters 

and control codes required by a printer to produce the actual report printout. Monarch reads 
that same report file. Instead of producing a hardcopy printout with words and numbers 
frozen on the page, however, it creates a softcopy of the report on screen, with live data you 
can work with. 

Monarch reads report files created within any computing environment. These files are 
commonly known as print or spool files, but they are also referred to as text (TXT), formatted 
text, PRN, PDF, and SDF files. Monarch can also read a wide variety of input files, such as 

delimited (e.g., pipe, comma, semi-colon, etc.) text, HTML, MS-Excel, MS-Access, dBase, PDF, 
and XPS, among others, and is able to connect to OLE DB and ODBC sources.  

The complete features of your Monarch application depend on the license you purchased. In 
this learning guide, these licenses may be referred to as “Monarch versions.” Click here to 

learn more about the different Monarch licenses available.  

New Features in This Version 
In Monarch version 14.2, the Classic application includes the following new features: 

 Read and write SAS XPORT format files (.xpt, .stx) - This feature provides interoperability 
between SAS platforms and is the best overall format for interfacing with other systems as 
it is consistent over all host environments. Note that this feature is only available in 
Monarch Complete and Monarch Complete with Table Extractor. 

 Enhanced PDF Options – Addition of dynamic and static guides improves user ability to 
assess suitability and set the correct stretch factor; screen real estate is also maximized. 

 Extended support for EBCDIC - New encoding functionality simplifies seeking for correct 
encoding and line/record options for EBCDIC and other input documents. As well, the 
maximum line length (i.e., maximum width of EBCDIC files) has been increased to 65K 
characters. 

 Autorecovery for models and projects - Users no long have to worry about losing 
information when the Monarch application is accidentally terminated or crashes. 

 License check in/check out 

 Various bug fixes 

http://docs.datawatch.com/monarch/desktop/Introduction__The_Monarch_Application.htm
http://docs.datawatch.com/monarch/desktop/What_s_New_In_Monarch_v14.1.htm
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The Monarch Suite of Applications 
The table below describes all of the main functionalities available in Monarch Classic, Monarch 
Complete, Monarch Complete with Table Extractor, and Monarch for IBM Analytics. 

FUNCTIONALITY MONARCH 
COMPLETE 

MONARCH 
COMPLETE 

WITH TABLE 
EXTRACTOR 

MONARCH 
CLASSIC 

MONARCH FOR 
IBM 

ANALYTICS 

Open reports, databases, and 
webpages in Report view 

    

Open reports, databases, and 
webpages via the Select Data 
Source to Open dialog 

    

Create tables in Table view     

Perform table operations     

Create summaries in Summary 
view 

    

Perform summary operations     

Export to .csv, .pdf, .xls, .xlsx, 
etc.  

    

Export to Tableau data extract 
and QlikView QVX files 

    

Export to IBM Analytics 
(Watson Analytics, Cognos 
Analytics) 

    

Export to Tableau Server    

Export to Monarch Swarm    

Interface with Datawatch 
Designer 

    

Interface with Data Prep 
Studio 

    

Access to Datawatch Data 
Connectors 

    

Auto-Define button in Report 
view 

    

Access to Monarch Table 
Extractor 

   

 

If the functionality you desire is not included in your version of Monarch, contact Datawatch 
Sales to determine how you can best take advantage of all of Monarch's powerful data 
extraction and analysis features. 

mailto:sales@datawatch.com
mailto:sales@datawatch.com
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Note that unless otherwise specifically stated, the topics described in this learning guide are 
applicable to all versions of Monarch. 

The Monarch Workflow 
Figure 2-1 shows how report data flow through Monarch. A Monarch session begins when you 
load a report file into Report view. As the session unfolds, you can produce a variety of 
outputs from each window. The lessons in this guide correspond to the flow chart. You’ll learn 
how to bring a report into Monarch, and you will progress step-by-step through the tasks 
performed in each window. 

 

Input   Output 

   Report File 

  

Report View 

 View and explore report 
 Look things up (Find) 
 Use Report Index 
 Print pages 
 Copy to clipboard 

 Define data extraction template 

 
 
 

 

 

 

 Hardcopy printout of pages 
 Clipboard image of data copied from the 

report, with automatic formatting of the 
data when pasting into a worksheet 

 Export file in fixed width text or PDF 

format 

   Extracted data 

  

Table view 

 View extracted data 
 Apply filters to extracted data 
 Sort data 
 Calculate new fields 
 Copy to clipboard 
 Export selected records 

 Print selected records 

 

 

 

 

 Hardcopy printout of selected data in 
columnar report format 

 Clipboard image of data copied from the 
table, in both text and worksheet formats 

 Export file containing selected data, in a 
choice of formats, including XLS, XLSX, 
XLSM, PDF, ACCDB, MDB, DBF, HTML, 

TXT, DWX, XML, and delimited text. 

   Extracted data 

  

Summary Window 

 Analyze selected data 
 Copy data to the clipboard 
 Export analysis 

 Print analysis  

 

 

 

 

 Hardcopy printout of summary report  
 Clipboard image of summary (in both text 

and worksheet formats) 

 Export file containing selected data, in a 

choice of formats, including XLS, XLSX, 
XLSM, PDF, ACCDB, MDB, DBF, HTML, 
TXT, DWX, delimited text 

 

Figure 2-1. The Monarch flow chart.  
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Monarch reads both report files and data from database files and OLE DB/ODBC databases, 
and information from databases can be extracted, manipulated, analyzed, and transformed. It 
also allows users to access data from additional sources, share user-defined functions, and 
access data from files that are of the types XLS, XLSX, XLSM, PDF, XPS, DBF, DB, MDB, HTML, 

and delimited text, as well as any OLE DB- or ODBC-compliant data source, such as SQL 
Server, Oracle, and DB2 database management systems. 

 

Input  Output 

   Database data 

  

Table view 

 Import data from any 
XLS, XLSX, XLSM, MDB, 
DBF, delimited text file, 
or from any OLE 
DB/ODBC compliant data 

source 
 View imported data 
 Apply filters to data 
 Sort data 
 Calculate new fields 
 Copy to clipboard 
 Export selected records 

 Print selected records 

 

 

 

 

 

 

 Hardcopy printout of data in 
columnar report format 

 Clipboard image of data copied 
from the table, in both text and 
worksheet formats 

 Export file containing selected 
data, in a choice of formats 
including XLS, ACCDB, MDB, DBF, 
HTML, XLSX, XLSM, TXT, DWX, 
PDF, and delimited text 

   Imported data 
  

Summary Window 

 Analyze selected data 
 Copy data to clipboard. 
 Export analysis 

 Print analysis  

 

 

 

 

 Hardcopy printout of summary 
report  

 Clipboard image of summary (in 
both text and worksheet formats) 

 Export file containing selected 

data, in a choice of formats, 
including XLS, XLSX, XLSM, PDF, 
MDB, DBF, TXT, DWX, and 
delimited text 

 

Figure 2-2. The Monarch flow chart showing data imported from a database.  

Figure 2-2 shows how data imported from a database flows through Monarch. You may begin 
a Monarch session by either opening an XLS, XLSX, XLSM, MDB, ACCDB, DBF, or delimited 
text file, or by importing data from an OLE DB/ODBC data source. When importing from a 
database, you can use all of Monarch’s Table and Summary View capabilities to manipulate, 

transform, and analyze data. 

You can even combine data extracted from report files with database data through a 
mechanism called an external lookup.  

Note that as the capabilities of newer versions of Monarch improve, the expected outputs 
presented in this section may vary. The basic data flows, however, remain the same. 
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The Monarch Interfaces 
Monarch provides three distinct views of report data, each with its own interface. Each view 
provides a specific set of functions and operations that will allow you to extract, view, 
summarize, and export data.  

If you are using Monarch for IBM Analytics, you will not have to access the Summary and 
Export views and you will be unable to access Datawatch Designer through the Table or 
Summary views.  

REPORT VIEW 

When you load a report file, a softcopy of the report is displayed in Report view. 

 

Figure 2-3. The Report view of Datawatch Monarch. 

Report view displays opened reports and includes all of the tools you will need to work with 
them. It also allows you access to Report Design view, an interface through which you can 
create templates to extract data and create tables.  
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TABLE VIEW 

Data extracted from the report display in Table view.  

 

Figure 2-4. The Table view of Datawatch Monarch.  

Table view allows you to work with the table produced by your report templates. You can click 

Table Design to edit your table and its fields. All of the changes you make to a table (e.g., 
filters, sorts, functions, etc.) display in this view. If your Monarch license allows it, you will 
also be able to open tables in Datawatch Designer through this view.  

Some of the other activities you can perform in Table view include: 

 Set the active filter to limit the fields displayed 

 Set the active sort to sort fields 

 Auto-size columns 

 Hide or display fields 

 Find a specific field value 
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SUMMARY VIEW 

User-defined summaries, which analyze report data, are displayed in Summary view.  

 

Figure 2-5. The Summary view of Datawatch Monarch.  

Summary View allows you to work with summaries. From this View, you can also click 
Summary Design to create or edit summaries. 

From within Summary View, you can also do the following: 

 Navigate a summary 

 Zoom in or out 

 Automatically adjust column widths 

 Freeze panes 

 Collapse or expand a summary 

 Customize summary font and background 
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EXPORT VIEW 

Exports defined may be viewed in Export view. 

 

Figure 2-6. The Export view of Datawatch Monarch.  

From this window, you can also do the following: 

 Run exports 

 Create a new export 
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[3] Introducing Data Prep 
Studio 

What is the Data Prep Studio 
Application? 
Data Prep Studio is a Monarch component intended to provide users with rapid data 
preparation (data prep) capabilities. As a quick data prep solution, Data Prep Studio offers 
several powerful features, including: 

 Drag and drop parsing and extraction 

 Report discovery and data combination  

 Real-time data preparation 

 Export capability to several file types 

Data Prep Studio provides easy-to-use interfaces for you to: 

 Add data sources 

Data Prep Studio allows you to easily load information from databases, reports, and even 
HTML pages. Special Preview functionality allows you to review the information and 
improve data quality before committing these into the Data Prep Studio workspace. 

 Combine disparate data sources 

Data Prep Studio allows you to easily integrate information from various data sources.  

 Clean and transform your data 

Data Prep Studio’s data preparation capabilities include pre-built functions to quickly and 
consistently transform your data into clean, analysis-ready information. 
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New Features in This Version 
In Monarch version 14.2, the Data Prep Studio application includes the following new features: 

 Monarch Table Extractor - Identify tables in text-heavy reports, such as annual reports 
and prospectuses, select those you need, and export them to Data Prep Studio, ready for 
further data preparation.  

 Excel Explorer - A new dialog implemented when opening Excel files allows users to 
preview and view multi-sheet Excel files, treat named ranges as single or multiple sheets, 
and select custom options for each sheet or range as needed.  

 File reconciliation - Make data sharing and reuse easier by swapping or replacing data 

sources as necessary. Issues arising from changing or updating a file system are quickly 
flagged and resolved.  

 Join improvements - Join analysis can now be accessed from within the Join Configuration 
dialog. Create new joins from the Combine Data Stage with a single click. Allow joining on 
disparate data types. 

 Change list improvements - Data Prep Studio now allows changes to be moved up and 

down the Change History List, deleted, and grouped, thereby allowing users greater 
flexibility when preparing data for further analysis. 

 New dialog for Split Address Into Parts - The updated dialog allows extraction of up to six 
address lines as well as countries, and error codes. 

 Various UI/UX improvements  

 Various bug fixes 

Launching Data Prep Studio 
Data Prep Studio may be launched in a number of ways 

 Launching Monarch for the first time after installing it. 

 Selecting Start > All Programs > Datawatch Monarch 14 > Datawatch Data Prep Studio > 

Datawatch Data Prep Studio. 

 Selecting the Data Prep Studio and Open Table in Data Prep Studio buttons in 
Monarch’s Home and Table views, respectively. 

  

http://docs.datawatch.com/monarch/desktop/What_s_New_In_Monarch_v14.1.htm


 

 

Monarch 14.2 Learning Guide   13 

 

The Data Prep Studio Workflow 
Figure 3-1 illustrates a typical data prep workflow.  

 

Figure 3-1. The data prep workflow. 

All data prep operations are performed in a workspace. Workspaces (including all tables 
opened or created, joined, cleaned, and transformed) may be saved and loaded in future Data 

Prep Studio sessions. 

The Data Prep Studio Interface 
First-time Data Prep Studio users will find the Getting Started video especially helpful in 
learning about this application’s capabilities.  

This video displays the first time Monarch is launched as well as every time the application is 
started thereafter unless the Show at start up box located at the lower left-hand corner of 
the screen is unchecked.  
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Select Exit Tutorial to close this video window.  

 

Figure 3-2. The Getting Started video. 

THE START PAGE 

The Start Page displays when the application is launched and the Getting Started video is 

closed (by clicking Exit Tutorial)/disabled. Besides providing access to video tutorials and 
related documentation and support, the Start Page is your primary jumping-off point for 
bringing data into the current data prep session.  

 
Figure 3-3. The Data Prep Studio Start Page. 



 

 

Monarch 14.2 Learning Guide   15 

 

Data Prep Studio features one toolbar and several main screens. 

 

Figure 3-4. The Data Prep Studio toolbar. 

Each of these tools opens a unique window, dialog, or stage through which Data Prep Studio’s 
functions may be realized.  

THE SETTINGS DIALOGS 

You can specify application default or current workspace settings by clicking the Settings  

button located to the far right of the toolbar and selecting the appropriate option.  

Note that some application settings, folder tracking, for example, are applied only when Data 
Prep Studio is restarted. Also, settings are serialized from the last closed Data Prep Studio 

session. This means that when two concurrently running sessions of the application are closed, 
only settings from the session closed the last are saved and reflected when a new session is 
started. 

Application Default Settings allow you to specify row limits, default folders, conversion 
settings, and the like on a global level. 

 

Figure 3-5. The Application Default Settings dialog of Data Prep Studio. 

The Current Workspace Settings dialog allows you to specify workspace-level conversion and 
time-interval settings. 
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Figure 3-6. The Current Workspace Settings dialog of Data Prep Studio. 

Details on each of these settings may be obtained here. 

THE APPLICATION MENU 

The Application Menu  button displays a list of other Data Prep Studio commands you 
may wish to apply to the current Data Prep Studio session.  

 

Figure 3-7. The Applications Menu of Data Prep Studio. 

  

http://docs.datawatch.com/monarch/desktop/The_Settings_Dialog.htm
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Using this menu, you can: 

 Open a workspace  Work with change lists 

 Save a workspace  Switch to or open a table in Classic mode 

 Close a workspace  Exit Data Prep Studio 

THE PREVIEW DATA WINDOW 

The Preview Data window allows you to: 

 Open a file or a data source 

 Preview and confirm the data in the data source 

 Load a table into your workspace 

 

Figure 3-8. Data Prep Studio’s Preview Data window. 

Several tools are provided to enable you to open/preview more tables, select one or a group of 

tables, and close one or a group of tables. You can also append tables from the Preview Data 
window.  

 

 

Figure 3-9. The Preview Data window tools. 
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Tables are arranged according to their Data Source Group. This grouping system allows you 
to quickly select, deselect, and remove (close) tables in a group.  

 

Figure 3-10. The Beantown Data Source Group. 

The Search Data Source panel located on the upper right-hand corner of the Preview Data 
window allows you to search for specific tables by Data Source Type or Data Source Name. 

This functionality is especially useful when you wish to load just one or two tables from a large 
number of open data sources. 

 

Figure 3-11. The Search Data Source panel. 

THE TRANSFORM DIALOG 

You can quickly transform any table in the Prep Data window by clicking on the Transform 
button of the Data Prep Studio toolbar. Doing so launches a Select Transform Type dialog that 

will allow you to extract empty rows in the table, pivot/unpivot columns, group by specific 

columns, and remove duplicates.  

 

Figure 3-12. Data Prep Studio’s Transform dialog. 

When grouping columns, the following aggregation functions may be applied: 

 Number 

 Sum  Count 

 CountNotEmpty  Average 

 Maximum  Median 
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 Minimum  Don’t aggregate 

 Text 

 Count  CountNotEmpty 

 Maximum  Median 

 Minimum  Don’t aggregate 

 Date/Time 

 Count  CountNotEmpty 

 Maximum  Median 

 Minimum  Don’t aggregate  

THE PREP DATA WINDOW 

The Prep Data window allows you to transform columns. Pre-defined functions include convert, 
extract, clean, replace, and split capabilities, among others. 

 

Figure 3-13. Data Prep Studio’s Prep Data window. 
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THE COMBINE DATA STAGE 

The Combine Data stage is a switch on/switch off function that allows you to join two or more 
tables to create a new one. 

 

Figure 3-14. Data Prep Studio’s Combine Data stage. 

THE REPORT DISCOVERY WINDOW 

The Report Discovery window allows you to open report files and select specific fields from this 

report to create a table, which then becomes available in the Preview Data Window. 

 

Figure 3-15. Data Prep Studio’s Report Discovery window. 
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THE EXPORT DATA DIALOG 

The Export dialog allows you to export table data from Data Prep Studio to a number of 
different file types.  

  

Figure 3-16. Data Prep Studio’s Export dialog. 

Data Prep Studio Hotkeys 
Keyboard shortcuts (hotkeys) for the main toolbar are enabled in Data Prep Studio to help you 

quickly access the different windows. 

 

Figure 3-17. Data Prep Studio’s hotkeys. 

The following table describes the main hotkeys available in Data Prep Studio. 

USE THIS HOTKEY TO 

ALT + S Access the Start Page 

ALT + V Access the Preview Data window 

ALT + P Access the Prep Data window 

ALT + T Launch the Select Transform Type dialog 

ALT + C Access the Combine Data stage 

ALT + E Launch the Export Data dialog 

ALT + G Launch the Application Default Settings dialog 

ALT + F Launch the Application Menu 
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A detailed list of the keyboard shortcuts available in Data Prep Studio may be found here. 

Data Prep Studio Table Icons 
The right-hand side of tables displayed in the table lists of the Prep Data window is marked 
with icons to help you identify the table type. 

THIS ICON FUNCTION 

 
Marks a table.  

 
Marks a join.  

 
Marks an append.  

 
Marks a report.  

 
Marks a transformation.  

 
Marks a Monarch report node. 

http://docs.datawatch.com/monarch/desktop/DPS_Keyboard_Shortcuts.htm
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[4] Data Prep Studio Lessons 

Because most data prep needs may be addressed by Data Prep Studio, we begin this learning 
guide with lessons on how to work with this exciting add-on.  

 

Figure 4-1. The Data Prep Studio Start Page. 

Data Prep Studio supports a number of main functions: 

 Add data from a wide variety of data sources 

 Add data using the Datawatch Data Connectors 

 Join and append table data to create new data tables 

 Clean and transform tables for further operations 

 Export tables  

 Save and load workspaces 

Each of the lessons described in this section demonstrate how to use Data Prep Studio.  
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Before You Begin 
Throughout the lessons, we make the following assumptions: 

 Monarch Complete is properly installed and the Monarch program item is available when 
you start Windows. 

 The lesson files are installed and Monarch’s default Report, Model, and Project folders are 
configured to point to the lesson files (the Setup program ideally automatically assigns 
these defaults the first time you install the product but you may want to assign other 
folders instead). 

 You are using an operating system for which Monarch is certified.  

 The Date Format setting in Monarch has been set to M/D/Y to handle dates in the sample 
reports correctly.  

 

 

NOTE 

If you use a different OS, some slight deviations from the steps listed 
in the lessons will occur (e.g., the default paths, the appearance of 
screens, and other minor differences), but you can effectively 
complete the lessons on all versions of Windows that Monarch 
supports. 

 

   

 

This learning guide also assumes that you have copies of the following files stored in your 
computer: 

 Beantown.mdb 

 Payroll.mdb 

 Classic.pdf 

 Canaccord 042215.pdf 

These files are typically installed along with Monarch and are found in 

C:\Users\Public\Documents\Datawatch Monarch\Data and 
C:\Users\Public\Documents\Datawatch Monarch\Reports. If you do not have these file, you 
can download them from here. 

We begin our lessons by adding data to a Data Prep session. 

  

http://docs.datawatch.com/monarchpersonal/tutorial/DMP_TutorialFiles.zip
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Previewing and Adding Data to a Data 
Prep Session 
A Data Prep session begins by placing data, either from a preexisting table or from a table 
created through the Report Discovery window, to the Preview Data window.  

The following file types may be opened in Data Prep Studio: 

 Delimited text files (.csv)  Print files (.dat, .prn, .rpt, .txt) 

 Fixed text files (.txt)  PDF files (.pdf) 

 Microsoft Excel files (.xls, .xlsx)  XPS files (.xps) 

 Microsoft Access files (.mdb, .accdb)  HTML files (.htm, .html, .asp, .aspx) 

 JSON files (.json)  Log files (.log) 

 XML files (.xml)  Data Prep workspace files (.dpwx) 

ADDING DATA FROM A DATABASE FILE 

Steps: 

1. Launch Data Prep Studio. 

2. Select Open Data to display the Select Data Source to Open dialog. 

 

Figure 4-2. The Select Data Source to Open dialog. 
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3. Select the data source option Microsoft Access. 

4. In the Open dialog that displays, navigate to C:\Users\Public\Documents\Datawatch 
Monarch\Data, select Beantown.mdb, and then click Open. 

You are brought to the Preview Data window. Each of the tables that make up the 

database displays in this window.  

 

Figure 4-3. Tables brought into the Preview Data window. 

 

NOTE 

Letters beyond the 64th character are truncated when opening tables 
from Excel files with column names exceeding 64 characters because 

the Access driver used to read these files imposes a 64-character 
limit. 

 

   

 

5. Inspect the table you wish to open by clicking on its Preview  icon. In Figure 4-4, for 

example, a preview of the table Accounting is displayed.  
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Figure 4-4. Viewing the contents of the Accounting table. 

A set of panels showing information about the columns of the table, as well as a preview 
of the rows in the table, are shown. 

6. To view information about a column, select this column in the Column Information panel. 

Information about the column is also displayed on the Statistics panel. 

7. To hide the statistics panel, select the Hide Preview button.  

8. Load the table(s) into your Workspace by selecting the desired table(s) individually or 
clicking the Select All button to load all of the tables simultaneously and then clicking 

Load Selected Tables. 

The table(s) you selected become(s) available in the Prep Data window. 

In Figure 4-5, all three tables that make up the Beantown database were loaded into the 
workspace. Each table is presented in its own worksheet and displays on a single table 
panel.  
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Figure 4-5. Loading all of the tables in the Beantown database into the Prep Data window.  

Clicking on the drop-down buttons located to the right of these tables displays a context 
menu that will allow you to perform table operations, including change row limits, edit file 
paths, pin tables, and the like.  

A complete list of the actions that can be performed on tables may be found here. 

The bottom of the Prep Data window (see figure above) presents several options that will 

allow you to navigate through your tables easily.  

Note that while a database may contain any number of tables, only those tables you 

selected and loaded from the Preview Data window display in the Prep Data window. 

Limiting Rows 

You can change the number of rows Data Prep Studio loads on a global basis when it opens 

tables by selecting Settings  from the Data Prep Studio toolbar and then selecting 
Application Default Settings from the options that display. This setting may be found in the 

Row Limit tab. Note that while decreasing the row limit when opening tables can improve the 
performance of Data Prep Studio and speed up response times, this may also result in missed 
exceptions and problematic rows, particularly if these rows are not included in the limited row 

set. 

If you wish to change the row limit of a specific table that has been opened in the Prep Data 
window, click on the drop-down button located to the right of the table from the table selector 
and, from the options that display, select Load Options > Change Row Limit. 

If you wish to change the row limit of a table from the Preview Data window, select the Edit 

Source Row Limit  button and use the Edit Source Row Limit dialog that displays to do 
so.  

http://docs.datawatch.com/monarch/desktop/Working_with_the_Table_List.htm
http://docs.datawatch.com/monarch/desktop/Working_with_the_Table_List.htm
http://docs.datawatch.com/monarch/desktop/Working_with_the_Table_List.htm
http://docs.datawatch.com/monarch/desktop/Navigating_Tables.htm
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Changing File Paths 

You may wish to change the file path of an open table in the Prep Data window (e.g., a file 
with the same name is located in a different folder in your machine or network). To do so, 
click on the drop-down button located to the right of the table from the table selector and, 
from the options that display, select Load Options > Edit File Path. In the Open dialog that 

displays, navigate to the file you wish to use and then click Open. Note that you can only 
replace the contents of a table with those of another table with the same file extension. Data 
Prep Studio automatically detects the file extension of the open table to help guide your 
replacement choices.  

Editing Load Options 

When your table is one of several tables in an Access database or one of several worksheets in 
an Excel file, you can select a different table to open by clicking on the drop-down button 
located to the right of the table from the table selector and, from the options that display, 
selecting Load Options > Edit Load Options.  

For Access data sources, the following dialog displays: 

 

Figure 4-6. The Access Options dialog. 

Select the new table you wish to load from the drop-down list provided and then click OK. 

For Excel data sources, the following dialog displays: 

  

Figure 4-7. The Excel Options dialog. 

From the settings provided, specify those most applicable to the table you wish to open and 

then click OK.  
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For HTML tables, the following dialog displays: 

 

Figure 4-8. The HTML Options dialog. 

After specifying the necessary details, click OK.  

Pinning Tables 

When a table is pinned in the Prep Data window (i.e., click on the drop-down button located to 
the right of the table from the table selector and, from the options that display, select Load 
Options > Pin Table from the options that display) and the workspace is saved, a user 
without direct access to the table source may open the pinned table by opening this same 
workspace. When pinning a table, a user may also choose to pin the current rows opened 
(when a row limit has been set) or pin the entire data set.  

 

Figure 4-9. Pinning a table in the Prep Data window. 

This functionality allows data-sharing with users who do not necessarily have rights to the 
source systems required to create working tables. Note, however, that the pinned table cannot 
be refreshed by a user without access to the data source.  

Refreshing Table Data 

When a table (e.g., an Excel worksheet) is open in the Prep Data window of Data Prep Studio, 
you essentially have a snapshot of the current state of this table. When you or another user 
makes changes to this table, your table “snapshot” must be rebuilt to reflect these changes. 
To do so, click on the drop-down button located to the right of the table from the table 
selector and, from the options that display, select Refresh Data Table from the options that 

display. 

Note that tables obtained from drag-and-drop operations in web pages cannot be refreshed 

because such tables are not sourced from a file path or URL. In these tables, the Edit File 
Path and Refresh Data Table buttons are not available. 
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Saving Data Sources to the Data Source Library 

Data Prep Studio can save tables you opened in the Prep Data window the Data Source Library 
Library. From here, you can further choose to save the table to your local library or to the 
Monarch Swarm library. 

The Monarch Swarm Library includes all data source definitions and workspaces saved with the 

intention of sharing in Monarch Swarm. 

When you save a data source or table to this library, Data Prep Studio “remembers” the path 
or location of this source and applies it when the same is opened in another data prep session. 
Thus, you can use the Data Source library to access commonly-used data sources quickly and 
seamlessly without using the Open Data Source dialog, previewing the data source, and 
selecting individual tables to open.  

To save a data source to the Data Source library, go to the Prep Data window, click on the 

drop-down button of the table you want to save, and, from the options that display, select 
Load Options > Save in Library > Local or Monarch Swarm.  

To load a data source from the library, select the Open Library  icon from the Data Prep 
Studio toolbar or Open Library from the Select Data Source to Open dialog. This action 
launches the Library dialog.  

 

Figure 4-10. The Library dialog. 

To perform an action on any data source in this list, select it to activate it and then choose an 
operation to execute. You can edit the table path, load the data source, preview the data 
source, or delete the selected data source. 

More information on the Data Source Library may be found here. 

http://docs.datawatch.com/swarm/Monarch_Swarm_FactSheet.pdf
http://docs.datawatch.com/monarch/desktop/Working_with_the_Data_Library.htm
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ADDING DATA FROM A PDF REPORT 

The steps below describe how to open PDF reports in Data Prep Studio. 

Steps: 

1. Return to the Preview Data window and then select Add More Stuff. 

2. In the Select Data Source to Open dialog that displays, click PDF Report to display the 
Open dialog. 

3. Navigate to C:\Users\Public\Public Documents\Datawatch Monarch\Reports, select 
Classic.pdf, and then click Open. 

 
You are brought to the Report Discovery window. 

 

Figure 4-11. Loading Classic.pdf into the Report Discovery window. 

4. Automatically define fields by selecting the Auto Define  button on the 

toolbar. 
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Figure 4-12. Automatically defining fields in the Report Discovery window. 

You can also: 

 Define each column individually by double-clicking on a field.  

 

Figure 4-13. Defining individual fields in the Report Discovery window. 

  



 

 

34    Monarch 14.2 Learning Guide 

 

 Define a line by double-clicking on the margin beside the line you want to define. 

  

Figure 4-14. Defining a line in the Report Discovery window. 

 Initiate Report Discovery Advanced mode by right-clicking on the report area and 
then selecting Advanced Mode. This action changes the color of the report to green. 

   

Figure 4-15. Initiating Advanced mode in the Report Discovery window. 

Data Prep Studio will create a new column for each field that you define, and populate that 
column with similar field values. 
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5. Select Open in Data Prep Studio to complete document prep. The table you have just 
defined is added to the Preview Data window. 

  

Figure 4-16. The newly defined table in the Preview Data window. 

If you wish to make changes to your newly defined table after bringing it into the Preview 
Data window, you can either select Start Page > Recent Files and then click on 

Classic.pdf or click on the drop-down arrow beside the report name in the table list of the 
Prep Data window and then select Edit Report.  

Doing this will bring up the Report Discovery window once more and allow you to make 
additional changes to your table.  

6. Load this table into your workspace by selecting it and then clicking Load Selected 
Tables.  

 

 

NOTE 

You can perform some changes to the table extracted from a report, 
including change its column names and fill nulls with the value 

preceding the empty cell, in the Report Discovery window.  

These changes do NOT form part of the session’s Audit Trail 

(Change History) because the Report Discovery window is a 
settings panel that creates a new table from the settings selected. 
The Change History function of Data Prep Studio only tracks 
changes to existing tables. 

If you wish to apply more changes to a table you extracted using 
the Report Discovery window and have these changes tracked, 
open the table in the Prep Data window instead. 
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Figure 4-17. The newly defined table in the Prep Data window. 

Using Report Discovery Advanced Mode 

Instead of using Report Discovery’s Auto-define Fields function, you may wish to define 
fields yourself. This is done using Report Discovery’s Advanced Mode. 

Steps: 

1. In the Report Discovery window, right-click on the report and then select Advanced 
Mode.  

 

Figure 4-18. The Advanced Mode screen of the Report Discovery window  
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2. Hover over a character on the line you wish to mask. Ideally, this character will form part 
of your mask. 

3. Using your mouse, click on the character you wish to mask and cycle through the mask 
characters until you come to the correct one. Mask characters include: 

  – Any letter 

  – Any digit 

  – Any non-blank character 

  – Blank 

For example, starting from the first line with the Media type CD, go to the QTY column, 

hover your mouse over the first 4 that appears under this column and then click once to 

expose the  mask. 

4. If the mask is composed of several characters, move to the next character (the first blank 
space) and repeat Step 2. Do this step until the mask is completed. Notice that all lines 
containing the mask you have defined are highlighted. 

The figure below, for example, shows how you might mask the order lines of Classic.pdf.  

 

Figure 4-19. Viewing the results of the mask we created. 

The mask we created indicates that the details of any line with one number, two blanks, 
and a letter should be flagged and added to your table. 

5. Select Accept Mask Changes, and then click Accept on the Report Discovery window. 
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The table you have just defined is added to the Preview Data window. If you wish to load 
this table into your workspace, select it and then click Load Selected Tables. 

ADDING DATA FROM A WEBSITE 

Data Prep Studio is unique from other data prep software because it is capable of intuitively 
determining tables from webpages and recreating these in the Preview Data workspace.  

Steps: 

1. On your browser, go to the webpage http://www.nasdaq.com/extended-
trading/premarket-mostactive.aspx. 

This webpage displays, among others, a chart of the pre-market most active stocks listed 
in the NASDAQ, the second-largest stock exchange in the U.S.  

 

Figure 4-20. NASDAQ’s pre-market most active stocks webpage. 

2. Click your mouse anywhere one the webpage, taking care to avoid links, and then press 
CTRL + A on your keyboard to select the entire page.  

3. Using your mouse, drag and drop the contents of the webpage into the Preview Data 
window of Data Prep Studio.  

Data Prep Studio intelligently detects tables in webpages and recreates them so that they 
can be brought into the Prep Data window.  

http://www.nasdaq.com/extended-trading/premarket-mostactive.aspx
http://www.nasdaq.com/extended-trading/premarket-mostactive.aspx
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Figure 4-21. The newly defined table in the Preview Data window. 

You can also drag and drop tables from HTML files/pages directly into the Prep Data 
window or Combine Data stage.  

A preview of the table extracted by Data Prep Studio reveals the same table displayed in 
NASDAQ’s Pre-market Most Active Stocks webpage.  

 

Figure 4-22. Previewing the details of a table imported from a webpage. 

4. Select Load Selected Tables to open the newly defined table in the Prep Data window. 
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Figure 4-23. The newly defined table in the Prep Data window. 

Data Prep Studio allows you to open files stored on a web repository, such as Amazon S3, FTP, 

SFTP, and the like. To do so, click the Open from Web  button located at the bottom of 

the dialog. This action launches an Open Data Source from Web dialog wherein you can enter 
the URL of the webpage containing the table you wish to bring into Data Prep Studio.  

What’s the Difference between Dragging and Dropping Webpage Content 
and Using the Open from Web Dialog? 

The browser is not only a rendering engine, but also is a scripting engine. For HTML with no 

Javascript that is delivered in its complete form and rendered in the browser, the 
copy/drag/drop content will be the same as the content obtained directly from the URL. 

However, if the HTML contains Javascript, which dynamically inserts the tables as HTML when 
rendered on the browser, only the copy/drag/drop will contain dynamically created tables; the 
HTML obtained directly from the URL will not contain these tables. 

ADDING DATA FROM XML AND JSON FILES 

Data Prep Studio allows you to explore and open JSON and XML files. 

Steps: 

1. From the Preview Data window, select the Add More… button to launch the Select Data 
Source to Open dialog. 

2. Choose JSON (or XML). 
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3. In the Open dialog that displays, navigate to the location of the file you wish to open, 
select the file, and then click Open. 

The JSON Explorer displays. 

 

Figure 4-24. The JSON Explorer. A similar explorer is also available when opening XML files. 

XML and JSON files present a hierarchical arrangement of nodes or tables. Selecting a 

node (table) displays all of its fields on the right-hand side of the explorer and a preview 
of the data contained within it. When checked, the Use Simplified Column Names box 
located on the upper right-hand corner of the explorer instructs Monarch to eliminate 
extraneous characters (e.g., the @ sign) from column names.  
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Figure 4-25. The XML Explorer with a node selected.  

Selecting a node also shows the number of rows it contains if this number is more than 

one.  

4. Select a node to open by clicking on it. 

5. Select Row Expand Arrays or Column Expand Arrays to display JSON arrays into rows 
or columns, respectively.  

6. Select an Encoding Option if necessary.  

7. Click OK.  

Your table is loaded in the Preview Data window. You can select and add this table to your 
list of open tables as usual. For the rest of the exercises, however, this is not necessary.  
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ADDING DATA FROM MONARCH FILES 

Data Prep Studio allows you to work with existing Monarch models and projects. 

This means you can take advantage of the robust templating and extraction capabilities of 
Monarch Classic and use the pre-defined models to work with reports. 

However, note that tables that come from Monarch files behave differently from tables that 
come from other sources: 

 Tables associated with a Monarch file are not displayed on the Preview Data window. 

 Data from reports associated with a Monarch file table are displayed as tables on the Prep 
Data window but cannot be prepped. 

 

The following Monarch Classic features are translated in Data Prep Studio when you open a 
Monarch file: 

 Data captured via trap of all trap types 

 Models with multi-column regions 

 Models with formula-based calculated fields using all built-in Monarch functions 

 Models with lookup table calculated fields 

 Monarch projects that use with multiple reports 

 Monarch projects that use PDF reports 

 

The following Monarch Classic features are currently not supported in Data Prep Studio: 

 Monarch projects that use databases. If you attempt to open a Monarch project that uses 
a database, Data Prep Studio will display an error message 

 Summaries. Data Prep Studio will only display data as displayed on a Monarch table. 

 Filters. Data Prep Studio will load all of the data from a report and ignore any filters that 
have been defined in the Model. 

 External Lookups. Data Prep Studio will load all of the data and will ignore external 

lookups and the join logic associated with these. 

 User-defined functions. Fields that use user-defined functions are displayed in Data Prep 
Studio with null values. 

 External Models. External model definitions within a Monarch model are simply ignored 
when the model is imported into Data Prep Studio. 

 User-edited and runtime fields. Fields that use user-edit and runtime fields are displayed 
in Data Prep Studio with null values. 

 Sorts 

 Password-protected PDF files 
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 Special report-related functions 

 Project exports 

To open Monarch Files in Data Prep Studio, the following steps are applied. 

Steps: 

1. Select Open Data from the Start Page to launch the Select Data Source to Open dialog. 

2. Click Monarch File, and, from the Open dialog that displays, navigate to the folder in 
which your Monarch file resides, select it, and then click Open.  

If you open a Monarch model only, the model is displayed as a table in the Prep Data 
window. To view data, you must add at least one report that is compatible with this 
model. To do so, in the Prep Data window, click on drop-down located to the right of this 

main table and select Add Report.  

If you open a Monarch project, the model is displayed as the main table in the Prep Data 
window and all other tables obtained from the report associated with the project are displayed 
as sub-tables. 

More information on working with Monarch Files in Data Prep Studio can be found here. 

ADDING DATA FROM EXCEL FILES 

Excel files may be added to your workspace via the Select Data Source to Open dialog or 
simply dragging and dropping the file into the Start Page, Preview Data window, or Prep Data 
window. 

When opening Excel files, the Excel Explorer dialog displays. 

 

Figure 4-26. The Excel Explorer dialog. 

This dialog is used to specify which tables to open and how the data should be displayed. 
When the necessary specifications have been provided and Load Selected is clicked, the 
table(s) open as usual and they can be previewed and loaded to the Prep Data window. 

More information on the Excel Explorer dialog may be found here. 

http://docs.datawatch.com/monarch/desktop/Working_with_Monarch_Files.htm
http://docs.datawatch.com/monarch/desktop/Adding_Data_from_Excel_Files.htm


 

 

Monarch 14.2 Learning Guide   45 

 

USING THE RECENT FILES PANEL TO LOAD DATA 

Clicking on the Recent Files button located on the upper left-hand corner of the Start Page or 
the Preview Data window displays a panel from which you can view all recently opened 
workspaces, data sources, and tables. 

  

Figure 4-27. The Recent Files panel. 

 

 

NOTE 

The Recent Files panel is populated with data sources and tables 

opened from previous and the current data prep sessions. If you 
are using Data Prep Studio for the first time, no data sources and 
tables will display when you expand this panel.  

 

 

Selecting any item in this panel opens the related data source or table. This functionality 
allows you faster access to your data and eliminates the need for repeated launching of the 
Select Data Source to Open dialog just to load more data to the current data prep session.  

When clicking on an item in the Recent Data Sources panel, say, an MDB file, all of the 
tables included in this file are loaded into the Preview Data window and made available for 
bringing into the Prep Data window. In Figure 4-28, we selected Beantown.mdb from the 

Recent Data Sources panel. All three tables included in this database file are loaded into the 
Preview Data window. From here, you can select which table(s) to open in the Prep Data 
window as usual.  
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Figure 4-28. Opening Beantown.mdb from the Recent Data Sources Panel. 

Items in the Recent Data Sources panel may be closed (i.e., removed from the data sources 
list) by hovering your mouse on the data source you want to close and then clicking on the 

Remove  button that appears to its right.  

When an item is selected from the Recent Tables panel, only this item is opened and loaded 

into the Preview Data window. As in the previous case, items in this panel may be closed by 

hovering your mouse on the table you want to close and then clicking on the Remove  
button that appears to its right.  

DISPLAYING RECENT DATA SOURCES IN THE SELECT DATA 
SOURCE TO OPEN DIALOG 

You can view and open recently opened data sources in the Select Data Source to Open dialog 

by hovering on a file type option in the dialog. Doing so causes a drop-down arrow to appear 
at the bottom right-hand corner of the option box.  

 

 

NOTE 

If no drop-down arrow displays when you hover over a file type 
option in the Select Data Source to Open dialog, no files of this 
type were recently opened.  
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Figure 4-29. Viewing recently opened data sources via the Select Data Source to Open dialog. 

Clicking on this arrow produces a list of recently opened files belonging to this file type. Select 
any item on this list to load it into the Preview Data window. Close data sources (i.e., remove 
them from the list) by hovering your mouse on the data source file you want to close and then 

clicking on the Remove  button that appears to its right.  

 

Figure 4-30. Closing a recently opened data source via the Select Data Source to Open dialog. 

Now that we know how to open data from a table, report, and webpage into the Add Window, 
we’ll explore how to open data from other database types using the Datawatch Data 
Connectors. Let’s save our current workspace and open a new one. 
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Saving a Workspace 
Your workspace includes: 

 The data tables you have loaded 

 The join and append definitions you have created 

 The transform operations you have carried out 

 The change histories of the tables you opened 

You can save your workspace anytime as a Data Prep Workspace file (*.dpwx), and you can 
load this workspace in future Data Prep Studio sessions to continue preparing your data.  

Learn more about your workspace here. 

Steps: 

1. Select the Application Menu  button from the Prep Data window and, from the menu 

that displays, select Save Workspace. 

2. Select one of the following: 

 Save the workspace on your computer 

 Save the workspace on your computer with a different name 

 Save the workspace with a password 

 Save the workspace with a different name and password 

 Save the workspace to the Monarch Swarm Library 

3. In the Save As dialog that displays, navigate to the folder in which you want to save the 
workspace, enter Workspace1 into the File name field, and then select Save. 

4. If you opted to save the workspace with a password, enter and confirm this password in 
the next dialog that displays. Select OK when you are finished.  

5. Close the current workspace by selecting Application Menu  > Close Workspace. 

  

http://docs.datawatch.com/monarch/desktop/About_Your_Workspace.htm
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Using the Datawatch Data Connectors 
Data Prep Studio allows you direct access to a wide variety of database types through a set of 
built-in data connectors.  

   

Figure 4-31. The Datawatch data connectors. 

Data Prep Studio allows you to access data from the following database sources:  

 Microsoft Access  Oracle 

 IBM Cloudant  Salesforce 

 DB2  SQL Server 

 Informix  Splunk 

 Microsoft Excel  Monarch Server – Content 

 MySQL  OLEDB 

 Oracle  ODBC 

 Google Analytics  

It also allows you to access data from the following big data sources: 

 IBM Cloudant  Cloudera Impala 

 MongoDB  Sybase IQ 

 Amazon Redshift  Hadoop Hive 
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Finally, data from other sources, such as Business Objects Universe and OData, are also 
supported in Data Prep Studio. 

To connect to any of these sources quickly and successfully, Data Prep Studio makes use of 
data connectors.  

To obtain access to data using this connector, specific information, including host name, 
server name, user ID, password, and database name, among others, is necessary. Which 
information you need will depend on the database to which you are attempting to connect. If 
you wish to use any of the data connectors, contact your database administrator to obtain the 
necessary connection details.  

ADDING DATA FROM DB2, INFORMIX, MYSQL, ORACLE, 
POSTGRESQL, SQL SERVER, HADOOP HIVE, CLOUDERA IMPALA, 
AMAZON REDSHIFT, AND SYBASEIQ 

The connection dialogs for DB2, Informix, MySQL, Oracle, PostgreSQL, SQL Server, Hadoop 

Hive, Cloudera Impala, Amazon Redshift, and SybaseIQ are similar, although some data 
connections may require more information than others.  

Connecting to an Oracle database, for example, will require you to choose between the 
Standard or TNSNames connection types; if you choose the Standard connection type, you will 
need to provide an SID name or service name besides a hostname, user ID, password, and 
edition name. If you choose the TNSNames connection type, you will need to provide a 
TNSNames file name. Connecting to a SQL Server will require you to choose between Windows 

authentication and username/password authentication.  

The following typical example describes how to access data from an Apache Hadoop Hive 
database using the relevant Datawatch Data Connector. If you do not have information to 
access a Hadoop Hive database at the moment, simply follow along with this tutorial.  

Note that this section simply demonstrates how to use the connector; thus, the tables we 
opened previously will not appear in the Preview Data window until we load the workspace we 

saved in the previous section.  
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Steps: 

1. From the Start Page, select Open Data.  

2. In the Select Data Source to Open dialog that displays, select Hadoop Hive. 

The Hadoop Hive Data Connection dialog displays. 

 

Figure 4-32. Initiating a connection with Hadoop Hive database. 

3. Enter the hostname, user ID, and password to the database you wish to connect to.  

4. From the drop-down box of the Hive Server Type field, select HiveServer2. 

5. Click Fetch Databases and then use the selector to choose a database to connect to.  

6. Click Load Tables to display a list of tables to open. 
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Figure 4-33. Displaying the tables of a Hadoop Hive database.  

7. Select a table from the table list.  

The fields of this table display in the Columns box. 

 

Figure 4-34. Selecting columns to add to a table.  
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8. Choose the field(s) to load by ticking their checkboxes in the Columns box.  

9. If you wish to parameterize (i.e., filter) or aggregate (group) the data in these fields, tick 
the relevant boxes and then select a parameter or aggregate type to apply from the drop-
down boxes provided.  

10. Select OK when you are finished. The table displays in the Preview Data window.  

This table can be selected and loaded into the Prep Data window as usual. 

CONNECTING TO IBM CLOUDANT 

The following steps detail how to connect to a database via IBM Cloudant 

Steps: 

1. From the Preview Data window of Data Prep Studio, select Add More Stuff. 

2. In the Select Data Source to Open dialog that displays, select IBM Cloudant. The IBM 
Cloudant Connection dialog displays 

3. Enter the account name or URL of the Cloudant account to which you wish to connect in 
the Cloudant Account or URL field. 

4. If you wish to connect to a specific database, check the box for Connect to a Specific 

Database and then specify the name of the database in the field adjacent to this box. If 
you wish to choose from a list of databases, skip this step. 

5. Enter the username and password into the appropriate boxes and then click Login. 

 

Figure 4-35. Connecting an IBM Cloudant database. 
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Upon successful connection: 

 The Database field displays the name of the database you specified in Step 4 or 

 The Database field’s drop down control is activated if you skipped Step 4; you can use 
this field to select a database to connect to. 

6. Select a view from the drop-down box provided. 

7. Specify other settings using the fields and boxes provided if you wish. 

8. Select Ok. 

The table(s) contained in the database you selected display(s) in the Preview Data 
window.  

These tables can be selected and loaded into the Prep Data window. 

CONNECTING TO ODATA 

The following steps describe how to connect to a database via OData. 

Steps: 

1. From the Preview Data window of Data Prep Studio, select Add More Stuff. 

2. In the Select Data Source to Open dialog that displays, select OData. 

The Odata Connection dialog displays. 

 

Figure 4-36. Initiating an OData connection. 
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3. Enter the collection list URL into the field provided. 

4. Place your cursor in the User ID field and specify a user ID and password if necessary. 

In the present example, we are using the Northwind database 
(http://services.odata.org/Northwind/Northwind.svc/), which requires no user ID or 

password.  

5. Select Retrieve. A list of tables displays in the Collections box.  

 

Figure 4-37. Selecting a collection (table) to open. 

6. Select a collection (table) from the list provided and, in the adjacent Query Parameters 

box, select Add.  

 

Figure 4-38. Selecting fields to open in Data Prep. 

http://services.odata.org/Northwind/Northwind.svc/
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7. From the drop-down list that appears in the Query Parameters box, select fields to add 
to your table. You may filter results by specifying an operator and required (filter) value if 
you wish. 

8. Continue clicking Add and repeating Step 7 until you are satisfied with your table.  

9. Select your desired decimal separator for numerical values. 

10. Click OK. 

The table you created displays in the Preview Data window.  

This table can be selected and loaded into the Prep Data window as usual.  

CONNECTING TO MONARCH SERVER – CONTENT 

The following steps describe how to connect to Monarch Server content. 

Steps: 

1. From the Preview Data window of Data Prep Studio, select Add More Stuff. 

2. In the Select Data Source to Open dialog that displays, select Monarch Server - 
Content. 

The Monarch Server - Content Connection dialog displays. 

 

Figure 4-39. The Monarch Server – Content Connection dialog.  

3. Enter the Monarch Server Client URL, Username, and Password in the fields provided 
and then click Connect when you are finished.  
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The contents of the dialog expand to enable you to choose a document type group, 
document type, model, report date range, report, view, and timezone.  

 

Figure 4-40. Connecting to Monarch Server.  

4. Using the drop-downs and boxes provided, specify the data table you wish to open and 
then click OK. 

The table/report you selected displays in the Preview Data window.  

This table/report can be selected and loaded into the Prep Data window as usual. 

 

 

NOTE 

The Monarch Server - Content connector for Data Prep Studio only 
functions if the Monarch Server security settings are set to 
Default. Other settings, such as Active Directory, are not yet 
supported in DPS.  
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CONNECTING TO BUSINESS OBJECTS UNIVERSE 

The following steps describe how to connect to data stored in Business Objects Universe.  

Steps: 

1. In the Preview Data window, select Add More… to launch the Select Data Source to Open 
dialog. 

2. Select Business Objects Universe from the list of other database types to open.  

The Business Objects Universe Connection Settings dialog displays.  

 

Figure 4-41. The Business Objects Universe connection dialog.  

3. Provide the hostname, port, Server, user ID, and password required to connect to the 
Business Objects Universe. If the port you wish to use is different from the default port, 
change the default value to the correct one. 

4. Select any of the following Authentication Types: 

 Enterprise 

 LDAP 

 WinAD 

 SAPR3 
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NOTE 

This list depends on what authorized providers are available for 
the BOU instance. 

 

 

5. Set the Request Timeout. 30 is the default. 

6. Click Connect to load the selected Universe. The directory path where the selected  

7. In the treeview of the loaded items, the following element types are displayed: 

 Folder or  

These are the logical groups of related objects. You can only select one folder (group) 
at a time.  

 Universe  

Maps to the data in the database. 

 Dimension  

Key objects to which queries are based on. 

 Business View  

These are semantic layers specific for Crystal reports. 

 Filter  

Used to limit the data that is returned. 

 Attribute (similar to Calculated columns)  

8. Perform quick searches for universes, measures, and dimensions in the Search box. 

 

 

NOTE 

Only the previously loaded subtrees can be looked up via quick 
searches when sub-trees are fetched on-demand. 

 

 

All of the selected items in the treeview are listed in the Selected Items box. 
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Figure 4-42. Displaying selected items in the Business Objects Universe connection dialog.  

9. You can modify the Display Name of an item. Also select a filter operator and parameter or 
delete an item in the list. 

10. The selected table with filters is displayed in the Filters box. These are stored in the 

Business Objects Universe. 

 

 

NOTE 

BOBJ (Business Objects) supports specifying custom filters either 

in the Filter box or a parameter can be set for any added Item in 
the Selected Items box. 

There is also a separate list for BOBJ predefined filters that you 

can use. 

 

 

11. Click the Validate button to ensure that your query is correct.  

12. Click OK to confirm the selection and retrieve the record set into Designer.  

The flat record set corresponding to the executed SQL is returned from the source 
database and displayed in Data Prep with the database name as the title and all fields 
listed displayed in Data Preview. 

13. If you wish to make changes to your fields, you may do so now and then click OK when 
you are finished. If you do not wish to make any changes to your data, simply select the 

OK button. 
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CONNECTING TO SALESFORCE 

The following steps describe how to connect to Salesforce data. 

Steps: 

1. Open the Select Data Source to Open dialog and then select Salesforce. 

The Salesforce Connector Settings dialog displays. 

 

Figure 4-43. The Salesforce Connector Settings dialog.  

2. Enter a valid username, password, and security token and then click Connect. 

3. Select the source type for data retrieval, i.e., Salesforce Objects Table or Report. 

4. Select the data source to open according to the source type you selected. 

5. Click OK. 

CONNECTING TO MONGODB 

The following steps describe how to connect to MongoDB data. 

Steps: 

1. Open the Select Data Source to Open dialog and then select MongoDB. 



 

 

62    Monarch 14.2 Learning Guide 

 

The MongoDB Connector Settings dialog displays. 

 

Figure 4-44. The MongoDB Connection dialog.  

2. Enter a valid username and password and then click Connect. 

3. Once a connection to the database has been established, select a database and 
collection from the drop-down boxes provided. The columns associated with your 
selection display in the JSON list box. 

4. Create a new column if you wish by clicking the Add Column button and entering the 

necessary information. Alternatively, you may click the Generate Columns button. Doing 
so launches a query of the first few database record and builds a table schema from the 
available information.  

5. Specify query options if you wish.  

6. Click OK. 

CONNECTING TO GOOGLE ANALYTICS 

The following steps describe how to connect to data stored in Google Analytics. 

Steps: 

1. From the Preview Data window, select Add More Stuff. 

2. In the Select Data Source to Open dialog that displays, select Google Analytics. 

The Google Analytics Connection dialog displays.  
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Figure 4-45. The Google Analytics Connection dialog.  

3. Provide a service account email, key file path, and profile ID and indicate the start and end 
dates of the data you wish to fetch.  

4. Click the Fetch Dimensions and Metrics button to populate the Categories, Dimensions, 
and Metrics list boxes. 

5. Select the fields you want to add to your table from these lists and then click OK. 

More information on this connector may be found here.  

The Google Analytics example concludes our exercise on using the Datawatch Data 

Connectors. A full list of the connector dialogs available in Data Prep Studio is available here.  

If you would like to save this workspace to continue working on it at a later time, you may do 

so now. Otherwise, select Application Menu  > Close Workspace. 

 

  

http://docs.datawatch.com/monarch/desktop/Connector_Dialog_for_Google_Analytics.htm
http://docs.datawatch.com/monarch/desktop/Working_with_Data_Sources.htm


 

 

64    Monarch 14.2 Learning Guide 

 

Navigating Tables 
Tables open in the Prep Data window may be easily navigated in a number of ways.  

NAVIGATION CONTROLS 

The following controls have been enabled in Data Prep Studio to allow quick movement 
through a table.  

 Ctrl + Home – Go to first cell of the first row of the table 

 Ctrl + End – Go to the last cell of the last row of the table 

 Ctrl + Right arrow – Go to right-most cell in the current row 

 Ctrl + Left arrow – Go to the left-most cell in the current row 

SEARCHING FOR DATA 

 

Figure 4-46. Searching for data in a table.  

You can search for specific data in tables by using the Search field located at the bottom of 
your workspace. Enter the string you would like to search for and then either press Enter on 

your keyboard or click the Search for Next  button located to the right of this field. The 

first cell including the string you are searching for is highlighted. Keep pressing Enter or 
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clicking the Search for Next  button to locate all instances of this string. To reverse the 

search direction, click on the Search for Previous  button.  

WORKING WITH ROWS 

The row number of any given table is provided at the bottom of your workspace. To go to a 
specific row in your table, simply enter the row number you wish in the row field provided. To 

go to the first and last rows of the table, click on the First Row  and Last Row  

buttons, respectively. The Previous Page  and Next Page  buttons take you to views 
of previous and next pages of data, respectively. 

 

Figure 4-47. Viewing the row count of the Accounting table of Beantown.mdb.  

You can increase row heights by selecting the Row Height  button to fit multi-line data into 
your rows.  

SHOWING NULLS AND WHITESPACE CHARACTERS 

Two buttons, which appear at the lower right-hand corner of the Prep Data window, have been 

enabled in Data Prep Studio to help you visualize your data better. The Show Nulls  

button helps you see null values (i.e., empty fields). Clicking on the Show Whitespace 

Characters  button displays spaces, tab indents, and line breaks between text characters; 

these whitespace indicators display as •, , and , respectively. 

DOCKING/UNDOCKING TABLES 

Docking a table helps you view multiple tables at once or move them to a different location, 
for example, a second monitor. To undock a table, right click on it from the Prep Data window 

table selector and then select Undock Table from the options that display. You can also just 

drag the table anywhere on your screen. This action undocks the table and allows you to move 

it anywhere you wish. To dock a table, select the Dock Table  icon that appears on the 

upper right corner of an undocked table. This table is returned to the main interface.  
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Loading a Workspace 
Let’s load the workspace we saved as Workspace1 to continue with our tutorial. 

Steps: 

1. Select Application Menu  > Open Workspace. 

2. In the Open dialog that displays, go to the folder in which you saved Workspace1, select 
this file, and then click Open. 

  

Figure 4-48. Loading a saved Workspace into Data Prep Studio. 

All of the tables you loaded into Data Prep Studio, joins and appends you created, and 
transform operations you performed are displayed. 

 

Figure 4-49. All transformations to tables saved into a Workspace file are automatically 
performed when the file is loaded into Data Prep Studio. 
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NOTE 

When a saved workspace is opened, Data Prep Studio attempts to 
load all of the tables added to the workspace using the file paths 
provided in a previous session. But what if the paths to these 
tables are changed or the table are renamed? Learn more about 
file reconciliation here. 

 

 

Joining Data in a Data Prep Session 
Data Prep Studio allows the following join types: 

  Left outer join  

A left outer join retains all of the rows of the “left” table, regardless of whether or not 

there is a row that matches on the “right” table. 

  Right outer join  

A right outer join retains all of the rows of the “right” table, regardless of whether or not 
there is a row that matches on the “left” table. 

  Full outer join  

The full outer join returns all rows from the left and right tables. The full outer join 
combines the results of both left and right joins. 

  Inner join  

An inner join yields the intersection of two tables, i.e., only the rows they have in 
common. 

These joins essentially allow you to create new tables from preexisting ones so that you can 

get more information out of your data and more detail into future visualization or analytics 
work.  

But what if you wanted more information on the data that can’t be joined? In this case, 
negative joins are what you will need to generate. You can create a left negative join, which 

shows all rows from the right table for which the join keys do not match, or a right negative 
join, which shows all rows from the left table without matching join keys. More information on 
this topic is available here.  

In this exercise, we will join data from two tables. Following the steps outlined in Previewing 
and Adding Data to a Data Prep Session – Adding Data from a Database, load the table in 
Payroll.mdb into Data Prep Studio.  

Steps: 

1. Select Combine Data from the Data Prep Studio toolbar to launch the Combine Data 
stage. 

http://docs.datawatch.com/monarch/desktop/File_Reconciliation.htm
http://docs.datawatch.com/monarch/desktop/Joining_Tables.htm
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All of the tables you loaded are displayed on the table list to the left of the screen. Note 
that the table Compensation must display at the bottom of this list if you successfully 
opened Payroll.mdb in Data Prep Studio. 

2. Drag Accounting from the table list and into the first Drag a Table box. This table will be 

the “left” table of the join. 

3. Drag Compensation from the table list and into the second Drag a Table box. This table 
will be the “right” table of the join. 

4. Select the Click to Join button that displays on top of these tables.  

The Join Configuration dialog displays. 

 

Figure 4-50. The resulting Join Configuration dialog. 

In this exercise, we will join the two tables via an inner join (i.e., we only want to see rows 
where key fields from both tables match).  

5. Select the  icon, which signifies an inner join, from the available icons located at the 
bottom of the Join Name field in the Join Configuration dialog.  

6. Select Emp_ID as the key field for the Accounting table. 

7. Select Emp_ID as the key field for the Compensation table.  

8. If you wish to take advantage of Data Prep Studio’s fuzzy matching function, tick the Use 
Fuzzy Matching box and then set an accuracy threshold using the slider that displays. 

9. Select OK. 

The resulting table is created and added to the table list. A preview of the table resulting 
from this join also displays in the Combine Data workspace. 
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In the Prep Data window, the joined table is named, by default, Join. Succeeding joins will 
be named Join(1), Join(2), and so on. These tables can be renamed to whatever you 
wish.   

 

Figure 4-51. The results of our join operation. 

10. Selecting the Prep Data button on the toolbar shows the contents of this new table.  

 

Figure 4-52. The newly defined table in the Prep Data window. 
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ANALYZING JOINS 

Data Prep Studio includes Join Analysis functionality to help you decide which joins will likely 
produce the best results. This functionality may be accessed by selecting the Show Join 
Analysis button on the upper right-hand corner of the Combine Data stage BEFORE Step 4 of 
the procedure described above. 

Alternatively, if you have completed Step 4 of the join procedure, click Recommend Keys in 

the Join Configuration dialog.   

The Join Analysis dialog that displays provides suggestions as to which join fields may be 
combined to yield the most number of results. 

 

Figure 4-53. The Join Analysis dialog. 

Hovering over each of the boxes in the dialog displays more information about the suggested 
join. 

 

Figure 4-54. Viewing information of the suggested join. 
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If you are satisfied with the projected join result, simply click on the box corresponding to the 
proposed join. The Join Configuration dialog displays and you can proceed with Step 6 of the 
procedure described above. 

CREATING A NEW JOIN 

If you would like to create a new join after completing a previous one, select the Create New 
Join button located on the upper left-hand corner of the Combine Data Stage. Doing so 
removes all tables already placed in the joining stage, as well as the previous join defined. You 
can now begin creating a new join. 

USING FUZZY JOINS 

When joining data, Data Prep Studio makes an allowance for potential errors in spelling that 
would result in a mismatch even when the keys are highly similar (e.g., "bond" vs. "bund"). 
Such issues are addressed by using fuzzy joins. 

Fuzzy joining is activated by ticking the Use Fuzzy Matching checkbox located near the 

bottom of the Join Configuration dialog. 

       

Figure 4-55. Activating Fuzzy Matching in the Join Configuration dialog. 



 

 

72    Monarch 14.2 Learning Guide 

 

The options that display when fuzzy matching is employed allow you to specify an accuracy 
threshold for matching and whether or not to include columns detailing the fuzzy matching 
results in the table obtained from the join. 

Note that join keys MUST be defined before fuzzy matching can be accomplished. 

More information on fuzzy matching may be found here.  

Appending Data in the Preview Data 
Window 
Tables with the same fields may be appended via a single click of a button. To do so, simply 
select the tables you wish to append from the Preview Data Window. 

 

Figure 4-56. Specifying tables to append in the Prep Data window. 

If the tables you selected can be appended, Data Prep Studio activates the Append Selected 

Tables button. Click this button. 

http://docs.datawatch.com/monarch/desktop/Using_Fuzzy_Joins.htm
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Figure 4-57. The appended tables display in the Prep Data window. 

In the Prep Data window, the appended table is named, by default, Append. Succeeding 
appends will be named Append(1), Append(2), and so on. These tables can be renamed to 
whatever you wish.   

Tables cannot be appended if their fields are different.  

  

Figure 4-58. Tables with different fields cannot be appended.  
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Appending Data in the Prep Data 
Window 
In previous lessons, you learned to append similar tables by selecting these tables in the 
Preview Data Window and then clicking the Append Selected Tables button. In many 
instances, this simple operation is adequate. But what happens if the tables you wish to 

append don’t match exactly (e.g., two tables contain the information you want to append but 
one table contains 1 field more than the other)? 

Data Prep Studio addresses this problem by implementing more complex append operations 

from the Prep Data Window 

APPENDING DATA VIA THE CONTEXT MENU 

For this exercise, open and load the tables of Beantown.mdb. 

Steps: 

1. Using CTRL+click, select the tables Accounting, Data Processing, and Marketing in 
this order. 

2. Right-click on your mouse and then select Append Tables >. 

You may opt to: 

 Strict append 

This option appends all tables based on name and type. 

 Match columns on order, name, and type 

This option appends your tables first according to the order in which you selected 
them, then according to their field names, then according to their field type. 

 Match columns on order and name 

This option appends your table first according to the order in which you selected them 

and then according to their field names.  

 Match columns on order  

This option appends your tables according to the order in which you selected them.  

3. Select any of these options listed above. 

A new append table is created. 
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APPENDING DATA VIA THE APPEND HELPER 

The Append Helper is a wizard that can help you in customizing the append operation. Unlike 
other append methods, you can "force" Data Prep Studio to match columns even if they do not 
have the same location, name, and/or data type. 

 

Figure 4-59. The original Accounting table. 

For this exercise, double-click on the Last Name field header of the Accounting table and 
rename it to “Surname.” Click on the drop-down button beside this header and then select 
Edit/Move Column Information from the menu that displays. Using your mouse, click on 
the drag-and-drop handle of Surname, drag the field, and drop it after First Name. Now we’ll 
append the Department, First Name, and Last Name/Surname fields of the Accounting and 

Data Processing Tables.  

 

Steps: 

1. Select the tables Accounting and Data Processing. Right-click on your mouse and then 
select Open Append Helper.  

 

Figure 4-60. The Append Helper. 
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2. In the Source Tables panel, ensure that Accounting is selected. In the Columns to Append 
panel, click on Department and then select Move. Repeat this step for the First Name 
and Surname fields. 

These fields should appear in the Appended Table panel.  

3. In the Source Tables panel, select Data Processing.  

The fields of this table should display in the Columns to Append panel. 

4. Select Department in the Columns to Append panel, select Department in the Appended 
Table panel, and then click the Match control that displays beside Department in the 
Columns to Append panel. 

 

Figure 4-61. Matching the Department fields of two tables.  

5. Repeat Step 4 to match the First Name field between the two tables. 

6. Select Last Name in the Columns to Append panel, select Surname in the Appended 
Table panel, and then click on the Match control that appears beside Last Name in the 
Columns to Append panel. Select OK when you are finished. 
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Figure 4-62. Matching the Last Name and Surname fields. 

The appended table displays. 

 

Figure 4-63. The resulting appended table. 

Note that the Surname field contains the correct data even though the contents of this field 
originated from two source tables with different field names.  
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You can click on the + button that appears to the right of a matched field to view the tables 

and field names that make up the match. While the list is displayed, you can click x beside a 

field to remove the match. 

You can also edit columns before finalizing the append operation. 

For example, you can change column names or data types. 

To do so, click Edit on a column on the Appended Table panel. The column's name becomes 
editable. A list of available data types are also displayed, with the column's current data type 
highlighted. You can either 

 Enter a new column name 

 Select a new data type 

Transforming Data 
A Transform dialog is launched when you click  on the Data Prep Studio 

toolbar. This dialog enables you to quickly change how your tables look and how your data are 
grouped. 

EXTRACTING NULLS AND BLANKS 

To extract empty rows or rows with empty values in a table, select Transform… to launch the 
Transform dialog and then click Extract Nulls and Blanks. You can: 

 Exclude all empty rows 

 Exclude rows where there is an empty value in any column 

 Include rows where there is an empty value in any column 

PIVOTING COLUMNS 

Pivoting allows you to transform column values into column headers, thereby changing the 

look of your data from tall+skinny to short+wide.  

For this exercise, open Classic.pdf. In the Report Discovery window, double click on the fields 

Betty’s Music Store (Customer), CD (Media Qty), and Amount (Amount) and then click 
Open in Data Prep Studio. Load this table so that it displays in the Prep Data window. 
Replace the null values in the Media Qty column by clicking on the drop-down arrow beside 
the column name and then selecting Replace > Ditto. Your table should look like the 
following table. 
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Figure 4-64. The resulting table extracted from Classic.pdf. 

Now we’re ready to pivot your columns. 

Steps: 

1. From the Prep Data window, select Transform > Pivot Column. 

The Pivot Column dialog displays. 

 

Figure 4-65. The Pivot Column dialog. 

2. Click the drop-down box of the Column to Pivot field and then select Media Qty. Leave 
the Grouping Type as Distinct Values. 

3. Click the drop-down box of the Values Column field and then select Amount. Leave the 
Operation as Sum. 

4. Select OK when you are finished. 

Your table should be transformed as follows. 
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Figure 4-66. The pivoted table. 

UNPIVOTING COLUMNS 

Unpivoting All of the Pivoted Columns of a Table 

When all of the pivoted columns of a table are unpivoted, the data are returned to their 
tall+skinny look.  

Steps: 

1. Click on the table you pivoted in the previous lesson in the Prep Data window and then 
select Transform Data > Unpivot Columns. 

2. In the Unpivot Columns dialog that displays, select CD, DVD, LP, SACD, and BLU and 

then click OK.  

Your table returns to its original form.  

 

 

NOTE 

If you are unpivoting all of the columns you pivoted in a table, 
effectively completely reversing your change, you can also simply 
click on the drop-down icon located to the right of the pivoted 
table and, from the options that display, select Discard 

Transform  
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Unpivoting Select Columns of a Pivoted Table 

When you opt to unpivot select columns of a pivoted table, you are effectively instructing Data 

Prep Studio to display the data (values) of these columns (attributes) in a left-to-right 
manner but keep all other fields and their associated data in their top-bottom form. 

In this case, an Attribute column, which will contain the name(s) of the column(s) you 
unpivoted, and a Values column, which will contain all of the data corresponding to these 
columns, are created. Depending on the number of columns you choose to unpivot, the new 
table created could be much shorter than the original pivoted table.  

Steps: 

1. Repeat the Pivoting Columns exercise to obtain a pivoted table. Ensure that this table is 
displayed in the Prep Data window. 

2. From the Data Prep Studio toolbar, select Transform Data > Unpivot Columns. 

The Unpivot Columns dialog displays. 

 

Figure 4-67. The Unpivot Columns dialog. 

3. Check the box for BLU and then select OK. 

The newly transformed table displays as below. 

 

Figure 4-68. The newly transformed table. 
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GROUPING DATA 

The Group By transformation allows you to classify or consolidate rows that belong together 
according to some common value within the row. When you consolidate the records, you can 
also select column values to aggregate. 

Let’s use the table in the previous exercise to group our data. 

 

Figure 4-69. The Append Helper. 

In the table above, we can group all media sales so that only the total amounts for each media 
type are displayed. 

Steps: 

1. From the Prep Data window, select Transform > Group By. 

The Group By dialog displays.  

 

Figure 4-70. The Group By dialog. 
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2. Click the drop-down button of the Group By field and then select Media Qty. Leave the 
Grouping type as Distinct Values. 

3. In the Column field, select Amount. Leave the Operation as Sum. If you’d like to rename 
the new grouped column, you can do so by changing the entry in the New Column Name 

field. 

4. Select OK when you are finished.  

Your new table displays below. 

 

Figure 4-71. The table resulting from a Group By operation. 

REMOVING/SHOWING DUPLICATES 

You can remove or show duplicate rows from tables by selecting Transform and, in the dialog 

that displays, clicking the Remove/Show Duplicates option. 

Removing Duplicates   

You can remove duplicate data from a table.  

Steps: 

1. In the Prep Data window, view the table with duplicate rows to remove and then select 
Transform > Remove/Show Duplicates. The Remove/Show Duplicates dialog displays. 
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Figure 4-72. The Remove/Show Duplicates dialog. 

2. Select Remove Duplicates. 

3. If you wish to remove duplicates from all columns, select Column Name and then click 
OK.  

4. If you wish to remove duplicates from select columns instead, untick the box for Column 

Name and then tick the boxes for these columns from the column selector and then click 
OK. 

The resulting table displays. 

Showing Duplicates 

Instead of removing duplicates, you can also show rows with duplicate data as a new table.  

Steps: 

1. In the Prep Data window, view the table with duplicate rows to show and then select 
Transform > Remove/Show Duplicates. The Remove/Show Duplicates dialog displays. 

2. Select Show Duplicates. 

3. If you wish to show duplicates from all columns, select Column Name and then click OK.  

4. If you wish to show duplicates from select columns instead, untick the box for Column 
Name and then tick the boxes for these columns from the column selector and then click 

OK. 

The resulting table displays. 

More information on removing/showing duplicates can be found here.  

http://docs.datawatch.com/monarch/desktop/Remove_Show_Duplicate_Rows.htm
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Working with Load Plan Visualization  
When you join, append, or transform tables, the resulting table displays in the table selector 
of the Prep Data window as follows: 

 

Figure 4-73. The Load Plan of a table resulting from join, append, or transform operations. 

Clicking on the  icon of the main table minimizes the table display as follows: 

 

Figure 4-74. The minimized table display.  

The tables that display under a joined, appended, or transformed table (i.e., the “parent” 
tables) enable you to visualize which specific tables were employed to obtain the newer table 

(i.e., the “child” table). This functionality is called load plan visualization. 

Because joins, appends, and transforms are NOT recorded as changes, these operations will 
not display in a table’s change history and you may be unable to recreate child tables easily, 
especially when working with the same workspace at a later date. Load plan visualization 
addresses this issue by allowing you to recreate new tables from previously existing ones: 
you’ll know exactly which tables to use and what operation to apply to obtain a desired table.  

Note that when pre-existing tables are combined to create new ones, the former are displayed 
below the latter.  

  

Figure 4-75. Movement of tables in a load visualization plan.  

As with any other table in the Prep Data window, clicking on the drop-down icon located to the 
right of child tables allows you to edit the operation and pin and refresh the table. You can 



 

 

86    Monarch 14.2 Learning Guide 

 

also rename or close the table, duplicate the table (including all other tables used to achieve 
it), and discard the operation. In case of the latter, the child table disappears and only the 
parent tables remain.  

Working with Calculated Fields 
The ability to create calculated fields is among the more important data prep operations you 
can perform. Calculated fields can be created from text, date/time, and numeric fields. They 
can also be edited via the Change History list.  

A complete list of the functions available in the Create Calculated Field dialog, as well as their 

definitions and examples, may be found here. 

Note, however, that Data Prep Studio does not support redaction functions. To use these 
functions on a table, switch to Classic mode, apply the necessary functions, and then open the 
table in Data Prep Studio. 

For this exercise, let’s compute what the unit prices of various media from the Classic.pdf 
report would be if we applied a 10% discount to them.  

 

Figure 4-76. The Create Calculated Field dialog. 

Steps: 

1. From the Classic.pdf report, extract the fields marked by Betty’s Music Store 
(Customer), Bartok, Sonata for Solo Violin (Description), MK-42625 (Label/No.), 
and 8.99 (Unt_Prc). Load this table into the Prep Data window. 

http://docs.datawatch.com/monarch/desktop/ht_table_functions.htm
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2. Click on the drop-down button beside the Unt_Prc column and then select Create 
Calculated Field. 

3. In the Create Calculated Field dialog that displays, enter Discounted Prices in the New 
Column Name field.  

4. Double-click on Unt_Prc field in the Fields panel so that the field name appears in the 
Expression box.  

5. In the Operators panel, double-click on the multiplication operator. This operator appears 
in the Expression box. 

6. Using your mouse, click to the right of the multiplication operator in the Expression box 
and then type in 0.90. Select OK when you are finished. 

The Create Calculated Field dialog closes and a new column is added to your table. 

7. Select the drop-down button of the Formula Field column and then click Format. In the 
Format Formula Field dialog that displays, select Financial and then click OK. 

Your table is rebuilt as below. 

 

Figure 4-77. Adding a calculated field to a table. 
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Filtering Data 
You can choose how much data to import from a table into your Data Prep Session by filtering 
your table and selecting the data you want to view. Let’s find out how using the table we 
produced from a PDF report. In this example, instead of viewing data for 20 customers, we’ll 
select only 5 customers and load their data into a new table.  

Steps:  

1. Open Classic.pdf and then use the Auto-Define button in the Report Discovery window 
to extract data from the report. 

2. View the resulting table in the Prep Data window.  

3. Click the drop-down button beside the Customer column and then select  Apply 
Filter.  

The Apply Filter dialog displays.  

 

Figure 4-78. The Apply Filter dialog.  

4. Click on the Select filter type  icon and, from the options that display, select 

Multiple selection. 

5. Under Value, select Betty’s Music Store, Big Shanty Music, Bluegrass Records, Canciones, 
and Chez Rudy. 

6. Select Load Selected Tables when you are finished. The resulting table displays in the 
Prep Data window.  
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Figure 4-79. The table obtained from a filter operation.  

Note that the data of only five customers are displayed. 

Different filter operations are available for different field types. Numeric fields, for 
example, may be filtered by using ranges or specifying less than or greater than values. 
To filter date fields, you can specify a date range or before/after date. For text fields, you 

can specify strings or select discrete values.  

Preparing Data 
You can prepare columns in a table to prepare them for future visualization or analytics 
operations. Data Prep Studio includes pre-built functions that allow you to quickly and 

consistently clean your data, turning them into analysis-ready information. Preparing data in 

Data Prep Studio is as easy as clicking on the drop-down  button located to the right of 

each column header. Doing so displays a list of prep operations you can perform on that 
column.  
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Figure 4-80. Available prep operations for Text fields in the Prep Data window. 

For text fields, the following prep operations may be applied: 

 Sort 

 Case 

 Clean 

 Column 

 Convert 

 Extract 

 Replace 

 Split 

For date/time and numeric fields, the following prep operations may be applied:  

 Sort 

 Format (for numeric fields) 

 Column 

 Convert 

 Compute (for numeric fields) 

 Replace 

 Split (for date/time fields) 
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Besides these prep operations, you can also change the field type of each of the columns in 
your table (e.g., change a numeric field into a date/time field). To do so, simply click on the 
field type icon found to the right of the column name and, from the options that display, select 
the new field type you wish to apply. 

You can select the drop-down button located to the right of each column and, from the options 
that display, click Edit/Move Column Information. Doing so displays the Edit/Move Column 
Information dialog, which will allow you to make even more detailed changes to your columns, 
including their order, name, and type. You can also opt to hide or unhide columns by ticking or 
unticking the Hide box that displays whenever a specific column is selected.  

 

Figure 4-81. The Edit/Move Column Information dialog. 

In the Prep Data window, you can select specific columns and then perform convert, merge, 
remove, and copy operations or create new functions to obtain only the data you truly need. 
You can also select columns from a table and create a new table from this selection. You can 
even create new columns, either from scratch or from extract and replace operations, and 

change the data types of these columns. 

You can add metadata from Excel, delimited text, and PDF/PRN reports as new columns to 
tables.  

To change the table header and use values from a certain row as column names instead, click 

on the number of the row you would like to use as a header, effectively highlighting it, right-
click on your mouse, and then select Set Row as Column Headers from the options that 

display.  

To gain access to these capabilities and more, simply click on the drop-down button located to 
the right of each table column. This action displays a menu from which you can select a prep 
operation. 

  

http://docs.datawatch.com/monarch/desktop/Hiding_a_Column.htm
http://docs.datawatch.com/monarch/desktop/Merging_Columns.htm
http://docs.datawatch.com/monarch/desktop/Creating_a_New_Column.htm
http://docs.datawatch.com/monarch/desktop/Adding_File_Metadata_Columns_to_Tables.htm
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The table below provides more information on the transformations you can perform in Data 
Prep Studio. 

USE THIS TRANSFORMATION TO 

SORT 

Sort selected columns Sort the column in ascending order 

Define Sort Launch the Sort dialog to create a new sort definition 

CASE 

Make Proper Case Convert to uppercase the first letter of each word in a 
string 

Make Lower Case  Convert the entire string to lowercase letters 

Make Upper Case  Convert the entire string to uppercase letters 

CLEAN 

Remove Leading & Trailing 
Spaces  

Remove all leading and trailing spaces from a string 

Remove Consecutive Spaces Collapse multiple consecutive spaces into one space 

Remove Specified Characters Remove the sequence of characters from the values of 
the column you apply this operation to 

Remove non-alphanumeric 
characters 

Remove all characters that are not numbers or letters 
(e.g., periods, commas, other symbols) from the 

selected fields 

Remove numeric characters Remove all numerals from the selected fields 

COLUMN 

Rename  Rename the column you selected 

Duplicate  Produce a duplicate of the column you selected 

Remove Remove the column you selected 

Hide Hide the selected column 

Show hidden column Show a list of hidden columns. Selecting a column from 
this list displays it in the table once more.  

CONVERT 

Text to Number Convert the data type Text into Number 

Text to Date/Time Convert the data type Text into Date/Time 

HH:MM:SS to Number of Secs  Convert HH:MM:SS strings into a number of seconds 

Date/Time to Text Convert the data type Date/Time to Text 

Date/Time to Number Convert the data type Date/Time to Number 

Number to Text Convert the data type Number into Text 

Number to Date/Time Convert the data type Number into Date/Time 

Advanced Text to Number Converts text fields with the values “X B,” “X M,” and “X 

K,” where “X” is any number, into “X,000,000,000,” 
“X,000,000,” and “X,000,” respectively. 
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USE THIS TRANSFORMATION TO 

EXTRACT 

Starting from left Extract n characters from the beginning of a string  

Starting from right Extract n characters from the end of a string  

Using Position & Length  Extract n characters from the xth position from the start 

Using Start & End Strings Extract n characters starting from the start and end 

positions indicated by a string of characters 

FORMAT (for Date/Time fields) 

Short Date Apply the MM/DD/YYYY form of a date/time field 

Long Date Apply the Day, Date form of a date/time field 

Short Date/Time Apply the MM/DD/YYYY HH:MM AM/PM form of a 
date/time field 

Long Date/Time Apply the Day, Date HH:MM AM/PM form of a date/time 
field 

Time Apply the HH:MM AM/PM form of a date/time field 

Custom Specify a custom form (e.g., year, month, day, hour, 
minute, etc.) for the date/time field 

FORMAT (for Number fields) 

Number Format the number with a thousands separator and two 
decimal places  

Financial Format the number with thousands separator and two 
decimal places. Negatives are enclosed in parenthesis. 

Currency Format the number with thousands separator and two 
decimal places. Adds a currency, and negatives are 
enclosed in parenthesis. 

Percent Multiply the number by 100 and add a % sign 

Scientific Format the number in exponential form 

Custom Specify a custom form (e.g., 000,000, #0.0E0, # 
‘degrees,’ etc.) for the number field 

REPLACE 

Using Position & Length Replace strings of a certain length and located at a 
certain start position with another string 

Using Find & Replace Replace specific strings with another string 

Ditto Copy non-null values down to fill null values in 
subsequent rows in a column 

Blank Values Replace blank values with a specific string 

Nulls Remove null values and replace with a specific string 

SPLIT 

Into parts from the Left Start from the left and split a column into two or more 
columns, depending on a separator you define. The 
separator may be a single character or substring 
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USE THIS TRANSFORMATION TO 

Into Parts from the Right  Start from the right and split a column into two or more 

columns, depending on a separator you define 

Names Into Parts Split the value of a name column into its name parts. 

Addresses Into Parts  Split the value of a single address column into its 
component address or postal parts 

Date/Time into Parts Split a date/time column into two or more parts 
according to the date/time components you select. 
Parts include Year, Quarter, Month, Day, Hour, Minute, 
Second, Date, Time, DayofYear, HalfYear, and Week. 

Date/Time into ISO 8601 Parts Split a date/time field into two or columns according to 

the ISO 8601 date/time components you select 

Date/Time into Fiscal Parts Split a date/time field into two or more columns 
according to the fiscal parts selected 

COMPUTE 

Round with Precision… Round numbers to a specified number of places to the 

right (or left) of the decimal point 

Round Up (Ceiling) Round numbers up to zero decimal places 

Round Down (Floor) Round numbers down to zero decimal places 

Remove Negative Signs (Abs) Return the absolute values of numbers 

Remove Decimals (Int) Return the integer portions of numbers 

Calculator Creates a calculated field using other numeric fields in 
the table 

 

Let’s transform the Hire Date column of the table Join so that only the hire date and not the 
hire time displays. In this exercise, we will also transform the Salary and Bonus fields so that 
the values in these fields resemble monetary values more closely.  

Steps: 

1. In the Prep Data window, load the Join table. 

2. Click on the drop-down  button located to the right of the Hire Date column header. 

3. From the menu that displays, select Format. 

4. From the Format Hire Date dialog that displays, select Short Date. 
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Figure 4-82. The Format Hire Date dialog.2 

5. Select OK when you are finished  

The new column displaying only the hire date (without the hire time) displays. Note that 
the column header has been changed to reflect at least part of the transformation we 
performed.  

  

Figure 4-83. The transformed Hire Date column of the Join (Accounting + Compensation) 

table in the Prep Data window. 
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6. Click on the drop-down  button located to the right of the Salary column header and, 

from the menu that displays, select Format. 

7. In the Format Salary dialog that displays, select Currency and then click OK. 

8. Perform Steps 5 and 6 to transform the Bonus field. 

Your table should now look as below. 

 

Figure 4-84. The completely transformed Join (Accounting + Compensation) table in the 

Prep Data window. 

Tracking Changes 
A change history is the record of all changes that have been made to a table. This list can be 
reapplied to any table that has columns of the same names and data types in the same order. 
Change histories may be imported and exported and applied to tables similar to that from 

which the imported/exported change history was created. 

Data Prep Studio features a nifty tool through which you can track your data transformations 
in a stepwise manner. This tool is called Change History and is found as a panel on the right-
hand side of the Prep Data window.  

 

Figure 4-85. Accessing the Change History panel. 
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This panel shows each of the changes we performed in the previous exercise.  

If you want to undo an operation, select the Undo Change  button beside that operation. 

If you’d like to edit it, select the Edit  button. 

Note that selecting Undo for one operation will also undo all operations after it and that the 
Change History functionality is only available in the Prep Data window.  

A complete discussion on Change History is provided here. 

APPLYING A CHANGE LIST TO A DIFFERENT TABLE 

You can drag and drop single changes (using the header of a change) or whole change lists 
(using the drag-and-drop handle of the Change History panel) to other tables. When you do 
so, each of the changes specified in the change list are automatically applied in sequence to 

the new table if the latter has no change history.  

 

Figure 4-86. The drag-and-drop handle of the Change History panel. 

In Figure 4-87, the change list of the table Join (Accounting + Compensation) has been 
dragged to the table Join(1) (Data Processing + Compensation). Assuming that both tables 
contain the same fields but the latter has a different change list, you are asked if you would 
like to replace the Change History of the latter table.  

http://docs.datawatch.com/monarch/desktop/Working_with_Change_History.htm
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Figure 4-87. The same change list created from the Join (Accounting + Compensation) table 
was dragged and dropped into the Data Processing table. 

Selecting Yes in the Change List Drop dialog applies the exact same changes in the former 
table to the latter one. If a field is hidden and some change must be applied to it, the hidden 
field is displayed and the change operations are completed.  

If you select No, hidden fields are not displayed but changes to them are still applied.  

In another example below, the Change History of the Join table (Accounting + Compensation) 

has been dragged and dropped to the table Marketing.  

 

Figure 4-88. The change list created from the Join (Accounting + Compensation) table was 

dragged and dropped to the Marketing table. 
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Because the Marketing table does not contain Salary or Bonus fields, the error shown in Figure 
4-88 displays.  

EXPORTING A CHANGE HISTORY LIST 

Change History lists may be exported for use in a similar table in another Data Prep Studio 
session. 

Steps: 

1. Select Application Menu  > Change Lists > Export Change List. 

Alternatively, you can select the Export Change List  icon on the Change History 

panel.  

2. In the Save As dialog that displays, use the File Location drop-down to navigate to the 
folder in which you want to save the exported change list and then enter ExportChange1 
into the File name field. 

3. Click Save when you are done. 

The export list is saved into the nominated folder with the extension .dpcl. 

IMPORTING A CHANGE HISTORY LIST 

Importing Change History lists allows you to quickly and easily apply changes made to a 
previous table to a similar table. 

Steps: 

1. Following the steps outlined in Joining Data in a Data Prep Session, join the tables 
Marketing and Compensation using an inner join and Emp ID as the key. 
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The following table displays. 

 

Figure 4-89. The results of joining tables Marketing and Compensation. 

2. Select Application Menu  > Change Lists > Import Change List. 

Alternatively, you can select Import Change List  icon on the Change History panel. 

3. Using the Open dialog that displays, navigate to the folder in which you stored 
ExportChange1, select this file and then click Open.  

The Hire Date, Salary, and Bonus fields of the joined table immediately reflect changes.  

  

Figure 4-90. The results of our Import Change List operation. 
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Viewing the Change List history of the joined table yields the following results: 

 

Figure 4-91. The Change List History of the newly joined Marketing and Compensation 

tables. 

MODIFYING ITEMS IN A CHANGE LIST 

Now that you know that you can reverse changes you have applied to your tables by using the 

Change History functionality, what happens if you simply want to modify – not reverse – a 
change, such as a formula field? You can modify changes such as filters and calculated field 

definitions by clicking on the Edit  icon that displays to the right of a change in the Change 
History list. Note that if this icon does not appear, the change cannot be modified.  

Clicking the Edit  icon launches the relevant dialog to enable you to modify your change. If 

you were to modify the calculated field you added to your table in the previous exercise, for 
example, you would click on the edit button in the change marked  

  

in your Change History list. Doing so will launch the Update Calculated Field dialog.  
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Figure 4-92. Clicking the Edit button that appears on a change in the Change History list 

launches the relevant dialog. 

CREATING CUSTOM CHANGE LISTS 

Custom change lists apply to a single column of a single data type at a time, similar essentially 
to a user-defined function. Users can drag any set of changes that apply to a single data type, 

e.g., text, numeric, date, and then save them with a name for reuse within a workspace. 

When the changes are applied to one or more columns on a table they will be recorded in the 
change history. 

Steps: 

1. Select the Edit or Create Custom Change List button from the Change History toolbar. 

You can also select the drop-down handle of any column in the Prep Data window and then 

select Custom Change. 

The Custom Change dialog box displays. 
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Figure 4-93. The Custom Change dialog. 

2. Drag change history items from an existing Change History list to the Custom Change 
dialog box. 

3. Enter a name for the custom change list in the box provided.  

The list is automatically saved and may be applied to a compatible column. 

More information on creating custom change lists may be found here. 

Exporting Data 
You can export tables in Data Prep Studio. Note that you can only export data from the Prep 
Data Window. The following export types are supported in Data Prep Studio: 

 Microsoft Excel (.xlsx, .xlsm, .xls) 

 Delimited text file (.csv) 

 Monarch Swarm 

 Datawatch Designer (.xlsx) 

 IBM Watson Analytics 

 IBM Cognos Analytics 

 Microsoft Access (.accdb, .mdb) 

 Microsoft Power BI  

 Tableau Server/Tableau data extract file (.tde) 

 QlikView (.qvx) 

http://docs.datawatch.com/monarch/desktop/Custom_Change.htm
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EXPORTING TO CSV, MICROSOFT EXCEL, MICROSOFT ACCESS, 
DATAWATCH DESIGNER, QLIK, AND TABLEAU FILES  

Steps: 

1. From the Prep Data window, select the table Join(1) (Data Processing + 
Compensation) and then click Export Data on the Prep Data toolbar. 

A Select an Export Type dialog displays. 

 

Figure 4-94. The Select an Export Type dialog of Data Prep Studio. 

2. Select Microsoft Excel to display the Microsoft Excel Export dialog. 

 

Figure 4-95. The Microsoft Excel Export dialog. 

3. Use the Browse button to navigate to the folder into which you want to save your export.  

Note that Data Prep Studio will remember the export file path that you use so that you do 
not have to enter or select this each time you export to the same file type. 

4. Specify a filename to which your export should be saved.  
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5. Tick the Advanced button to specify how exports to an existing filename or table must be 
handled (i.e., append, overwrite, skip).  

6. Select OK.  

A message box indicating successful export appears. 

 

Figure 4-96. The Export Complete message box. 

7. Click OK to close this box. 

When you export to a Datawatch Designer data source, the message box returned after 
completion of the export operation includes a link that will allow you to open Datawatch 

Designer and immediately use the exported table as a data source. Note that you must 
have Datawatch Designer installed to take advantage of this functionality. 

EXPORTING TO IBM WATSON ANALYTICS 

Watson Analytics is IBM’s cloud-based service that streamlines the data-analysis process for 
most business users. Using this service, analysts can upload their data and, among other 

activities, start exploring the same by typing in questions into or selecting suggested 
questions from a simple dialog box.  

 

Figure 4-97. Starting an exploration of the table “Data Processing + Compensation.” 
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Answers to these questions display in a panel below the question field. When an answer is 
selected, the related visualization displays. 

 

Figure 4-98. The results of a Watson Analytics exploration. 

Exporting to Watson Analytics is only possible through Monarch Complete and Monarch for IBM 
Analytics. Note also that Internet Explorer 11 must be installed in your computer to run this 

application correctly. More information on this requirement can be found here. 

Some information is necessary to successfully export and work with your data in IBM Watson 
Analytics: 

 A correctly set up Watson Analytics service 

 IBM ID – Your IBM login ID 

 Password – Your password 

Steps: 

1. Continuing from your tables in the previous exercise, export the table Join(1) (Data 
Processing + Compensation) to IBM Watson Analytics. 

 

Figure 4-99. Exporting to Watson Analytics. 

2. Enter your IBM login information into the dialog that displays. 

3. Select Sign In when you are finished.  

http://www-01.ibm.com/common/ssi/cgi-bin/ssialias?infotype=an&subtype=ca&appname=gpateam&supplier=897&letternum=ENUS214-475
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Figure 4-100. Logging into the IBM Watson Analytics service. 

 

 

NOTES 

You will need to provide your IBM login information only once per 
Data Prep Studio session. Subsequent exports to the same service 
will use the information you provided upon first export to Watson 

Analytics.  

Exports to Watson Analytics feature a 100-character limit, which 
means text fields with over 100 characters will be truncated. This 
limitation is a known issue in Watson Analytics and is implemented 

to maintain performance. 

Also, different account types present different restrictions when 

opening exported files in IBM Watson Analytics: 

 Free Edition - Can open files with a maximum of 100,000 rows 
and 50 columns; file size should be no larger than 500 MB. 

Overall capacity for all data sets and analyses is 500 MB. 

 Personal Edition - Can open files with a maximum of 

1,000,000 rows and 256 columns; file size should be no larger 
than 2 GB. Overall capacity for all data sets and analyses is 2 

GB. 

 Professional Edition - Can open files with a maximum of 
10,000,000 rows and 512 rows; file size should be no larger 
than 4 GB. Overall capacity for all data sets and analyses is 4 
GB. 
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The export operation is executed and the Export Complete message box displays. 

At this point, you can use your browser to access your Watson Analytics service and view 
your exported table. You’ll be able to begin exploration of your data as soon as you select 
a data set to work with.  

 

Figure 4-101. Logging into the IBM Watson Analytics service. 

EXPORTING TO IBM COGNOS ANALYTICS 

Cognos Analytics is a cloud-based application developed by IBM that allows sharing of data 
and information across workgroups as well as create and/or personalize dashboards and 
reports on various types of devices.  

 

Figure 4-102. The Welcome page of Cognos Analytics. 

Exporting to Cognos Analytics is only possible through Monarch Complete and Monarch for IBM 
Analytics.  
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Some information is necessary to successfully export and work with your data in IBM Watson 
Analytics: 

 A correctly set up Cognos Analytics service 

 Service root URI – The URL of your Cognos Analytics service. This URL must be entered 

into the field provided in the Server tab of the Settings dialog of Data Prep Studio.  

 Namespace – The security connection type employed for the service 

 Username 

 Password  

Steps: 

1. Go to the Server tab of the Settings dialog and enter the URL of the Cognos Analytics 
Service you are connecting to. Select OK to save your changes.  

2. Continuing from your tables in the previous exercise, export the table Data Processing + 
Compensation to IBM Cognos Analytics. 

3. Enter the necessary information into the dialog that displays. 

 

Figure 4-103. Entering Cognos Analytics connection information. 

 

 

NOTE 

You will need to provide your login information only once per Data 
Prep Studio session. Subsequent exports to the same service will 

use the information you provided upon first export to Cognos 
Analytics. 

 

 

4. Select OK when you are finished.  
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The table you exported should display in My Content when you log into your Cognos 
Analytics service.  

 

Figure 4-104. The exported table displays in My Content. 

EXPORTING DATA TO MICROSOFT POWER BI 

Data Prep Studio now supports exports to Power BI by creating files that are automatically 
placed in your Power BI workspace provided that you have a Microsoft Power BI account. Note 
that you must have a Microsoft Power BI account to execute exports of this type successfully. 

If you do not have one yet, you can sign up for an account here. 

 

Steps: 

1. Select a table to export to Microsoft Power BI. 

2. From the Data Prep Studio toolbar, select Export > Microsoft Power BI. 

The dialog in Figure 4-105 displays. 

https://powerbi.microsoft.com/en-us/pricing/
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Figure 4-105. The PowerBI Export login dialog. 

3. Enter a valid email or phone number and password into the fields provided in this dialog. 
Select Sign in when you are finished.  

The Authorize PowerBI Export dialog displays for first-time users.  

 

Figure 4-106. The exported table displays in My Content. 
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4. Click Accept. 

The export operation is performed and the table is added as a new dataset in your 
Microsoft Power BI account. 

 

Figure 4-107. The results of the current export operation. 

EXPORTING DATA TO MONARCH SWARM 

Monarch Swarm is a self-service data preparation and analytics platform that accelerates the 
exploration and preparation of data, and delivers timely data discovery through automation 

and distribution across an organization. 

Workspaces and data sources may be exported to the Monarch Swarm Library.  

To do so, select Export Data > Monarch Swarm. 

The Monarch Swarm Export dialog displays. Confirm the details of the indicated Monarch 
Swarm Server, modify the table/workspace name as you wish, and then click OK to complete 
the export operation.  

More details on Monarch Swarm may be found here.  

  

http://docs.datawatch.com/swarm/desktop/index.htm
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EXPORTING TO TABLEAU SERVER 

Data Prep Studio allows you to export to or update existing worksheets in Tableau Server. 

However, to be able to do so successfully, you need to have installed the Tableau TABCMD 

program first. Click here to download and learn more about the utility. 

To export data to Tableau Server, follow the steps outlined below. 

Steps: 

1. Select the table you wish to export and then click Export Data from the Data Prep Studio 
toolbar. 

2. In the Export dialog that displays, click Tableau Server. The Tableau Server Export dialog 
displays. 

 

Figure 4-108. The Tableau Server Export dialog. 

3. Enter all of the required information and then select OK. 

 

More information on exporting to Tableau Server may be found here. 

https://onlinehelp.tableau.com/current/server/en-us/tabcmd.htm
http://docs.datawatch.com/monarch/desktop/Exporting_Data_to_Tableau_Server.htm
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Switching from Data Prep Studio to 
Monarch 
To access Monarch from Data Prep Studio, select Application Menu  > Switch to 

Classic Mode and then choose Classic Mode. When launching Monarch Complete for the first 
time, the Choose Startup View dialog displays.  

 

Figure 4-109. The Choose Startup View dialog. 

The Home screen of Monarch displays.  

 

Figure 4-110. Monarch Classic’s Home screen.  

When you specify Classic Mode as the startup view, sessions after the current one will 
automatically display the Monach Classic view when the application is run. Conversely, if you 
specify Data Prep Studio as the startup view, all sessions after the current one will 
automatically display the Data Prep Studio view when the application is run. 

If you wish to work with Data Prep Studio when the startup view is Monarch Classic, click the 

Data Prep Studio  button on the Home ribbon.  
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NOTE 

You may also switch to Monarch Classic mode when in the Report 
Discovery window. While defining fields in Report Discovery mode, 
you may wish to open the report in Monarch to take advantage of 
Monarch’s more-advanced field-capture abilities. To do so, click 
the Edit in Classic Mode located on the toolbar of the Report 

Discovery window.   

 

 

Congratulations! You have just completed the Data Prep Studio lessons. We hope you have 

found them to be a helpful introduction to Data Prep Studio’s capabilities. 

For additional information not covered by this tutorial, we suggest you thoroughly explore 
Data Prep Studio’s help system. To do so, simply click the following link: 

http://docs.datawatch.com/dps/help/desktop/About_Monarch_Data_Prep_Studio.htm  

More documentation on Data Prep Studio is also available on http://docs.datawatch.com/dps/. 

The previous lessons reveal that users who wish to open database tables quickly, clean them, 
and transform them for further application, such as in data visualization, may find Data Prep 

Studio a great solution to their needs. However, while data extraction from reports and export 
capabilities are also provided in Data Prep Studio, these features may not be adequate when 
you want to extract data from some file types, such as .TXT, or export to a specific format not 
supported by Data Prep Studio. To do these, you will need to work with Monarch Classic.  

http://docs.datawatch.com/dps/help/desktop/About_Monarch_Data_Prep_Studio.htm
http://docs.datawatch.com/dps/help
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[5] Monarch Table Extractor 
Lessons 

Monarch Table Extractor is designed for ordinary people who wish to do extraordinary things 

with PDF files. 

Available only with a Monarch Complete with Table Extractor license, the application allows 

you to identify tables in text-heavy PDF files, select them, modify them if you wish, and then 
export them to Data Prep Studio for further data preparation. 

 

Figure 5-1. A typical Monarch Table Extractor workflow.  

Monarch Table Extractor provides easy-to-use interfaces to perform the following: 

 Automatically look for and define tables in a document 

 within a page, 

 in all pages, or 

 in specific pages. 

 Modify tables that have been defined (e.g., modify headers, rename columns, and delete 
columns) 

 Create a custom table 

 Export tables to Monarch Data Prep Studio 

 

The lessons outlined in this tutorial provide a very brief overview of what you can do with 
Monarch Table Extractor. To learn more about this application, click here. 

http://docs.datawatch.com/monarch/desktop/MTE_About_Datawatch_Monarch_Table_Extractor.htm
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Launching Monarch Table Extractor 
Launch Monarch Table Extractor by selecting Start > All Apps > Datawatch Monarch 14 > > 
Datawatch Monarch Table Extractor. 

The Datawatch Monarch Table Extractor start page displays. 

 

Figure 5-2. The Monarch Table Extractor Start page. 

Opening a Document 
The easiest way to open and work with a document is to drag it to the Monarch Table 
Extractor interface.  

The following typical example describes how to open a pdf document and define tables, using 

a file named Canaccord 042215.pdf. If you do not have access to this document now, simply 

follow along with this tutorial. 

Steps: 

1. Navigate to the location of Canaccord 042215.pdf. 

2. Drag Canaccord 042215.pdf to the Monarch Table Extractor start page. 
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Figure 5-3. Starting a Monarch Table Extractor session.  

Canaccord 042215.pdf is loaded into Monarch Table Extractor.  

 

Figure 5-4. The loaded document. 

You can also do the following: 

 Select the Open PDF button on the Start page, and use the standard File Open dialog box 
to locate your document and open it. 

  

Drag 
Here 

Document Page Preview displays 

the current page of a document. 

Use this window to view a page and 

its tables.  

 

Page Thumbnails display 

thumbnails (i.e., small versions of 

the document pages) that you can 

use to easily look for a specific 

page. 
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 Select Open from the Application Menu, and use the standard File Open dialog box to 
locate your document and open it. 

 

Figure 5-5. Monarch Table Extractor’s Application menu . 

Defining Tables 
Define one or all tables by selecting any one of the following from the Table Actions panel: 

 Auto Define Page 

 Find All Tables 

 Find Tables from Pages 

For this session, let us auto-define a page. In this section, we will auto-define tables, verify 
the tables, and delete one of them. 

AUTO-DEFINING A PAGE 

Select Auto Define Page to ask Monarch Table Extractor to look for and then automatically 

define all tables in the current page. 

Steps: 

1. While Page 1 of Canaccord 042215.pdf is displayed, select Find Tables > Auto Define 
Page from the Table Actions panel. 

 

 

Figure 5-6. Auto-defining a page. 

Table Actions 

Auto Define Page 
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Monarch Table Extractor looks for data arranged in a tabular structure and converts these 
into actionable tables.  

 

Figure 5-7. Locating all tables in a PDF file. 

VIEWING AND MODIFYING A TABLE 

Data from the tables are displayed on the table panel.  

In addition, a Page/Table list shows the page where a table is located and all the tables 
defined for that page. 

Steps: 

1. Select Page 1 – Table 3 on the Page/Table List.  

The table is highlighted on the document, and the values for the table are displayed on the 

Table panel. 

Expandable/collapsible 

Page/Table List allows you to 

select a table from a specific page.  

 

Table Panel Menu displays 

actions you can carry out on 
tables. 

 

Table panel 

Data Preview Grid displays a 

preview of extracted table data. 
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Figure 5-8. Selecting a specific table in Monarch Table Extractor. 

On the document, the table looks like this: 

 

Figure 5-9. A selected table in Monarch Table Extractor. 

The table is surrounded by a dashed border with handles. Headers (which may be 
separate from the table) are highlighted in pink. Columns are highlighted in blue.  

2. Do one of the following to modify a table or its elements: 

 Right click on a table, header, or column to display context menu items.  

 

Figure 5-10. Selecting a table to modify. 

Click between columns to select a table a table.  
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Select a table, and then click on a column, to select the column. 

Select a table, and then click on a header, to select the header. 

 Select specific text via drag-and-drop to display additional context menu items as well. 

 

Figure 5-11. Selecting specific text via drag and drop. 

The context menu items that display will allow you to 

 create a new column, 

 delete columns, 

 exclude values from a table, 

 combine tables, 

 define a table title, 

 modify headers, and 

 delete spaces from header and table values. 

  



 

 

Monarch 14.2 Learning Guide   123 

 

DELETING A TABLE 
You may not need all the tables defined by Monarch Table Extractor. You can easily delete 
tables via the context menu or the Table panel menu. 

Steps: 

1. Select Page 1 – Table 1 on the Page/Table List. 

This table is highlighted: 

 

Figure 5-12. Selecting a table to delete. 

Although this looks like a table, the values are not related as columns or rows. We can 
delete this table. 

2. Right-click on Page 1 – Table 1 on the Page/Table List.  

A context menu displays. 

 

Figure 5-13. Deleting the selected table. 

3. Select Delete Table from the context menu. 

Exporting Tables 
After defining your tables, you can export them to Monarch Data Prep Studio. Once the tables 
are exported and loaded, you can work on them using Monarch Data Prep Studio's features. 

Note that you MUST manually launch both Monarch Table Extractor and Data Prep Studio to 
enable successful export. 
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Steps 

1. Right-click on Page 1 – Table 3 on the Page/Table list.  

A context menu displays. 

 

Figure 5-14. Exporting a table in Monarch Table Extractor to Data Prep Studio. 

2. Select Export Table to DPS. 

Alternatively, you can select the table on the Table Panel, and then select Export Table 
to DPS on the Table Panel Menu.  

 

 

Figure 5-15. An alternative method to export tables to Data Prep Studio. 
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[6] Monarch Lessons 

This chapter introduces you to the Monarch lessons.  

These lessons are designed to quickly acquaint you with basic program operations. For 

additional material not covered in this guide, consult the Monarch Help file by selecting File, 

clicking on the drop-down button of the Help  menu, and then selecting Help Topics from 
the options that display. 

 Chapter 7 – Working in Report View  

Shows you how to load a report file, navigate the report on screen, look up information in 
the report, copy selected data to other applications, and print pages from reports.  

 Chapter 8 – Extracting Data from a Report  

Shows you how to create a template to extract data from a simple columnar report, view 
the data in the Table view, and save the template to a Monarch model file. 

 Chapter 9 – Special Data Extraction Techniques  

Deals with special problems caused by address blocks, fields that run together in a report, 

and data presented in multiple columns.  

 Chapter 10 – Working in Table View 

Shows you how to load and navigate through a table, format fields, create headers and 
footers, print table data, and copy data to other applications.  

 Chapter 11 – Working with Sorts 

Shows you how to sort the table, create multiple sort definitions, select a sort definition, 

and save sort definitions. 

 Chapter 12 – Working with Filters 

Shows you how to use a filter to select records based on any field value, create multiple 
filters, utilize value-based filters, select an active filter, and save filter definitions.  

 Chapter 13 – Working with Calculated Fields  

Shows you how to create calculated fields to add information to the table database. 

 Chapter 14 – Working with Multiple Instances of a Report 

Shows you how data extracted from multiple reports may be sorted and analyzed in Table 
view. 

 Chapter 15 – Extracting Multiple Line Fields  

Shows you how to extract a multiple line text block from a report. It also introduces memo 
fields, which are used to hold the contents of a multiple line field, and covers exporting 
and printing memo fields. 
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 Chapter 16 – Summaries  

Teaches you how to create a summary report from your Monarch data, specify summary 
design preferences, and create quick summaries. 

 Chapter 17 – Advanced Summary Capabilities  

Shows you how to reveal even more information about your data via Monarch’s advanced 
summary features.  

 Chapter 18 – Exporting Operations 

Discusses how to export reports, tables, and summaries.  

 Chapter 19 – Importing Data from HTML and External Databases 

Discusses how to import data from various external sources. 

 Chapter 20 – Creating External Lookups 

Discusses how external lookups are performed in Monarch. 

 Chapter 21 – Using Digital Signatures 

Discusses how digital signatures are added to some exports in Monarch and viewed in 
Microsoft Excel. 

 Chapter 22 - Using Pivot Tables 

Discusses how pivot tables are added to some exports in Monarch and viewed in Microsoft 

Excel. 

 Chapter 23 – Working with Asian (CJK) Character Sets 

Discusses how to work with documents using Asian character sets 

 Chapter 24 – Using Monarch Utility 

Discusses how to use Monarch Utility to perform a number of functions. 

Installing Lesson Files 
When installing Monarch, the last screen of the Monarch Setup program provides a checkbox 
that asks whether to install the lesson files.  

When this box is ticked, the Setup program will install the lesson files in the appropriate 

folders under the Datawatch Monarch folder in the Public Documents area.  
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The Options Interface 
The Options interface allows users to configure several universal Monarch settings, including 
Folders, input information, views, and exports, among others.  

 

Figure 6-1. The Options window.  

Clicking specific buttons on the Options ribbon exposes settings you can modify. When you 

have modified the settings as you wish, simply click Accept  to accept your changes and 

close the interface. You may specify several options before selecting Accept . Select 

Cancel  to disregard any changes you made and close the interface. In this case, none of 
the previous settings are modified. 

The following table summarizes the functions of each of the buttons in the Options ribbon.  

Use this button… To… 

 Accept 
Accept the changes you made and close the 
interface 

 Cancel 
Cancel the changes you made and close the 

interface 

 Folders 
Expose folder settings 

 Input 
Expose input settings 

 View  
Expose view settings 

 Export 
Expose export settings 
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Use this button… To… 

 Clipboard 
Expose clipboard settings 

 Security 
Expose security settings 

 Datawatch Server Library 
Expose Datawatch Server Library settings 

 Time Intervals 
Expose time interval settings 

 Advanced 
Expose advanced settings 

 Cache 
Expose caching options 

 Themes 
Expose theme settings 

 Help 
Launch the Help file 

 

More information on each of the settings available in the Options window is available here. 

http://docs.datawatch.com/monarch/desktop/Options_Window.htm
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[7] Working in Report View 

In this chapter, you will learn how to launch Monarch and work in Report view. Lesson topics 
include: 

 Starting a Monarch session 

 Opening report files 

 Navigating through reports 

 Using bookmarks 

 Copying data from reports 

 Printing data from a report 

 Using PDF and XPS files 

Most computer applications produce reports as output. Monarch is unusual because it uses 
reports as input. A Monarch session begins when you open an existing report. The report 
displays in Report view. 

The Report view gives you a scrollable view of your report. You can move around, look things 
up, copy data to other applications, and print pages on your local or network printer. In this 
lesson, you will learn the basics of these operations. In later lessons, you will learn how to 
extract and export data from reports. 

Opening Report Files 
In Monarch, you can open either one or several reports (up to 1,024 reports!) in a single 
session.  

OPENING A SINGLE REPORT FILE 

To begin working with Monarch, you need to open a report file. We use the term “report file” 

to describe any computer report stored on disk. These files are often referred to as print, 
spool, TXT, PRN, SDF, PDF, and formatted or fixed width text files. 

We have provided several report files for use with these lessons. In this lesson, we will first 

open single report files and then open multiple report files.  
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NOTES 

Monarch opens a report as a “read-only” file. Monarch can write a 
new file with data extracted from the report, but the original 
report remains safe because it cannot be altered. 

You can also open reports in zip files or web and other locations. 

If you have set up Datawatch Server Library credentials in the 

Options interface, you can also open files located in the specified 
Datawatch Server Library. 

 

 

Let’s open a report file. 

Steps: 

1. On the File tab, select Open  > Report > Computer.  

 

Figure 7-1. The Open Report dialog.  

The Open Report dialog appears. The Files list displays all the files in the Reports folder 
with a DAT, PRN, RPT, or TXT extension. If you don’t see a list of files, make sure you are 

viewing the Monarch > Reports folder, and the file type is set to Print Files 
(*.dat;*.prn;*.rpt;*.txt), as shown in Figure 7-1.  

2. Select Classic.prn, and then choose Open. 

Monarch displays a softcopy of the report in Report view. The report shows customer 
shipments for a distributor of classical music recordings. 
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OPENING MULTIPLE INSTANCES OF A REPORT 

The procedure for opening multiple instances of a report is similar to that required to open a 
single report. 

Let’s start by opening the January shipping report. 

Steps: 

1. Assuming that you have launched Monarch, select File, click on the arrow of the Open  

menu, and then select Report.  

2. In the Open Report dialog that displays, click on ClassJan.prn, and then choose Open. 

January’s shipping report displays in Report view. 

 

Figure 7-2. Classical Music Distributors January shipping report.  

Next we’ll open the February shipping report. 

3. Select File, click on the arrow of the Open  menu, and then select Report.  

4. Click on ClassFeb.prn, and then choose Open. 

For each additional report you open, Monarch displays the Retention Options dialog. This 
dialog prompts you to discard or retain any currently open reports and model parameters 
before opening the new report. 
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Figure 7-3. The Retention Options dialog.  

To replace the existing report and model with a new report, you would leave the Retain 
Current Reports and Retain Current Model check boxes unchecked. Since we want to open 
a new report without closing the currently open report, we’ll choose to retain the current 
reports. 

5. Select Retain Current Reports, and then choose OK. 

The February shipping report replaces the January report in Report view. Note that 
Monarch does not create a separate window to display each report. Instead, all open 
reports are viewed in one Report view, with a single report displayed at a time. When two 
or more reports are open at the same time, Monarch displays the most recently opened 
report. You can select another report to view by clicking on it in the Report selector. The 
Document Selectors list all of the open reports, tables, and summaries in each Monarch 

session.  

So far we have opened two reports: ClassJan.prn and ClassFeb.prn. ClassFeb.prn was the 
last report opened so that report is currently displayed in Report view. 

Now let’s open the March shipping report. 

6. Select File, click on the arrow of the Open  menu, and then select Report.  

7. Click on ClassMar.prn, and then choose Open. 

This time the Retain Current Reports check box is already selected. 

By preserving your most recent dialog settings, Monarch saves you a step each time you 
open a new instance of the report. 

8. Choose OK. 

The March shipping report is opened and displayed in Report view. 
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Getting to Know Report View 
Let’s take a minute to explore what you can find in the Report interface. 

 

Figure 7-4. The Report interface.  

The Report interface is divided into three distinct areas. The Report ribbon is located on the 
top-most portion of the interface and spans the entire width of the screen. This ribbon will 

allow you to perform many of the report functions made available by Monarch. The Report 
selector displays as a panel on the left-hand side of the interface. You can choose specific 
reports to view from this selector, a functionality that is especially handy when you have 
multiple reports open. Finally, the actual report is displayed on the right-hand portion of the 
interface. 

The following table summarizes the functions of each of the buttons in the Report ribbon.  

USE THIS BUTTON… TO… 

 Report Design 
Launch the Report Design interface 

 Auto Define 
Automatically creates a template (or sets of 

templates, if applicable) for an open report. Note 

that this feature is only enabled in Monarch 
Complete and that the resultant model is applied 
to all other open reports.  

 Font Style 
Select a font style 

 Font Size 
Select a font size 

 Zoom to Fit 
Automatically resize the report into the available 
Report view using the best possible fit 

 Greenbar 
Add greenbar shading to the report 
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USE THIS BUTTON… TO… 

 Select All 
Select all of the text in the report 

 Copy 
Copy text from the report 

 Search 
Search for information from the report 

 Find in Table 
Find the table entry corresponding to a specific 

line in the report 

 Previous Report 
Go to the previous report if multiple reports are 
open  

 Previous Page 
Go to the previous page of a multiple-page report 

 Go to Page  
Go to a specific page of a multiple-page report 

 Next Report 
Go to the next report if multiple reports are open 

Next Page 
Go to the next page of a multi-page report 

 Bookmark 
Add a bookmark to a specific record 

 Next Bookmark 
View the next bookmark 

 Previous Bookmark 
View a previous bookmark 

 Clear Bookmark 
Clear all bookmarks 

 Report Index 
Display or define the report index 

 PDF/XPS Options 
Specify character spacing options when opening 

PDF/XPS files 

 Open as a Table in Data Prep 

Studio 

Open the report as a table in Data Prep Studio  

 Help 
Launch the Help file 

 

Navigating Through Reports 
Although the softcopy report looks just like its hardcopy cousin, you can use Monarch to zoom, 

scroll, page, jump, and quickly find information within it. These tasks would be a lot more 
difficult to carry out with a hardcopy report. Let’s look at some of the benefits of viewing and 
exploring a softcopy report on screen using the three files we opened previously. Make sure 
that you select the Report tab before you begin.  
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THE REPORT SELECTOR 

Report view opens and Monarch also displays, by default, a panel on the left side of the 
screen: the Report selector. 

 

Figure 7-5. The Report selector. 

Clicking on any report in the Report selector opens the report in Report view. 

The Search Selection box allows you to search for open reports. This functionality would be 
useful if, for example, you had a large number of open financial reports and want to search 

specifically for sales reports for a certain year.  

 

Figure 7-6. The Search Selection box allows users to search for individual reports in the Report 
selector. 

Right-clicking on the Report selector displays a context menu that will allow you to perform 
the following operations: 

 Close a report 

 Print a report 

 Quick print a report 

 Preview a report before printing 

 Export (all files) 

 Export a selected file 

 View the File Information dialog (includes details on file path and name, size, lastmodified 
date) 
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ADDING GREENBAR 

Because Monarch operates in a graphical environment, you can adjust the display to enhance 
readability and suit your own visual preferences. Monarch can display a greenbar effect on the 
screen, which helps your eyes track across sparse columns in a wide report. If you prefer not 
to display greenbar, however, you can easily remove it. 

Steps: 

1. On ClassJan.prn, select Greenbar  from the Report ribbon.  

2. The report displays with greenbar shading.  

 

Figure 7-7. The report displayed with greenbar shading.  

3. To remove greenbar shading, simply select Greenbar  again.  

 

 

NOTE 

For the remainder of this Learning Guide, we will not use the 
greenbar feature.  
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CHANGING FONTS AND FONT SIZES 

Monarch allows you to change the font and font size used to display reports on screen. 

Steps: 

1. To change the font, in the Report ribbon, click the drop-down  button on the Font Style 
box.  

 

Figure 7-8. Changing font styles. 

Only non-proportional fonts with fixed letter spacing are available because report columns 
may appear misaligned if proportionally spaced characters were used.  

2. Select the Lucida Console font from the list.  

The font style is changed throughout the entire report. 

 

You may also change font size in order to zoom in or zoom out. Experiment with the font size 
until you find the size you like best. 
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Steps: 

1. Click the drop-down  button on the Font Size box. 

 

Figure 7-9. Changing font sizes.  

Font sizes vary depending on the font style selected. If the size you want isn’t available, 
use the font list to select another font. You can let Monarch select the font size for you 
using the Zoom to Fit command. This selects the font size that matches the report width 
to the display width, so you can view the entire width of the report on screen. 

2. To change the font size to match the report width to the display width, from the Report 

ribbon, select Zoom to Fit . 

If the report is too wide to fit on screen even at the smallest available font size, Monarch 
will select the smallest font size to fit as much of the report width as possible in the 
available display area. 

MOVING TO THE NEXT PAGE OF A REPORT 

It can be a tedious chore to dig through page after page of a big hardcopy printout. With 
softcopy reports on screen, however, your computer does most of the work for you. Monarch 
lets you move around with just a few clicks of your mouse. 

Like most Windows applications, Monarch provides a vertical scroll bar to help you scroll 
through a report. You can scroll through the report by pressing the up or down arrow on the 
scroll bar or by clicking and dragging the slider with your mouse. As you drag the slider, a 
tooltip window displays the current page of the report. To display a particular report page, 
drag the slider until the tooltip displays the desired page number.  
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For example, the following figure shows Page 8 of the ClassJan report.  

 

Figure 7-10. Scrolling through a report. 

To move through the different pages of a report, you can: 

 Use the Previous Page  button 

 Use the Next Page  button 

 Use the Go to Page  button 

When you select the Go to Page  button, the Go to Page dialog displays. 

 

Figure 7-11. The Go to Page dialog.  

Enter the desired page (e.g., 8) into the Page Number field and then click OK. Monarch 
displays the specified page in Report view. Go back to Page 1 before moving on with this 
lesson.  

Dotted lines indicate page breaks. Monarch relies on page break characters in the report file to 
determine where breaks belong. If breaks are not explicitly defined in the report file, Monarch 
breaks pages after a fixed number of lines. 

To move left or right, press the left or right arrows on the horizontal scroll bar, or drag the 

slider with your mouse. 
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MOVING THROUGH SEVERAL REPORTS 

To move through different reports when multiple reports are open, you can: 

 Use the Previous Report  button 

 Use the Next Report  button 

FINDING INFORMATION IN A REPORT 

It’s not always easy to find information buried deep in a hardcopy report. If you’re looking for 
a particular invoice in a report that is 75 pages long, for example, you can spend a lot of time 
and effort reading each page and you may not even find the report you want. Fortunately, 
Monarch can search reports at lightning speed to find whatever you want. Suppose you want 

to find all references to the composer, Mozart. You can use the Search function for this.  

Steps: 

1. Select the ClassJan.prn report and ensure that you are on its first page. 

2. Select Search  from the Report ribbon. 

A Search box displays on top of the Report view. 

 

Figure 7-12. The Search panel.  

3. Type Mozart in the Search field and then click Find Next. 
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The first occurrence of Mozart in the report will be highlighted. By default, search items 
are returned in a top-down manner. To search in a bottom-up manner, check the Search 
Up box among the Search options. 

4. Continue clicking the Find Next button to locate the next instances of Mozart.  

 

 

NOTES 

You can make searches case-sensitive by selecting Match Case. To 

reverse your search, i.e., to search for previous instances of the 
word or phrase, check the Search up box before clicking Search. 

The option Search all reports allows you to locate all instances of 

the search item in all open reports.  

 

 

5. Close the panel by selecting Search  on the ribbon more. 

Using Bookmarks 
Monarch allows you to set bookmarks within a session that can be used to navigate quickly 
between certain lines or sections of a report. You can even annotate bookmarks.  

 

 

NOTE 

Although bookmarks aren’t saved in model files, they are saved in 
project files. When exporting to a PDF file while in the Report view, 
bookmark comments will be displayed as comments within the 
PDF file. 

 

 

Let’s set bookmarks for Spinning Records and Musique Royale. 

Steps: 

1. Use the search tool to locate Spinning Records in the ClassMar.prn report.  

2. Click in the left-hand margin next to CUSTOMER to highlight that line. 
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3. Select the Report tab. On the ribbon that displays, select Bookmark . The Add 
Bookmark dialog displays. With this dialog you can add a comment to a bookmark. Let’s 

try doing this.  

  

Figure 7-13. The Add Bookmark dialog.  

4. Type whatever text you’d like (e.g., This is a bookmark comment.) and then click the 
OK button. A bookmark indicator appears on the left hand margin next to the highlighted 

line of text. 

5. Place your mouse pointer over the bookmark indicator.  

The text you typed is displayed. 

 

Figure 7-14. A bookmark is added to Spinning Records.  

6. Use the search tool to locate Musique Royale, and then repeat Steps 2–4 to bookmark it.  
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NOTE 

You can click the OK button on the Add Bookmark dialog without 
actually entering a comment if you wish. To prevent the Add 
Bookmark dialog from displaying on a specific bookmark, clear the 
Show when adding check box.   

 

 

You can move through bookmarks by clicking either Next Bookmark  or Previous 

Bookmark  from the Report ribbon.  

To remove a specific bookmark, select the bookmark you would like to remove and then 

click the Bookmark  button from the Report ribbon.  

To clear all bookmarks, select Clear Bookmark  from the Report ribbon.  

 

Copying Data from Reports 
Monarch makes it easy to transfer report data to other applications. Just copy and paste! 
When you copy data from a report, Monarch creates both a text image and a worksheet image 
with separate columns and cells in the clipboard. 

Let’s copy a customer’s name and address into your word processor. You might use this 

feature if you wanted to insert the address into a letter. 

Steps: 

1. Go to the first page of the ClassJan.prn report. 

2. Click at the beginning of the customer’s name (Betty’s Music Store in this case) and 

drag diagonally down to the right to highlight the entire customer name and address, as in 
Figure 7-15.  

 

Figure 7-15. Copying a portion of the report.  
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3. Select Copy from the Report ribbon. 

4. Launch your word processor. 

5. Position the cursor where you want the address to appear and use your word processor’s 
Paste (CTRL + V) command to insert the address into the document. 

 

Figure 7-16. Pasting to a word processor.  

 

 

NOTE 

If you wish to copy all of the text in the report, select the Select 

All  button on the Report ribbon before clicking the Copy  

button. 

 

 

If you wish to keep this document, save it before returning to Monarch.  

4. Exit your word processor without saving the document and return to Monarch. 
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Printing from a Report 
Monarch lets you print from the Report view. You can print a block of text, a page or series of 
pages, or the entire report. 

Let’s print a single page from the report. We’ll begin with Print Preview to see how the page 
will look before producing the actual printout. 

Steps: 

1. Return to the first page of the report ClassJan.prn. 

2. Select the File tab, click on the arrow of the Print  menu, and then select Print 

Preview from the options that display. 

The Print Preview window displays.  

 

Figure 7-17. The Print Preview Window.  
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3. Examine the Print Preview window to see if your settings for font size, margins, and page 
orientation are appropriate to produce satisfactory output. If not, you can change the 
settings until everything looks just right. We’ll change settings in a minute, but first, we’ll 
see how the Print Preview window works. 

4. Click Zoom to zoom in or out.  

5. Click the Next Page  or Previous Page  icons to move forward or back. 

Now, we’ll adjust our page orientation, margins, and font settings. On many printers, the 

Classic report prints nicely with a portrait page orientation, half-inch margins, and a 9-
point font. You may need to experiment to find the right settings for your printer. 

6. Select the drop-down button of the Page Orientation menu to confirm that the page 
orientation is set to Portrait. 

7. If you wish to change page margin settings, select Page Setup  and adjust the margin 
settings as necessary for your printer by double-clicking on the margin you wish to modify 

and entering your desired value. Select OK when you are finished. For now, though, let’s 
leave the margins as they are.  

 

Figure 7-18. The Page Setup dialog.  

8. When satisfied, close the Print Preview window by clicking the  button on the upper 

right-hand corner of the window. 

9. Select the File tab, click on the arrow of the Print  menu, and then select Print from 

the options that display.  

We’ll print Page 5. 
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Figure 7-19. The Print dialog.  

10. Select the printer you would like to use.  

11. Select the Pages radio button and then type 5 in the Pages box. 

12. Select Print. 

The selected page will be printed. Monarch prints report pages as composed in the report 

file. Because Monarch adopts pagination from the report file, you must be careful to select 
an appropriate font size and margin settings to ensure that the full report image will fit on 
each page. Any lines that do not fit will be carried over to a subsequent page. Any 
columns that do not fit will be truncated. 

Closing Reports 
During each Monarch session, you may wish to use several report files and thus have a need 
to close other reports. Let’s do that now. 

Steps: 

1. Ensure that the report ClassMar.prn is selected in the Report selector. 

2. Select File > Close  > Report.  

If you had other files open, such as a model, a database file, or a project, that you wish to 
close, you can also select these from the options presented when you select Close. 

3. A message box displays to ask you if you wish to close the ClassMar.prn report. Click Yes.  

The selected report is closed and the Report selector displays the two remaining open 

reports.  
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Repeat Steps 1 to 3 to close the ClassJan.prn and ClassFeb.prn reports.  

If you had both report and model files open and want to avoid having to close each file 
one by one, you can use the Close All command, which is called when you select File > 

Close All . This command closes all of the open files in your Monarch session. You will 

be asked whether or not you would like to save model changes if you defined templates 
during the Monarch session. 

Using PDF and XPS Files 
Monarch has the ability to convert PDF/XPS files into text so that they can be utilized like any 
normal text report in Monarch. You can then create data extraction templates to extract 

information in exactly the same way as you would approach a text report file.  

PDF/XPS is an open standard, so there are thousands of different applications that create 
PDF/XPS files using many different techniques. This has the side effect of having PDF/XPS files 
that may look identical on screen, but are structurally very different internally.  

Monarch uses very sophisticated techniques to analyze and reformat the data, in order to 

produce the best possible "Monarch-friendly" results to enable accurate trapping after 
importing the data.  

However, there may be some badly formatted and unusual PDF/XPS files that do not convert 
accurately enough to trap easily in Monarch. Files that do not convert perfectly may still be 
processed very effectively by Monarch via features such as the floating trap and calculated 
fields. Let’s begin this lesson by importing a PDF file into Monarch.  

Steps: 

1. Select File, click on the arrow of the Open  menu, and then select the Report option 
to display the Open Report dialog.  

2. Select the PDF files (*.pdf) option from the Files of Type drop-down list, select the 
ClassJan.pdf file, and then click the Open button to open the PDF in the PDF Import 
Options window. 
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Figure 7-20. The opened PDF file.  

3. For now, simply select Accept  on the PDF Import Options window to display the 
report.  

As we can see, ClassicJan.pdf is a PDF version of the ClassicJan.prn report, which we are 
already familiar with.  

To import an XPS file into Monarch, follow the same procedures outlined above, but 

choose the XPS files (*.xps) option from the Files of Type drop-down list instead. 

 

When opening a PDF/XPS file, Monarch performs an analysis of the file to try and determine 
the optimum method of transforming the data accurately. In most cases, Monarch’s auto-
detection routines will produce the best results, but under certain conditions, adjustments to 
the PDF/XPS import options may be necessary. For example, the following conditions may 
require the PDF/XPS import options to be adjusted: 

 The PDF/XPS contains tables with tightly compacted columns. 

 The PDF/XPS contains multiple font sizes and the data of interest is in a smaller font than 
most of the other text in the PDF, thereby causing the auto-calculated font size to be too 
large. 

 Mixed mono- and variable-spaced fonts exist in the PDF/XPS where the data of interest 
uses mono-spaced fonts. 

 Mixed freeform and tabular data exist in the PDF/XPS. 

Let’s examine the PDF/XPS import options more closely, and see how adjusting them will 
affect the data transformation. 
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THE STRETCH OPTION 

The stretch option governs how much spacing is used during the conversion process. When 
Monarch analyzes the PDF/XPS file, it tries to match the spacing as closely as possible to the 
original document. However, there are many factors that can make it necessary to introduce 
more spacing into the conversion than appears to exist in the original PDF/XPS file. Such 
factors can include hidden data in the PDF/XPS, i.e., data which is not visible on screen but 

still exists within the PDF/XPS file itself. This can be the result of columns that truncate the 
data, for example. At first glance, it is not apparent that any data is missing, but Monarch will 
convert all the data in the PDF/XPS file, not just what might be visible in a PDF/XPS viewing 
application. In this case, in order to try and maintain proper column justification, Monarch will 
have to recalculate and pad the spacing, as the original column spacing may not be enough to 
hold the data safely. 

In general, Monarch’s behavior is to use a larger amount of spacing (i.e., a higher stretch 

value) than in the original document. This can make the document look like it is stretched 
wider than the original PDF/XPS, but Monarch errs on the side of caution, so that columns do 
not run into each other in the current document. This is also done so that if a later iteration of 
the same report (or a similar one) contains wider data values, the model will still “work” with 
it. 

If you know your reports well, then you can decrease the stretch value to make the reports 
look more presentable by avoiding horizontal scrolling or very small font sizes in the Report 

view.  

Stretch values may be increased or decreased via the PDF/XPS Import Options window, which 

is launched when you select PDF/XPS Options  in the Report ribbon. 

THE MONO-SPACED OPTION 

Mono-spaced refers to the fact that a mono-spaced font was used in the PDF/XPS. The 
Monarch Report view uses mono-spaced fonts, which are fonts in which each character has the 
same width. For example, in a mono-spaced font, the “o” and “i” characters would have the 
same width (i.e., they would take up the same amount of horizontal space on a line). Other 
terms for mono-spaced are fixed-width and non-proportional.  

 

 

NOTE 

The opposite of mono-spacing is proportional spacing, in which 
different characters have different widths, e.g., in a proportionally 
spaced font, the letter “o” would be wider than the letter “i.” 

 

 

Note that the Mono-spaced option is already selected on the window. When you import a 
PDF/XPS file into Monarch, Monarch tries to detect when mono-spaced fonts are used and 

optimizes the conversion accordingly. In some cases, Monarch may not detect that mono-
spaced fonts were used for the PDF/XPS file. When this failure occurs, it is usually due to a 
mix of mono-spaced and proportional fonts existing in the same PDF/XPS file. If you know that 
the PDF/XPS file uses mono-spaced fonts, and the Mono-spaced option is not selected during 
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the import analysis, you can select this setting to force Monarch to optimize for mono-spaced 
fonts. 

While proportionally spaced fonts look more appealing, mono-spaced fonts are superior for 
tabular data because the uniform width of each character makes alignment of columns easier. 

 

 

NOTE 

In general, PDF/XPS files generated using mono-spaced fonts will 

convert more successfully, so if you are trying to optimize your 
PDF/XPS producing application for Monarch, use mono-spaced 
fonts. Some of the more common fonts include: Andale Mono, 
Anonymous, Crystal, Bitstream Vera Sans Mono, Courier, Courier 
New, Elronet Mono-space, Everson Mono Latin 6, Fixedsys, Lucida 

Sans Typewriter, Lucida Console, and PrestigeFixed. 

 

THE FREEFORM OPTION 

The Freeform option tries to optimize text that is more freeform than columnar or grouped 

columnar. A columnar document is a simple table format, where grouped columnar might be 
something similar to one of the Monarch sample reports, such as Betty’s Music Store 
(Classic.pdf).  

A typical document that might benefit from using this setting would be an academic report 
that is 95% text, but which contains a few tables you want to extract. 

 

 

NOTE 

This setting will sometimes work effectively on columnar 
documents when the default settings do not produce good results. 

 

 

When you select a PDF/XPS file from the Open Report dialog and then click Open, the 
PDF/XPS is automatically imported into Monarch as a report file. 

If we wanted to, we could now select a template sample and begin creating templates to 

extract the PDF/XPS file’s data. Since we’ve done plenty of this already, let’s try importing a 
PDF/XPS file into Monarch that will require us to modify the PDF/XPS import options. For now, 

close the PDF report by selecting File, clicking on the arrow of the Close menu, and then 
selecting Report. 
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CUSTOMIZING PDF/XPS IMPORT OPTIONS 

Steps: 

1. Select File, click on the arrow of the Open  menu, and then select Report from the 

options that display. 

2. In the Files of type drop-down box, select PDF files (*.pdf).  

3. Select the CustomerSummary.pdf file, and then click Open.  

You can also perform the next steps with an XPS file. In this case, open 
CustomerSummary.xps instead.  

Monarch opens the PDF Import Options window and displays a sample of the PDF file’s 

data. Let’s enlarge the window so that we can view more of the sample data. 

 

Figure 7-21. Viewing the resized window.  

Notice that for Bluegrass Records, the value in the Amount 1 column begins one space too 
far to the right, so that it doesn’t line up properly with the Amount 1 values for the other 

three customers.  

Let’s assume that we know the font used to generate this PDF was Tahoma, which is a 
proportional font. A quick visual investigation tells us this is not a freeform document, but 
is more of a columnar report. Let’s try adjusting the Stretch setting to see if this improves 
the conversion.  

4. In the Stretch size indicator, shift the marker until the size reads 7.0. You may need to 
resize the window to the right to see all of the data. Monarch applies the stretch setting 

and shows the results on the sample page. Note that the Amount 1 value for Bluegrass 
Records now lines up correctly with the Amount 1 values of the other customers. If you 
wish to increase the font size in the window, use the Zoom size indicator to resize the font 
as you wish.  
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Figure 7-22. Viewing the adjusted sample page.  

5. Click the Accept  button to close the PDF/XPS Import Options window and open the 
PDF file as a report.  

A closer look at all of the options available in the PDF/XPS Import Options window may be 
found here. 

This completes Chapter 6. If you plan to go on to Chapter 7 now, you may leave Monarch 

open but select the File tab and then click Close All . Select No when asked if you want to 

save changes to the model or project you created. If you plan to go on to Chapter 7 at a later 
time, select File > Exit Monarch.  

http://docs.datawatch.com/monarch/desktop/PDF_XPS_Options_Window.htm
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[8] Extracting Data from a 
Report 

In Chapter 4, you learned how to use the Report view to explore a report on screen. While this 

is very useful, Monarch goes much further in giving you access to the data buried in your 
reports. By defining data extraction templates, you can extract the data from your reports, 
then analyze it or export it using the Table and Summary windows, which are discussed in 

later lessons. In this chapter, you will learn how to extract data from a typical report. The 
lesson topics include: 

 Determining what an extraction template is 

 Creating various templates 

 Displaying data in Table view  

 Saving your work in a model file 

To get started on this lesson, load Monarch and open the Classic.prn report.

Getting to Know Report Design View 
The Report Design interface is our jumping-off point for creating data extraction templates. It 

is accessed by selecting Report Design  from the Report ribbon.  
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Figure 8-1. Launching the Report Design interface and Template Editor.   

Let’s take a minute to explore what you can find in the Report Design interface. 

The Report Design interface is divided into five distinct areas:  

The Report Design ribbon is located on the top-most portion of the interface and spans the 
entire width of the screen. This ribbon will allow you to perform many of the report design 

functions made available by Monarch.  

The Template Selector displays as a panel on the left-hand side of the interface. You can 
choose specific templates to view and modify from this selector, a functionality that is 
especially handy when you have defined multiple templates.  

The Template Editor is displayed in the middle of the interface. The Template Editor remains 

disabled until you select a new template to create.  

The right-hand side of the interface displays the general properties of a field in the Field 
Properties panel. Each field you define in a template has its own properties. You can set new 
properties or edit existing ones using this panel.  

Below the Template Editor is a Data Preview panel. This panel automatically generates a 
preview of what your table will look like, including all of its content, while you build templates 

to extract the desired data from your report.  

The figure below shows an example of what a Data Preview might contain: 
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Figure 8-2. The Data Preview tab provides users with a tabular sample of their extracted data 
In this example, data from the Detail template are shown.  

 

Figure 8-3. The Data Preview panel shows the data captured by the Order Number Level 
(append) template.  
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Figure 8-4. The DataPreview panel shows the data captured by the Page Header template.  

The following table summarizes the functions of each of the buttons in the Report Design 
ribbon.  

USE THIS BUTTON… TO… 

 Accept Accept the new template or changes to an existing 
template 

 Cancel 
Cancel the new template or changes to an existing 
template 

 Template Name 
Specify a new template name or modify an 
existing one 

 Template Role 
Display the role of the template selected 

 New Template 
Specify a new template  

 Delete Template 
Delete a template 

 Replace Sample Text 
Select a new line in the report with which to base 
a template  

 Clearing Template 
For footers and appends, remove “assumed” 

values copied up (for footers) or down (for 

appends) when only intermittent data are 
available. More information on this feature may be 
found here.  

 Auto-Define Trap 
Allow Monarch to automatically create traps for 
selected lines in the report 

 Auto-Define Fields 
Allow Monarch to automatically specify table fields 
based on selected lines in the report 

http://docs.datawatch.com/monarch/desktop/Clearing_Template.htm
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USE THIS BUTTON… TO… 

 Multi-Column Region 
Specify multi-column region settings 

 Run Report Verify 
Verify that the boundaries of fields are properly 
defined 

 Zoom Control 
Increase or decrease the size of the font displayed 

in the Template Editor 

 Report Colors 
Specify template colors 

 Help 
Launch the Help file 

Extracting Data Using Templates 
Imagine taking a piece of cardboard and cutting holes in it at certain locations. If you place 
this imaginary cardboard template on a printed report, you will see only the information that 
shows through the holes. Monarch uses electronic templates to extract information from your 
report files in a similar manner. If your report is sorted on several levels, you define a 
separate template for each sort level. 

The Classic.prn report has a simple structure, so extracting information from it is relatively 
easy. You can extract all the important information by creating a single detail template. 

 

Figure 8-5. The Classic.prn report.  

Classic.prn is a monthly shipment report for a distributor of classical music recordings. Like 
many reports, Classic.prn is organized with multiple sort levels. The entire report is sorted by 
customer. Within each customer, orders are sorted by ship date. Within each order, shipments 
are itemized on detail lines. In addition, three header lines appear at the top of each page. 

In this chapter, Monarch will draw data out of each level in the report based on templates that 
you define. You will start by defining a detail template. Then you’ll define an append 
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template to extract fields from each sort level and a page header template to extract fields 
from the page header. Fields from the append templates and the page header template will be 
appended to fields from the detail template to produce database records. 

We’ll use the sample line to identify all of the other detail lines throughout the report. To do 

this, we’ll use a process called trapping. By setting a trap, you tell Monarch which lines to 
capture and which to ignore. 

A detail trap identifies common features shared by all of the detail lines throughout the 
report, but not shared by other lines in the report, such as page header lines, lines containing 
labels, or lines from higher sort levels. A proper detail trap will capture only those lines we 
want while ignoring lines from headers and other sort levels. 

In the Classic.prn report, we need to look for features that differentiate the order information 

lines from the title, date, and page number lines at the top of each page. Specifically, we need 
to look for characters, such as letters, numbers, or punctuation, which always appear at the 

same position in the detail lines, but do not appear in any other lines. 

 

Figure 8-6. The Template Editor allows users to define templates with which to trap data.  

Selecting a new template to create or opting to edit an existing one activates the Template 
Editor. In the Template Editor, the Template Name and Template Role fields are automatically 
populated with the type of template we are going to create: Detail. The Template Selector on 

the left side of the image also displays the template name. We can change this name by 
simply changing the entry in the Template Name field.  

 

Figure 8-7. The Template Selector.  

Note also that most of the buttons that were previously deactivated in the Report Design view 
are activated in the Template Editor.  
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The line you select for trapping displays on a yellow background on the Editor. This line is 
called the Sample Text box. Above the Sample Text box is the Trap line, which we will use 
later to create our traps. The different trap types we can use are found in the Action bar. To 
the left of the Template Editor is the Line Selection area, which we will use extensively later 

on to select lines to trap.  

 

Figure 8-8. Specific areas of the Template Editor.  

Several types of traps are available: 

USE THIS TRAP… TO… 

 Alpha trap  
Trap any letter 

 Numeric trap 
Trap any number 

 Blank trap 
Trap blank spaces 

 Not blank trap 
Trap any character that is not a space 

 Numeric OR trap 
A special trap, used to trap numbers which may or 
may not appear in certain positions. A good 
example is an accounting report, where a number 
may appear in a credit or debit column, but not 
both. Using two numeric OR traps will trap a 
number in either position. 

 Character trap 
Trap special characters 

 NOT trap 
Trap any character EXCEPT the specified trap 
character 

Exact match trap Type any character or series of characters 

Floating trap Trap data from reports in which the data 
placement is not fixed 
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Aside from simply creating traps, the Action bar allows you to perform other functions: 

USE THIS BUTTON… TO… 

 Trap Type 
Specify the trap type to create: Standard Trap, 
Regular Expression Trap, or Floating Trap 

 Regular Expression Trap 
Options 

Select options to apply when creating regular 
expression traps: Ignore case, Explicit capture, or 
Ignore Pattern Whitespace 

 Trap Line 
Specify a different trap line on which to base a 
template if the sample text is composed of 
multiple lines 

 Reset Trap Line 
Discard all changes made to the Trap line and 
start again 

 Reset Fields 
Discard all fields specified and start again 

 Delete Field 
Delete a specific field 

 Edit Field 
Launch the Field Definition window 

 

To generate a table, Monarch produces one record for each detail line extracted from the 
report. The detail line contains the data that changes most often in the report and is usually 
the report’s lowest sort level. The append templates add, or append, information from higher 

sort levels. In this lesson, we will extract fields from four levels in the report; the detail level, 
two sort levels, and the page header. 

Creating the Detail Template 
The detail template extracts data from the lowest level in the report, which in this case are the 

lines representing individual shipments.  

To create the detail template, we’ll select a sample detail line and then use this line to identify 
other detail lines and highlight the fields to extract. 

Steps: 

1. In the Report ribbon, select the Report Design  button. 

The Report Design view displays.  
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Note that in this view, most of the buttons in the ribbon are deactivated. The buttons are 
activated when we create a new template or edit an existing one.  

 

Figure 8-9. Most of the buttons in the Report Design interface remain deactivated until you 
activate the Template Editor.  

2. Click in the line selection area to the left of the line containing Bartok, Sonata for Solo 
Violin.  

3. On the ribbon of this view, select the drop-down button for New Template and then 

select Detail.  

4. Type in “Line Item Detail” in the Template Name field and then press Enter on your 
keyboard.  

This step changes the template name. Changes are immediately reflected in the Template 
Selector.  

5. Ensure that the Trap Type is Standard Trap. 

TRAPPING THE DETAIL LINES 

Let’s create our detail trap. 

Steps: 

1. Click in the Trap line above the number 4. If the cursor is not positioned correctly, you 

can use the left  or right  arrow key to move it to the correct position. 

2. Click the Numeric Trap  button. “Ñ” appears in the Trap line, representing any 

number in the designated column position. 
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3. Click the Blank Trap  button twice. “ßß” appears adjacent to the first trap character, 

representing a blank in each column. 

4. Click the Non-blank Trap  button. “Ø” appears in the Trap line, representing any non-
blank character. 

By combining these trap characters (see Figure 8-10), we’re telling Monarch to “trap only 
those lines with a number, followed by two blank characters, followed by a non-blank 

character.” 

 

Figure 8-10. The completed trap definition.  

5. Scroll through the report to ensure that the trap captured all of the detail lines and no 
other lines. 

The report should appear as shown in Figure 8-11. 

 

Figure 8-11. Results of the detail trap.  

The results of our trap are indicated by the chevron character (») appearing in the line 

selection area to the left of each line that is selected by the trap.  

  



 

 

164    Monarch 14.2 Learning Guide 

 

 

NOTE 

If you made any mistakes when entering the trap characters, you 
can highlight the incorrect trap characters and press DELETE on 
your keyboard to remove them. To delete all trap characters, click 

Reset Trap Line . 

 

HIGHLIGHTING DETAIL FIELDS 

After you’re satisfied that the trap is working to capture all of the detail lines, but no other 

lines, you’re ready to highlight the fields that you want to extract. 

Although we can now manually highlight and name the fields we want to extract, let’s try 
using the Template Editor’s Auto-Define Fields feature, which allows us to automatically 
highlight fields in the template. It uses Monarch’s built-in parsing and data recognition 

capabilities to determine where fields begin and end.  

The Auto-Define Fields  button automatically highlights fields in your template. You can 
use this capability as a jump start when highlighting fields in your templates, and we will in 
fact use this in our lesson, but you should not rely upon this feature exclusively, as Monarch 

cannot predict which fields you might want to extract and which you want to leave out, nor 
can it deal with subtleties of report design that allow fields to wrap onto multiple lines or about 
one another.  

Let’s use the Auto-Define Fields  button to highlight the fields for our detail template. 

Steps: 

1. Click Auto-Define Fields  on the Report Design ribbon. 

Each field that is found in the detail template is highlighted. 

 

Figure 8-12. Results of the Auto-Define Fields command.  

2. Check the Data Preview panel to see what your table will look like with the information 
obtained by your template. 
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Figure 8-13. Results of the Auto Define Fields command.  

3. Click Accept  to accept the template definition.  

Congratulations! You have just created your first template. Figure 8-14 shows changes 
that occur in the Report view once a template is defined for a report. 

 

Figure 8-14. The completed detail template.  

VERIFYING FIELD BOUNDARIES 

Although you could scroll through the report to ensure that each field highlight is long enough 
to capture all of the data, this method becomes tedious when you are working with large 
reports. Therefore, a Field Verification feature is provided that reads the entire report and 
verifies that your fields are properly defined. 

When you activate the field verification feature, Monarch scans the entire report and examines 
the field boundaries. If any characters are found immediately adjacent to a field, Monarch will 

highlight the field to alert you that the field definition may be too short to accommodate a field 
value or that the field may be defined at the wrong location.  
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The Verify view displays when you select Run Report Verify  from the Template group 
of the Report Design view. The following table describes each of the buttons in this view. 

USE THIS BUTTON… TO… 

 Accept Accept the results of a verify operation 

 Cancel 
Cancel the verify operation 

 Adjust left 
Adjust the highlighting of the field one character to 
the left 

 Adjust right 
Adjust the highlighting of the field one character to 

the right 

 Adjust all fields 
automatically adjust all field definitions, thereby 

eliminating the need to go over an entire report to 
ensure that all required fields are captured 
properly.   

 Ignore all 
Ignore all field-highlighting issues of the type 
reported in the template and continue with the 
verify operation; subsequent verify operations will 
not highlight issues of the type previously ignored 

 Start 

Start the verify operation 

 Continue 
Continue the verify operation after correcting an 
issue 

 Start over 
Restart the verify operation  

 Stop 
Stop the verify operation  

 Reset Ignore Rules 
Reverse the Ignore all command; subsequent 
verify operations will highlight issues previously 
ignored 

 Help 
Launch the Help file 

 

 

NOTE 

If multiple reports are loaded, Verify automatically scans through 
all of them. When Verify is started it always starts at the first page 
of the current report, and will continue to report verify hits from 

that and other reports until it has cycled through all of the reports, 
thereby completing a full pass.  

Verification will start over from the top of the current report and 
re-scan for verify hits (but with any ignores still in effect). Upon 
reaching the end of a pass without ever having stopped, the dialog 

returns a message saying that verification has been completed. In 
this way the user can clearly see when they have succeeded in 
making a complete "clean" pass through the report(s).  
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Let’s verify that our field boundaries are correct. 

Steps: 

1. Return to Report Design and then click Run Report Verify . 

A status dialog displays the current status of the verify operation. When the verify 
operation is completed without errors, Verify completed displays in this dialog. This 
status indicates that all of our fields are properly defined. 

 

Figure 8-15. A completed Verify operation.  

2. Click OK to close the Verify dialog and Accept  to accept the Verify results. 

Creating Append Templates 
In the Classic.prn report, orders are sorted by order number. Also at this sort level is the ship 
date. We’ll create an append template to extract these two fields and an additional append 
template to extract the account number and contact fields that appear at the next higher 
level. 

The procedure for extracting fields from each sort level is the same as for extracting detail 
fields. First, we’ll select a sample, then we’ll trap the other occurrences of the sort level 
throughout the report, then we’ll highlight the fields we want to extract. 

Steps: 

1. In the same report, select Report Design  once more. 

2. Select the line containing the words ORDER NUMBER. This line is indented and appears 
below the line containing several field names and above the item details. 

3. On the ribbon of the Report Design, select the drop-down button for New Template and 
then select Append. Ensure that the Trap Type is set to Standard Trap. 

The Template Editor is activated and the line we selected is copied into the Sample Text 
box. Note also that the Template Name and Template Role fields are updated to reflect our 

selected template tape.  
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Figure 8-16. The selected ORDER NUMBER line.  

 

 

NOTE 

There can only be one detail template for any model you create. 
The total number of all append and footer templates cannot 
exceed 20. For each footer template used, there is one less 
append template available. For example, if you create three footer 
templates, then only 17 appends can be used. 

 

 

TRAPPING THE SHIP DATE LINES 

We’ll use an exact match trap to capture all lines representing the order number level. An 
exact match trap looks for an exact match of a character or series of characters.  

Steps: 

1. Continuing from the previous exercise, click in the Trap line above the colon following 
ORDER NUMBER in the sample line.  

2. Type a colon (:) in the Trap line directly above the first colon in the Sample Text box. 

3. Type another colon (:) directly above the second colon in the Sample Text box. 

4. Highlight the fields marked by 536017 and 04/10/10 in the Sample Text box as shown 
in Figure7-17. 
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NOTE 

Remember that your Date Format setting must be set to M/D/Y 
to properly capture date inputs in the sample reports we’ll be using 
for this guide. 

 

 

 

Figure 8-17. Highlighting the ORDER NUMBER and SHIP DATE fields.  

5. Scroll through the report to see the results. Note that on the fourth page of the report the 

“RETURN AUTHORIZATION” and “RECEIVED” fields have been highlighted (see Figure 8-
18). We don’t want to capture these fields, so we need to edit our template definition. 

 

Figure 8-18. Viewing the result of highlighting fields.  

6. In the Trap line, place the cursor directly above the “5” that begins the order number 

(536017) in the sample line, click the Numeric trap  button, and then check the 

highlighted fields once more. 
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The “RETURN AUTHORIZATION” and “RECEIVED” fields are no longer highlighted on Page 
4 of the report. 

 

Figure 8-19. Viewing the result of highlighting fields.  

7. Replace Append 1 with Order Number Level in the Template Name field of the Template 
Editor. 

The fields trapped by the append template we just created can be easily distinguished 

from those trapped by the detail template due to the different colors that Monarch assigns 
them.   

 

Figure 8-20. Viewing the result of highlighting fields.  

8. Select Accept  to accept your changes and close the Template Editor. You will be 
returned to Report view when you do so.  
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TRAPPING THE ACCOUNT NUMBER AND CONTACT LINES 

This time, we’ll trap the account number and contact lines in another append template.  

Steps: 

1. Ensure that you are on Page 1 of the Classic.prn report. 

Note that the “ACCOUNT NUMBER” and “CONTACT” fields are on different lines. To capture 
both fields, we’ll select a multiple line sample. 

2. Select Report Design  on the Report ribbon to switch to the Report Design view.  

3. Click down in the line selection area to the left of ACCOUNT NUMBER, and drag down 
two lines to highlight the CONTACT line. 

4. On the ribbon of the Report Design, select the drop-down button for New Template and 

then select Append. Ensure that the Trap Type is Standard Trap. 

The three lines we selected are displayed in the Sample Text box of the Template Editor. 

 

Figure 8-21.The Template Editor showing the sample lines.  

For a multiple line sample, you need to indicate which of the sample lines to trap. 

Generally, you will be able to trap on the first line by identifying features unique to that 
line. Occasionally, however, there will be no unique features that identify the first line. If it 
is not possible to trap on line 1, use the Trap Line box to indicate another line that has 
unique features.  

 

Figure 8-22. Highlighting the account number and contact fields.  

In this lesson, we’ll trap on the first line of the sample, so you won’t need to adjust this 
setting.  

Note that an “ACCOUNT NUMBER” label always precedes the account number field. Let’s 
use this specific sequence of characters as an exact match trap. 
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5. Type Account Number at the beginning of the trap line. By default, Monarch traps are 
not case-sensitive, so you need not enter the text exactly as it appears in your sample 
line. 

 

 

NOTE 

You can specify “case-sensitive” as the default case setting for 

traps by selecting Options  in the Home ribbon. In the Options 

interface that displays, select the Input tab, go to the Trapping 
subtab, and then check the Traps are case-sensitive box.  

 

 

6. Click Auto-Define Fields .  

 

Figure 8-23. Highlighting the account number and contact fields.  

Monarch highlights the fields in the report. You may need to scroll the report to see the 
results. 

7. Replace Append 1 with Account Number Level in the Name box, and then click the 

Accept  button to accept the template definition. 

Note that Monarch has assigned the same color to the fields trapped by the Account 
Number Level template as to those trapped by the Order Number Level template. This is 
because they are both append templates. 
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Figure 8-24. The results of your templating work display on Report view.  

Creating a Page Header Template 
Page headers often include useful information, such as the report date. In the Classic.prn 
report, the page header includes the report date and the page number. Let’s extract these two 

fields. 

Steps: 

1. Ensure that you are on Page 1 of the Classic.prn report 

2. Select Report Design  on the Report ribbon to switch to the Report Design view.  

3. Select the first line of the report as the sample text. 

4. On the ribbon of the Report Design interface, select the drop-down button for New 
Template and then select Page Header. Ensure that the Trap Type is Standard Trap. 

The Template Editor is activated and the line we selected displays on the Sample Text box.  

 

Figure 8-25. The sample line selected for the page header.  
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TRAPPING THE PAGE HEADER 

Most reports have a form feed character (ASCII 12, HEX 0C) embedded at the page break. 
Monarch can use this character to identify the beginning of a page header, so you normally do 
not need to set a trap to capture the page headers. However, if your reports do not include 
the form feed character, you will need to use a trap to capture the page headers. If you are 
unsure about your report’s internal structure, you should play it safe and create a trap. That’s 

what we’ll do for this lesson. 

Steps: 

1. Click the Numeric Trap button  twice and then type a forward slash (/) in the Trap 

line. This trap will capture the first line of each page header (where the date is 
represented in MM/DD/YY format). 

2. Highlight the report date and the page number, as shown in Figure 8-26. 

 

 

NOTE 

The Auto-Define Fields  button will not be able to capture the 
report date field due to the logic it uses to distinguish fields from 

labels, headings and other static text that appears in reports. Any 
text that does not change throughout the report is considered a 
label, even if that text looks like, and, as in this case, is, a field.  

 

 

 

Figure 8-26. Highlighting the page header fields.  

The page header fields in the report are highlighted. 

3. Click Accept  to accept the template definition. 
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Since you did not name the template, a default name is assigned for you. For detail and 
page header templates, the default names are Detail and Page Header, respectively. For 
append and footer templates, the default names are Append n, and Footer n, where n is 
incremented for each new append or footer template. 

Note in the report that Monarch has highlighted the fields trapped by the page header 
template with a unique color in order to distinguish them from those trapped by the detail 
and append templates.  

Creating an Exclusion Template 
Monarch offers a solution for instances where you may wish to exclude specific lines from 

being picked up by a previously defined template. To address this issue, you can create an 
exclusion template. For this exercise, open Classic.prn and Lesson8.dmod. 

Steps: 

1. In Report view, go to Page 4 of the Classic.prn report. 

Note that this page includes details for a return authorization as well as the received date. 

 

Figure 8-27. Page 4 of the Classic.prn report includes Return Authorization entries.  

If we were to trap the order numbers using an exact trap (e.g., a colon), the return 
authorization will also be picked up. When we trapped the order number line in a previous 
exercise, we used an exact trap and specified that all order numbers beginning with 5 
must be captured. But what happens when the order number begins with a 3 or a 4? Let’s 
use an exclusion template to address this issue. 

2. Click on the line containing the return authorization entry and then drag your mouse down 
so that all of the details under this entry are highlighted. Select Report Design. 

3. Select New Template > Exclusion. 



 

 

176    Monarch 14.2 Learning Guide 

 

4. On the trap line, click on the position right above the first letter of the word “Return” and 
then type in return.  

Note the change to the report shown below. 

 

Figure 8-28. Excluding Return Authorization entries with an exclusion trap.  

5. Select Accept.  

The template we have just defined instructs Monarch to not pick up data from the line 

marked with “return” at position 7 up to the last detail entry in the highlighted block. 

In Report view, the Return Authorization line is marked as follows: 

 

Figure 8-29. Report view showing markings of an exclusion template. 

You can now trap the Order Number line using semi-colons if you wish.  
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Setting Template Colors 
Monarch includes a function that allow users to clearly differentiate between the various types 
of templates that may be created (Detail, Append, Page Header, Group Footer) via template 
colors. Template colors allow you to easily determine what type of template is being used to 
extract information from a selection. Aside from being able to choose your own colors, 
Monarch also provides a pre-determined set of template colors. If you haven’t previously set 
your template colors yet, we’ll do so now. For this lesson, load Classic.prn and Lesson1.dmod. 

CHANGING DEFAULT COLORS 

You may change the template colors via the Edit Report Colors dialog box. 

Steps: 

1. Select Report Design  from the Report ribbon. 

 

Figure 8-30. The activated Template Editor.  
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2. Select Report Colors  on the Template Editor to launch the Edit Report Colors 
dialog. 

 

Figure 8-31. The Edit Report Colors dialog.  

Several color themes are available for use as template colors: 

 None shows no color backgrounds in the report after defining templates. 

 Gray background displays all templates defined in a report in a gray background. 

 Custom background for each template type assigns select colors for specific 
template types. This option is selected by default. 

Let’s try changing the color for Detail templates.  

3. Click directly on the Detail button to launch the color selector. Note that right now, the 

button is yellow. 

 

Figure 8-32. The Edit Report Colors dialog displaying the color selector.  

4. Select the first color on the first column, first row (#FF8080). 

5. Click anywhere on the Edit Report Colors dialog to accept your selection and close the 
color selector. 

You will notice that the Detail button is now bright salmon. 
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6. Select OK to close the dialog box. 

A quick look at the Template Editor shows that the color of the Detail template has been 
updated to a bright salmon color. 

 

Figure 8-33. The Detail template color is updated.  

RESETTING DEFAULT COLORS 

Before you proceed, we suggest that you change the Detail template color back to the original 
color. 

Steps: 

1. On the Template Editor, click Report Colors  once more. 

2. Select the Reset to default colors button.  

You will notice that the Detail button now shows the original yellow color. 

3. Select OK to close the dialog box. 
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Naming Fields 
Monarch allows you to name fields via three ways: You can name fields immediately after 
highlighting them in the Template Editor using the Field Properties panel, use the Table 
Design view, or use the Field Definition window. We’ll explore these options one by one. 

USING THE FIELD PROPERTIES PANEL 

Steps: 

1. In Report view, select Report Design  to view the report (along with the highlighted 
fields) in Report Design view. 

2. To see the original field names, ensure that at least one template is selected in the 
Template Selector (in this example, we selected to Line Item Detail template). 

 

Figure 8-34. Viewing the original field names using the Data Preview panel.  

Notice that each field in the Data Preview panel has been assigned a default field name, 
based on the order in which you created the fields. We’ll change these field names in a bit. 

3. Go back to the Template Editor. 

4. Click on the highlighted field labeled CD in the Sample Text box.  

All of the details associated with this Field display in the Field Properties panel. 
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Figure 8-35. Details of the Item Detail template are reflected in the Template Editor.  

5. In the Name field of the Field Properties panel, delete the current entry and enter Media 

in its stead. Click the  button that appears below the field to accept your changes.  

6. The Data Preview panel is automatically updated to show your changes. 

Note that the column previously marked “eg_CD” is now labeled “Media.”  

 

Figure 8-36. Field properties of the field eg_CD. 

7. Repeat Steps 3 to 5 to rename the rest of the fields in the detail template using the 
following guide: 

RENAME THIS FIELD… TO… 

eg_4  Quantity 

eg_Bartok, Sonata for Solo Viol Description 

eg_MK-42625 Label Number 

eg_8_99 Unit Price 

eg_35_96 Amount 

 

8. Once you’ve made all of your changes, click Accept  to save your changes and close 
the Template Editor. 
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USING THE TABLE DESIGN INTERFACE 

Let’s name the rest of the fields this time using the Table Design View.  

Steps: 

1. From the Report interface, select the Table tab to display the Table view and then click 

Autosize Columns . This function resizes the columns of the table so that the contents 

of each cell fit better.  

 

Figure 8-37. The table resulting from our templating activities is displayed when you select 

the Table tab.  

2. Select Table Design  from the Table ribbon to display the Table Design view. 

 

Figure 8-38. The Table Design interface displays names and properties for all fields.  
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The Table Design view presents a list of all of the fields you have trapped and will appear 
on your table, as well as their general properties.  

If you wish to view the template properties, simply check the box labeled Show 
Template Properties at the lower left-hand corner of the view. You’ll also see the now-

familiar Data Preview panel at the bottom left corner of the interface.  

While the Table Design view allows you to change field names and properties similar to the 
Field Definition window, it also allows you to perform external lookups, specify formula 
fields, define filters and sorts, and define address blocks, among others. We’ll discuss 
these functionalities one by one in later lessons. For now, we’ll focus on changing field 
names using the Table Design window. 

3. In the name field, locate the cell with the entry ACCOUNT NUMBER and change it to 

Account Number by clicking on the cell and typing over the original entry. 

4. Locate the cell with the entry CONTACT and rename it to Contact. 

5. Replace the name eg_536017 with Order Number. 

6. Replace the name 04/10/10 with Ship Date.  

7. Replace the field name eg_05/01/10 with Report Date. 

8. Replace the field name eg_Page 01 with Page Number.  

 

Figure 8-39. Renaming fields using the Table Design interface.  

9. Click Accept  to accept your field name definitions and close the Table Design view. 

10. The Table Design interfaces closes and you are returned to Table view. Click Autosize 

Columns  on the Table ribbon to view as many of the fields as you can.  
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Figure 8-40. The results of our renaming activities.  

USING THE FIELD DEFINITION WINDOW 

The Field Definition window is accessed by selecting Edit Field  from the Action bar of 

the Template Editor or selecting Input Fields in Table Design view. You can also access the 
window from Table view by double-clicking on any field. In this case, the properties of the field 

you double-clicked on display first.  

The Field Definition window displays. Let’s explore this window in detail. 

 

Figure 8-41. Field properties of the field eg_CD. 
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The ribbon of the Field Definition window features a Template Name drop-down list from 
which you can choose any template whose fields you wish to define. The template name you 
select from the drop-down box specifies which template fields are displayed in the Field 
Selector located on the left-hand panel of the window. If you wish to display all of the fields 

from all of the templates simultaneously, simply check the box for Show fields from all 
templates. 

You can select any of the fields from the Template Selector and define properties for them. 
The Field Definition view displays the characteristics of a single field in three tabs: General, 
Template, and Advanced.  

The General tab displays the properties of each individual field, such as its name, type, 
format, and display width. This tab shows exactly the same content in the Field Properties 

panel found in the Template Editor. The Template tab displays the properties of fields in 
terms of template characteristics, such as whether or not the field is properly verified and 
whether or not empty cells (fields) in a table should be filled with the corresponding value 

from the record immediately preceding it. Finally, the Advanced tab displays advanced field 
properties, which are useful when the field being defined spans several lines in a report.  

For more information on the Field Definition window, see the Monarch Help file.  

Using the Report Index 
Now that we’ve successfully extracted data from the Classic.prn report, let’s try using 
Monarch’s Report Index feature. In Report view, the Report Index displays a hierarchy of 
field values within one or more reports, thereby allowing you to quickly and easily explore a 

report and zero in on the information you are interested in. By exploring the tree, you can get 
a bird's eye view of your report data. When you find the information you are interested in, you 

simply click on the field value to jump to the corresponding page in the report. 

SETTING UP A REPORT INDEX 

Initially, the tree is empty. Let’s build the Report Index so that we can see firsthand how 

helpful it can be. 

Steps: 

1. Return to the first page of the Classic.prn report.  

2. Click the Report Index  drop-down button from the Report ribbon and then select 

Edit Report Index Fields.  
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The Edit Report Index Fields dialog displays. 

   

Figure 8-42. The Edit Report Index Fields dialog.  

In the Available Fields list are the fields we defined earlier. We can use up to five of these 
fields to build our tree. 

3. Select the Account Number field, and then click the Add >> button. The Account 

Number field is removed from the Available Fields list and added to the Selected Fields list. 

4. Select the Order Number field, and then click the Add >> button. The Order Number 
field is added to the Selected Fields list. 

5. Select the Description field, and then click the Add >> button to add it to the Selected 
Fields list. 

Note that the fields are listed in alphabetical order in the Selected Fields list (see Figure 8-
43). Their order in the actual Report Index hierarchy will be determined by their order in 
the report data, as we’ll see shortly. 
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Figure 8-43. Viewing the Selected Fields list.  

Now that we’ve configured the tree definition, let’s see how the Report Index displays in 
the Report view. 

6. Click the OK button to close the Edit Report Index Fields dialog.  

Monarch displays the Report Index on the right side of the Table (or Report) window by 

default. Initially, the tree is collapsed. You can move the panel by clicking on the panel 
header and then dragging it anywhere you wish on the window.  

 

Figure 8-44. Displaying the Report Index.  
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7. Expand the Classic.prn tree on the Report Index by clicking on the node ( ) to the left 
of the label Classic.prn.  

NAVIGATING WITHIN REPORT INDEX 

Monarch provides two modes of navigation within the Report Index, passive navigation and 
active navigation. Passive navigation involves expanding or collapsing branches to view 
underlying items without updating the Report view display. Active navigation involves 
highlighting a branch in the tree. Whenever a branch is highlighted, the Report view is 
automatically updated to display the corresponding page in the report.  

Typically, you will use a combination of passive and active navigation in Report Index, e.g., 
you would click on the arrow () to the left of a branch to expand it (passive navigation), 

and then, when you find an item of interest to you, you would click the item to display the 
corresponding page of the report (active navigation). 

Let’s perform both modes of navigation within Report Index. 

Passive Navigation 

First, let’s try passive navigation within Report Index. 

Steps: 

1. In the Report view, click the node ( ) next to the first account number (i.e., 11887) 
displayed in the tree, and then expand all the underlying branches by clicking their nodes 

( ). Note that the two order numbers for the account are nested beneath the account 
number. 

  

Figure 8-45. Using passive navigation in Report Index.  

Note that nothing in the Report view has been highlighted.  
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Active Navigation 

Now let’s give active navigation a try so that we can see how it differs from passive 
navigation. 

Steps: 

1. Scroll down to the bottom of the Report Index pane and click the node ( ) next to the 

last account number (i.e., 14162). Click on order number 536015. Click on the number 
itself, not the adjacent node ( ).  

Note that the report page (Page 19) containing the corresponding data displays in Report 
view and the data itself is highlighted. 

  

Figure 8-46.Using active navigation in Report Index.  

2. Expand the 536015 order number branch (either double-click it or click the node ( )) of 
the tree to reveal the individual line items, then select the second one (i.e., Liszt, Les 
Preludes). Note that the corresponding line in the Report view is highlighted.  

 

 

NOTE 

When exporting a report as a PDF file, the Report Index is used to 
create a list of PDF bookmarks for easy navigation.  
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Working with Model Files 
After you have created a data extraction template for a report, you can save it in a Monarch 
model file. A model file saves all of the templates and definitions that you have applied to a 
report during a Monarch session, as well as all sorts, filters, user-define functions, and the 
like. Models save work by allowing you to apply the same templates and definitions to a 
periodic report every time it is generated.  

Note that in the current version of Monarch, model files are saved using the .dmod extension. 
Monarch can read model files saved in previous versions of Monarch using the .xmod 

extension but it cannot save changes to this file type.  

SAVING MODEL FILES TO A LOCAL FOLDER 

Let’s save a model file to see how this works. 

Steps: 

1. Select File, click on the arrow of the Save  menu, and then select Model.  

Remember that in a previous lesson, we created an exclusion template. This template is a 
new feature made available only in Monarch 13.2. Models saved using this template may 
not function properly when opened in a previous Monarch version, such as Monarch 13.1. 
The same problem is encountered when saving models containing character list traps, 
which are not supported in earlier Monarch versions. The following compatibility warning 

displays to remind you of this limitation. 

 

Figure 8-47. The error message that displays when saving a model using a new Monarch 

feature.  

2. Check the box for Do not show this message again to prevent Monarch from displaying 
this error message in future sessions.  

3. Select Yes to continue saving the model. 
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If you provided credentials to allow saving of projects and models to a Datawatch Server 
library and/or Amazon S3 folder and selected Prompt as a default Save Project and Save 
Model behavior (these details can be specified in the Options Interface), the following 
dialog displays when you attempt to save the current model: 

 

Figure 8-48. The Datawatch Server library called when you save a model or project.  

4. Select Local Computer to save the current model and perform Steps 5–6 below as usual. 

If you did not provide any credentials, this dialog will not appear and you can proceed to 

Step 5.  

The Save Model dialog displays. 

 

Figure 8-49. The Save Model dialog box.  

5. Navigate to the folder you would like to save the model file to.  

6. Type ClassicLesson1 in the File name box then click Save . The .dmod extension will 
be added automatically to the file name. 

7. Select File once more and then click Close All  to close the Classic.prn report and 
model. 
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SAVING MODEL FILES TO A DATAWATCH SERVER LIBRARY 

Monarch now allows users to save and access models and projects from Datawatch Server via 
the Datawatch Server Library Browser. Note that this functionality is only available with 
Datawatch Server versions 12.5.1 and up.  

To save a model, for example, to the Datawatch Server Library, select File > Save As > 
Model. 

If you had previously configured a Datawatch Server Library in the Options interface and 
specified a prompt every time a model or project is to be saved, a dialog like that in Figure 8-
48 displays.  

Select Datawatch Server Library from this dialog to launch the Datawatch Server Library 

Browser.  

 

Figure 8-50. Saving a model to the Datawatch Server Library.  

Enter a filename for the model you are saving into the name field and then click Save as 
new. 

The model you have just saved is added to the Models list.  

If you wish to simply replace a model that is already on the Models list, select the name of this 

model and then click Replace. 
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Figure 8-51. Replacing a model in the Models list.  

SAVING MODEL FILES TO AMAZON S3 

Monarch also now allows users to save and access models and projects from Amazon S3.  

To save a model to an Amazon S3 folder, select File > Save As > Model. 

If you had previously configured a Datawatch Server Library in the Options interface and 

specified a prompt every time a model or project is to be saved, a dialog like that in Figure 8-
48 displays.  

Select the Amazon S3 button from this dialog to launch the Save as Web File dialog. 

 

Figure 8-52. Saving a model file to an Amazon S3 folder.  

Enter the S3 folder to which you want to save the model file in the text box provided and then 
select Connect. 
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LOADING SAVED MODEL FILES 

Now let’s load the same report with our new model file. 

Steps: 

1. Select File, click on the arrow of the Open  menu, and then select Report.  

2. Select Classic.prn from the dialog box that displays, and then click Open.  

The Classic.prn report displays in the Report view. 

3. Select File, click on the arrow of the Open  menu, and then select Model.  

4. From the dialog box that displays, select ClassicLesson1.dmod, and then click Open.  

The Report view is updated to reflect the effects of the template. 

 

Figure 8-53. Loading the Classic.prn report and ClassicLesson1.dmod model file.  

If you would like more information on Datawatch Server, simply click the following link: 

http://www.datawatch.com/products/datawatch-server/. 

Working with Project Files 
Project files save time by reducing the number of steps required to store a previous Monarch 
session. When you save a project file, references to the input file(s) and the model file as well 
as the active filter, sort order, summary, and view are saved. Project files are saved via the 
File > Save As > Project command.  

http://www.datawatch.com/products/datawatch-server/


 

 

Monarch 14.2 Learning Guide   195 

 

When you have saved your work to a project file and wish to continue your Monarch session at 
a later time, simply open the project file you saved by selecting File > Open > Project.  

PROJECT FILE LIMITATIONS 

Project files contain only references to a Monarch session’s data source and model file; it does 
not encapsulate the data source or model file into the project file. If you have deleted, moved 
or renamed the data source or model file referenced by the project, the project will be unable 
to restore the Monarch session. This is also true if you move the project file to a system that 
does not have access to the data source or model file, giving a project file limited portability 

beyond the system on which it was created. 

When a Monarch session using a database table is saved into a project and the column names 

of this table are changed (e.g., using an external application), an attempt to open the project 
launches the following prompt:  

 

Figure 8-54. Opening a project file with a modified table.  

Clicking Yes on this dialog launches an error message to describe the issues found: 

 

Figure 8-55. Errors observed when opening a project file using a table with a modified name. 

Clicking OK on this dialog takes you to the Edit Table Properties window, where you can select 

a new data source and/or modify other table properties.  
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Figure 8-56. The Edit Table Properties window. 

PROJECT FILES AND DATAWATCH AUTOMATOR 

Datawatch AutomatorTM (Automator) is a data conversion solution built for Monarch that uses 
existing ASCII or ANSI reports, PDF files, XPS files, ISAM files, Open XML spreadsheets, HTML 
files, and OLE DB/ODBC sources as sources of data. You can import report files into Automator 
and then export their data to a variety of formats or an OLE DB or ODBC destination. 
Automator also allows you to export files to a Microsoft Office SharePoint Server, FTP site, 

email destination, or distribution list. In short, Automator lets you extract, transform, move, 
and load data faster and more easily than previously possible.   

Automator offers far more than just an easy way to automate Monarch. It is an information 
delivery system, capable of distributing files over the network and to SharePoint locations. It 
can email users the files they need, or alert them that new files are available and where to get 
them, either over the network or via the Internet. RSS feeds can be created, integrating with 
newsreaders or corporate information portals. Thus, users are kept up-to-date on the latest 

information and can click to download or view the information via a browser. 

Automator makes use of project files to create processes. The project file referred to here is 
the same project file you create in Monarch when you save your work, including references all 
reports used, model(s), export(s), filter and sort definitions, and the like, to a file with the 
extension .dprj. 

Note also that only portable report files (PRFs) created from Datawatch Automator and 

Datawatch Server are supported in Monarch 13. 

For more information on Datawatch Automator, click on the link 
http://www.datawatch.com/products/datawatch-server/datawatch-automator/.  

http://www.datawatch.com/products/datawatch-server/datawatch-automator/
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[9] Special Data Extraction 
Techniques 

In Chapter 7, we created a table using a report with multiple sort levels, but we didn’t extract 

the customer information from the highest sort level. In this chapter, we’ll use Monarch’s 
address block feature to extract the customer names and addresses. We’ll also familiarize 
ourselves with Monarch’s floating trap and multi-column region trapping features. The lesson 

topics include: 

 Special problems with addresses 

 Extracting an address block 

 Using the address block feature 

 Using the floating trap type 

 Using the multi-column region trapping feature 

 

To get started, we’ll load the Classic.prn report and Lesson1.dmod model file. 

 

Figure 9-1. The Classic report with the Lesson1 model file. 
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The customer name and address, account number, and contact name are all at the same sort 
level in the report. Generally, we define one append template for each sort level. However, we 
will need to use a special technique to extract address fields, and that technique requires a 
separate template. 

Using the Address Block Feature 
SPECIAL PROBLEMS WITH ADDRESSES 

Most of the information in reports is contained in fields that are easily located for extraction. 
However, addresses present special problems. Some may contain three lines, while others 
have as many as six or seven. As well, fields containing state, province, and postal code 
information are not found at a fixed position on the lines they occupy. Monarch provides a 
specialized feature in Table view to solve these data extraction problems easily. 

To extract the address fields, Monarch provides the Address Block feature in Table view. The 

Address Block is capable of taking a block of text and extracting and categorizing the address 
information contained within it. 

EXTRACTING AN ADDRESS BLOCK 

The procedure for extracting the address fields is similar to extracting other fields. First, we’ll 
select a sample address block, then we’ll set a trap to capture all other address blocks 

throughout the report, and finally, we’ll highlight the address fields to extract. 

Let’s start by selecting a sample address block from the report. 

Steps: 

1. Select Report Design  on the Report ribbon.  

2. Click on the line selection area to the left of the line containing CUSTOMER and the first 
line of the address (i.e., Betty’s Music Store). 

3. On the ribbon of the Report Design view, select the drop-down button for New Template 
and then select Append.  
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The first line of the address block is copied into the Sample Text box of the Template 
Editor. 

 

Figure 9-2. First line of the address block in the Template Editor.  

4. Name this template Address Block. 

5. Type customer in the Trap line above CUSTOMER in the sample line. 

6. Highlight the field in the sample line, making sure you allow plenty of space for long 
address lines throughout the report. 

 

Figure 9-3. Trapping the first line for the address block. 

To capture the whole address block, regardless of the number of lines, we need to use the 
advanced field options available in Monarch.  

7. Select Edit Field  from the Template Editor’s Action bar. 

 

Figure 9-4. Field Properties window.  
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8. Choose the Advanced tab and then, under the End Field On heading, select the Blank 
Field Values radio button to terminate the field when a blank line or a series of blank 
lines is encountered. It is important to note that Monarch does not require the entire line 
to be blank, only the column positions occupied by the field.  

9. Enter the number of blank field values required to terminate the field, which in this case is 
1. 

10. Return to the General tab, change the field name to Customer Full, and then click the 

 button that appears beside the field. 

11. Change the field’s Type setting to Memo. 

12. Click Accept . 

The address fields in the report are highlighted. Scroll through enough of the report to 

satisfy yourself that all instances of the address have been captured. 

 

Figure 9-5. Viewing the trapped address block. 

Note that this has correctly captured all of the addresses, even though some have four 
lines and some have five. This is the advantage of using the Advanced Field properties. 

13. Click Accept  to accept the template and close the Editor. 

DEFINING ADDRESS BLOCKS 

When you open Table view, you will see that the field has been extracted and is displayed 
using standard memo field behavior. 

Now we can use the address block feature to extract the data from the block of text we have 
extracted. 

Steps: 

1. In Table view, select Table Design  from the Table ribbon to launch the Table Design 
interface and then select Add > Address Block to begin defining your address block.  

The Name and Postal Code Formats tab opens. 
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Figure 9-6. The Address Block Wizard. 

2. Enter Address1 in the Name field and then click the  button that appears beside the 
field. 

3. Select the Input Fields tab. 

4. In the Available Fields list, select Customer Full and then click the Add >> button to add 
the field to the Selected Fields list. This command specifies that our address block will be 

based on the Customer Full field.  

5. Click the Output Fields tab. 

6. Select the Address Line 1 check box. 

7. Replace the AddressBlockLine1 entry in the Output Field Name box with Customer.  

8. Select Address Lines 2 and 3, City, Region, Postal Code, and Country, and rename 

the fields as follows: 

 Address1 

 Address2 

 City 

 State 

 Zip 

 Country 

9. Click the Accept  button after all the fields have been named. The Validation Results 
dialog box displays. Select OK when you are satisfied with the results. If errors are 
detected, select Cancel to return to the Address Block Wizard and continue making 
changes.  
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10. Display Table view window and then scroll right to display the address fields. Select 

Autosize Columns  to display all of the fields properly. 

 

Figure 9-7. Extracted addresses in the Table view (column widths adjusted to show all 

seven address fields). 

Note that Monarch has extracted all the information contained in the original address block 
and categorized it correctly into the defined fields.  

The final step is to hide the original field we used to extract the address block information, 
Customer Full.  

11. Using your mouse, right-click anywhere on the Customer Full field. From the context 

menu that displays, select Hide.  

The table displays once more without the Customer Full field.  

 

 

NOTE 

To redisplay hidden fields, right-click on your mouse and then 
hover the cursor on the Show Hidden fields option that displays 
in the context menu. A list of hidden fields appears. Select the field 
to display from this list.  

 

 

12. Close the lesson and model files without saving any changes.  

We will cover hiding fields more thoroughly in the next lesson. As you can see from the 
table, the Address Block is a simple to use but powerful feature, capable of extracting 
information from addresses around the world.  
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Using the Auto-Define Feature in 
Report View 
Now that we know how Monarch allows you to manually create traps to extract data from a 

report, let’s turn our attention to the Auto-Define  feature in Report view. This new 

feature allows you to automatically define detail traps.  

Steps: 

1. Open the Employ.prn report. The report displays in Report view. 

 

Figure 9-8. The Employ.prn report. 

2. Click Auto-Define  on the Report view toolbar. The Template Editor displays with the 

trapping results. Note that the Trap line is automatically filled with trap characters. 
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Figure 9-9. The Template Editor window showing the results of an Auto-Define trapping 
operation.  

3. Scroll down to view the highlighted lines. Monarch analyzes the detail line we selected as 
our sample and selects all the other lines in the report that have the same format. 

Using the Auto-Define Trap Feature 
Now that we’ve seen how Monarch allows you to manually create traps to extract data from a 

report, let’s turn our attention to the Auto-Define Trap  feature. This new feature allows 

you to automatically define traps.  

One way we can explore just how effective this tool can be is to use it on the report we were 
just working with. Using the Employ.prn report, we can compare the auto-define trapping 
process with the manual trapping procedure we just performed. 

There are three important things to consider when using the auto-define trap feature:  

 When selecting your sample line (Step 3 below), it is important to select a line that best 
represents the bulk of the lines in the report, since Monarch will trap all the lines that 

feature formatting that matches your sample line. 

 After you have selected the Auto-Define Trap  button (Step 4 below), be sure to 
examine more than just one or two pages of the report. If you fail to do so, you may 
overlook lines of the report that you wanted to capture but Monarch failed to trap due to 

some anomaly in them. 

 Lines left unchecked (Step 6 below) in the Auto-Define Trap window will not be trapped by 
Monarch, so be sure to select the check boxes of all of the lines you want trapped.  
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Steps: 

1. Open the Employ.prn report. The report displays in Report view. 

 

Figure 9-10. The Employ.prn report. 

2. Select Report Design  to activate the Report Design interface.  

3. Click on the line selection area to the left of the detail line (e.g., the one containing 

Stephen McPherson) and then select New Template > Detail.  

 

Figure 9-11. Selecting the detail line. 
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4. Click Auto-Define Trap  on the toolbar. The Auto-Define Trap window displays. 

 

Figure 9-12. The Auto-Define Trap window.  

5. Scroll down to view the highlighted lines. Monarch analyzes the detail line we selected as 
our sample, and selects all the other lines in the report that have the same format. 

Note, however, that the auto-define trap feature has failed to select all of the detail lines.  

 

Figure 9-13. Viewing detail lines that haven’t been trapped.  

This is because, while the detail line we selected as our sample contained a street address 
that begins with a number (e.g., “410 Market Street”), a few of the street addresses in 
Employ.prn begin with a letter, as in “PO Box 1752”. When comparing the sample line with 
all the detail lines in the report, the auto-define trap feature opted not to trap any lines 
with such a discrepancy. 

Note that, on the first page of the report, there are two detail lines which weren’t trapped. 
We obviously want these detail lines to be trapped, however, as well as any that may exist 

on other pages of the report. Fortunately, the Auto-Define Trap window provides an easy 
way to ensure that they are selected. 
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5. Select the check boxes for the two detail lines whose street addresses are PO box 
numbers (see Rows 16 and 30). Note that the text color for these two detail lines changes 
from black to red. This is simply to notify us that the lines don’t perfectly match the 
sample detail line. 

  

Figure 9-14. Selecting the additional detail lines.  

6. Click the Apply Changes  button. This tells Monarch to additionally trap any lines that 

match the format of the newly selected ones. The additional detail lines we selected are 
now highlighted.  

 

Figure 9-15. Viewing the result of the recalculation.  

Although we could check the other pages of the report for detail lines which haven’t been 
trapped, let’s see if the detail lines we’ve selected are sufficient. 

7. Click the Accept  button to close the window, and then scroll down to make sure that 
all of the detail lines have been successfully trapped. 
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Figure 9-16. Scrolling the report to make sure all the detail lines have been trapped. 

Note that the Trap line is automatically filled with trap characters.  

Using the Floating Trap Type 
In addition to the address block feature, Monarch has another special data extraction feature 
called the Floating trap type. Let’s take a few moments to learn about this powerful feature.  

In many reports, particular fields of data, such as names and addresses, occur in consistent 

locations (i.e., they begin at the same horizontal position throughout the report). For example, 
in the following report, note how all of the first names begin at the same horizontal position, 
as do all of the last names, streets, cities, etc. 

 

Figure 9-17. A report showing consistent data placement, as is typical of many reports.  

Because of the consistent placement of data within the report, defining a trap to capture each 
occurrence of any one of these fields would be quite easy. With some reports, however, a 
standard trap won’t work because data placement within them is irregular rather than 
consistent.  
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In the following report, for example, note how the occurrences of the date/time field 
("[23/Aug/2008...") begin at different horizontal positions. 

 

Figure 9-18. A report showing inconsistent placement of the date/time data.  

In reports such as this, a standard trap will not work. Fortunately, Monarch includes a special 
trap called the floating trap, which can successfully extract data from many log files, reports 
and HTML files in which the data placement is not fixed. 

USING THE FLOATING TRAP TO CAPTURE LINES 

To familiarize ourselves with the floating trap, let’s open the above report and create a floating 
trap to capture the date/time fields it contains. 

Steps: 

1. Open the Weblog.prn report and select the first the first line. 

2. Select Report Design  to launch the Report Design interface.  

3. Click in the line selection area to highlight the first detail line in the report and then select 
New Template > Detail.  

 

Figure 9-19. Highlighting the first detail line in the report.  

4. From the Trap Type drop-down, select Floating Trap. 

5. In the Trap line, enter a left bracket directly above the left bracket in the Sample Text 
line, as in the following figure. 



 

 

210    Monarch 14.2 Learning Guide 

 

 

Figure 9-20. Entering a left bracket in the Trap box.  

6. In the Sample Text line, highlight the date/time field once more.  

7. Scroll down through the report once again. Notice that all of the date/time fields are now 
highlighted, indicating that they will be successfully captured. 

The floating trap works by looking across the lines to find the trap characters horizontally, 
rather than vertically, as in a standard trap. The trap then uses the characters to decide 
when fields can possibly start and finish. The field we have chosen to trap has a fixed 
width, but we will explore fields that have variable widths later on in the lesson. In this 

example, we have only defined that the field should begin after the bracket character, but 
we could define a close bracket to dictate where the field ends. 

 

Figure 9-21. Previewing the template again. Note that all of the date/time fields are now 

highlighted.  

8. In the Name field of the Field Properties panel, enter Date/Time to name the field and 

then click the  button that appears below the field. 

9. On the Template Editor, replace Detail in the Template Name field with Date/Time to 

name the template, and then click the Accept  button. Monarch closes the Template 

Editor and returns to Report view. 

10. Select the Table tab to view the Date/Time information in Table view. Note that all 916 
date/time fields within the report have been successfully extracted. 
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Figure 9-22. Viewing the Date/Time table (scrolled to the bottom).  

Now that we’ve seen how the floating trap can define lines where the trap character 
appears, let’s explore another one of its capabilities.  

USING THE FLOATING TRAP TO DEFINE FIELDS 

In addition to defining lines that contain the trap character, the floating trap can be used to 
define the width of variable length fields. If we return to our Weblog.prn report, we can see 

how this works. 

Steps: 

1. Select the Report tab and then click Report Design  to launch the Template Editor.  

We now want to extract the data from the first field, which has a variable width. In order 
to do this, we can use a trap character to tell Monarch where the field begins and ends. 
Since this field is left justified, we only need to be concerned with where the field ends.  

2. Position the cursor in the Trap line after .net, click the Blank Trap  button and then 
highlight the text in the sample line as in Figure 9-23.  

 

Figure 9-23. Floating Trap with the blank trap added.  

Note the results in the Report view portion of the window. 
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Figure 9-24. Floating trap with variable width fields.  

As you can see, the fields have been highlighted and the highlighting has shrunk to 
accommodate any field shorter than the fields we originally selected. There are some 
longer fields, however (e.g., “PPPa28-Resale_Vancouver"), in which the field is wider than 
the highlighting. This would result in an incomplete extraction of data. In order to rectify 
this, we need to manually specify the length of this field.  

3. Click the newly defined field eg_ezvl-30ppp187_epix_net in the Sample Text box and 
then select Edit Field to display its general properties in the Field Properties window.  

4. Click the Template tab. 

5. On the Template Width field in Field Properties, enter 60 and then click enter.  

6. Press Accept  (on the Ribbon) to accept the sizes then view the result. 

Note that all of the data is now trapped correctly. 

 

Figure 9-25. Viewing the finished floating trap.  
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7. Select the Accept  button to return to the Report view and then select File > Close 

All  to reset the Monarch session. Select No when prompted to save changes to the 
model. 

Using the Multi-Column Region 
Trapping Feature 
When working with Monarch, you may occasionally encounter a report that has a layout 
similar to that of a newspaper, i.e., one with multiple, adjacent columns of data on each page. 

For example, the following report contains a list of composers, numbered 1 through 90, and 
the list is broken into three columns, each containing thirty names. 

 

Figure 9-26. Viewing a report with multiple columns.  

To handle such reports, Monarch includes a Multi-column region (MCR) trapping feature 

which you can use to trap the data in multiple columns via only one template.  

Extracting data via the MCR trapping feature consists of three simple steps. First, you define 
the multi-column region via the Multi-Column Region Definition window, then you create a 
template to extract the desired data from the report, and finally you specify the vertical 
boundaries (i.e., beginning and ending points) for the columns. 

Let’s open a multi-column report and extract data from it via the MCR trapping feature. 
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Steps: 

1. Open the Composers.prn report. 

 

Figure 9-27. The Composers Multi Column report.  

This report contains the same list of composers we saw a moment ago. Composers.prn 
lists the names of ninety composers, arranged in three columns of thirty names, and 

ranked in order of popularity (1 = most popular, 90 = least popular) for each customer.  

Now that our multi-column report is open, let’s define the multi-column region.  

2. Select the first line of the report, select Report Design  from the Report ribbon, and 

then click Multi-Column Region  on the Report Design interface. 

The Multi-Column Region (MCR) Definition window displays.  

3. Select Enable MCR to activate the window. 
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Figure 9-28. The Multi-Column Region Definition window with a checked Multi-Column 

Region is active box.  

A series of red, vertical broken lines – or column indicators – appears over the report to 
indicate where the columns currently are. 

Now we need to examine the report to determine the number of columns we want the 

multi-column region to contain. This number should obviously equal the number of 
columns in the report which, in this case, is three.  

4. Enter 3 in the Number of Columns box.  

The number of columns you specified determines the number of column indicators that 

appear. Since we entered 3 in the Number of Columns box, three column indicators have 
appeared, as displayed in Figure 9-29.  
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Figure 9-29. Viewing the column indicators.  

Next, we need to specify a left margin for the leftmost column, i.e., specify the position 
where we want the leftmost column to begin. Since the text in the leftmost column begins 
at the left edge of the report, the current setting of 1 is the one we want, so we can leave 
it as is.  

 

 

NOTE 

If the text in the leftmost column began one space in from the left 
edge of the report, then we would enter 2 in the Left Position of 
First Column box. If the text began two spaces in from the edge of 

the report, we would enter 3 and so on. 

 

 

Now we need to adjust the width of the column indicators to match the width of the data 

columns in the report. 

5. In the Width of Each Column box, adjust the value until you obtain the correct width. For 

this report it is 29.  

The column indicators move to the left to reflect the change to the column width. Note 
that all three columns of composer names and ranking numbers now fall within the column 
indicators (scroll down to see this, if necessary).  
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Figure 9-30. Viewing the column indicators in the Report view.  

6. Click Accept  to accept the current MCR settings and close the window. 

The Report Design displays with the column indicators still displayed on the report.  

 

Figure 9-31. Viewing the column indicators in the Report view.  
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Now that we have determined the necessary number of columns, and have specified their 
width and the starting position of the leftmost column, we’re ready to define a template to 
extract the data. 

CREATING A TEMPLATE TO TRAP MULTI-COLUMN DATA 

The process of trapping data in a multi-column region report is the same as that for any other 
report. The first step is to select a template sample. 

Steps: 

1. Ensuring that you are in the Report Design interface, click on the line selection area to 

select the top line of composers names (i.e., the one beginning with PACHELBEL, J.), 
select the drop-down button for New Template, and then select Detail. Your screen 
should look as in Figure 9-32.  

 

Figure 9-32. Selecting the top line of composers.  

2. In the Trap line, place the cursor above the “P” of Pachelbel in the Sample Text line, then 

click the Non-Blank Trap  button. 

3. In the Trap Line, place the cursor above the “1” in the Sample Text line, then click the 

Numeric trap  button. 

 

Figure 9-33. Viewing the results of the non-blank and numeric traps. 
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4. In the Sample Text line, highlight the composer name and then highlight the number 1. 

 

 

NOTE 

When highlighting the composer’s name, extend the highlight well 
beyond the end of the name, as some of the composers names are 
longer than the one in the Sample Text line. Likewise, when 
highlighting the number “1”, be sure to begin the highlight at least 

one space before the number, as the numbers extend into the 
double digits. See Figure 9-34 for an example of how you should 
highlight the fields. 

 

 

 

Figure 9-34. Highlighting the fields. 

5. Select the number 1 in the Sample Text box to display its general properties in the Field 
Properties panel. 

6. Type Rank in the Name field and then click the  button that appears below the field. 

7. Select the text PACHELBEL, J in the Sample Text box to display its general properties in 
the Field Properties panel.  

8. Rename this field Composer and then click  to accept your field name definition.  

9. Click Accept  to save your template definitions.  
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Figure 9-35. Viewing the results of the Composers template in the Report view. 

Now let’s create an append template to extract the contact data from the report. This 
template will also help us specify our vertical boundaries for the MCR, which we will 
discuss in the next lesson.  

10. Select Report Design  to activate the Report Design interface.  

11. Click in the line selection area to highlight the first contact line (i.e., the line containing 
CUSTOMER: Betty’s Music Store), select the drop-down button for New Template, and 
then select Append.  

 

Figure 9-36. Selecting the template sample. 

12. To create the trap, type Customer in the Trap line above “CUSTOMER” in the sample line 
and then highlight Betty’s Music Store in the sample line. Be sure to extend the highlight 

well beyond the end of the last name, as in Figure 9-37. 
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Figure 9-37. Highlighting the Contact field. 

13. Rename the field eg_Betty’s Music Store to Contact in the Field Properties panel and 

then click the  button to accept your changes.  

14. Rename the template Contact and then click the Accept  button to accept your 
changes. You are returned to Report view and fields corresponding to the Contact 
template you have just defined are highlighted.  

If we wanted to, we could now create additional append templates to capture more 

information from the report, such as “CUSTOMER” and “ACCOUNT NUMBER” fields. 
Instead, let’s move on and learn how to specify vertical boundaries for the MCR.  

 

 

NOTE 

As an example of a model file that contains additional append 
templates, Monarch includes a Composers.xmod file in the 

Monarch Models folder. 

 

 

SPECIFYING VERTICAL BOUNDARIES FOR THE MCR 

So far, we have configured the column indicators to the correct width and have created a 
detail template that extracts the composer’s names and rank numbers from the report. We 

also created a Contact append template, which will be helpful to us when specifying vertical 
boundaries for the multi-column region.  

 

 

NOTE 

When we specify vertical boundaries for the MCR, we specify the 
top and bottom boundaries for the columns within it. 
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Steps: 

1. Select Report Design  to activate the Report Design interface.  

2. On the Report Design ribbon, select Multi-Column Region  to display the Multi-
Column Region Definition window.  

3. Select the Start after > Template radio button option and then ensure that Contact is 
selected from the Template drop-down list. 

A horizontal broken line appears at the top of the composer columns, just below the 
“CONTACT” line. This line indicates the top boundary of the multi-column region. 
Everything above this line will be excluded from the MCR.  

 

Figure 9-38. Viewing the top boundary of the MCR (just below the CONTACT line). 

4. Scroll down through the report to locate the bottom boundary of the multi-column region. 

Note that the current bottom boundary setting for the MCR is Stop at > Bottom of page. 
Notice that the bottom boundary of the MCR occurs just after the end of the columns on 
Page 1 and before the beginning of Page 2, as specified by the current bottom boundary 
setting. This boundary will suit our purposes as is, so we don’t need to adjust it.  



 

 

Monarch 14.2 Learning Guide   223 

 

 

Figure 9-39. Viewing the bottom boundary of the MCR. 

Now that you’ve seen how helpful templates can be when specifying the top and bottom 
boundary settings of the MCR, keep this in mind, as you can create blank traps solely for 
this purpose.  

5. Click Accept  twice, once to save the current MCR settings and then a second time 
save the current template settings. 

Monarch redisplays the Report view. 

Let’s view the trapped data in Table view. 

6. Select the Table tab to display the extracted data in Table view.  

7. Select Autosize Columns  to view all of the fields properly.  

Monarch displays the extracted data in the Table view.  
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Figure 9-40. Viewing the extracted data in the Table view (column widths adjusted to show 
column names).  

At this point, you can either save your work or close the report and model.  

Using the Regular Expression Trap Type 
Recall that in Chapter 7, we attempted to trap the Ship Date line but also picked up unwanted 
data as well, i.e., the Return Authorization and Received fields. We rectified this issue by 
creating an exact trap. We then showed how we can avoid this issue by using an exclusion 
trap. We could also have created a regular expression trap. Regular expression traps allow 
sophisticated Monarch users a high level flexibility when creating templates because this type 
of trap automatically considers variable spaces between fields of interest. Thus, this trap can 

be very useful when field positions change on a page or when field positions change with 
respect to other fields.  

All of the traps we have described thus far may be translated into a regular expression trap, 
and the first step of creating such a trap involves selecting a line with fields we want to trap. 
Similar to all of the previous traps/templates we created, a detail trap must be created before 
append, header, or footer traps. 

Let’s trap the Customer line of Classic.prn using a regular expression trap. 
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Steps: 

1. Open Classic.prn and Lesson1.dmod in Monarch. 

2. Select Report Design, choose the line containing the text CUSTOMER as the sample 
text, and then select New Template > Append.  

3. Rename this template as Customer. 

4. From the Trap Type Selector, select Regular Expression Trap. 

5. Select Ignore Case from the Options drop-down that displays on the Action toolbar when 
the regular expression trap type is selected.  

 

Figure 9-41. Creating a Regular Expression trap. 

6. In the trap line, type in the following: customer:\s*(?<customer>[A-Z].*) 

The trap we have just created instructs Monarch to look for a line marked “customer:” 

ignoring case and with any number of spaces following it and then select all of the text 
following this marker provided that the first character of the text to be captured begins 
with any character from A to Z.  

Note that Betty’s Music Store is highlighted as though we have selected it as a field.  

7. Right-click on Betty’s Music Store in the sample text line and select Create a field from 
this capture > customer. 
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The Customer field is created  

 

Figure 9-42. Data preview of the newly created Customer field. 

Note that regardless of the length of the customer name, the field is always captured 
correctly. 

 

Figure 9-43. The customer name “Die Melodie” is captured correctly even though we did 

not specify how large the field length should be. 
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Using the Exclusion Trap Feature 
Monarch offers a solution for instances where you may wish to exclude specific lines from 
being picked up by a previously defined template. To address this issue, you can create an 
exclusion template.  

Steps: 

1. Open the Classic.prn report and then go to page 4. 

Note that this page includes details for a return authorization as well as the received date. 

 

Figure 9-44. Page 4 of the Classic.prn report includes Return Authorization entries.  

If we were to trap the order numbers using an exact trap (e.g., a colon), the return 
authorization will also be picked up. When we trapped the order number line in a previous 
exercise, we used an exact trap and specified that all order numbers beginning with 5 

must be captured. But what happens when the order number begins with a 3 or a 4? Let’s 
use an exclusion template to address this issue. 

2. Click on the line containing the return authorization entry and then select Report Design. 

3. Select New Template > Exclusion. 

4. On the trap line, click on the position right above the first letter of the word “Return” and 
then type in return.  

Note the change to the report shown below. 
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Figure 9-45. Excluding Return Authorization entries with an exclusion trap.  

5. Select Accept.  

The template we have just defined instructs Monarch to not pick up data from lines 

marked with “return” at position 7. In Report view, the Return Authorization line is marked 
as follows: 

 

Figure 9-46. Report view showing markings of an exclusion template. 
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You can now trap the Order Number line using a semi-colon if you wish. 

Using the Start and End Region Trap 
Features 
A Start Region trap identifies a line in a report where all other types of trapping (e.g., detail 
traps, append traps) should begin. Correspondingly, an End Region trap identifies a line in a 

report where other types of trapping should end. These trap features may be used in 
combination to specify a section (or similar sections) of a report containing data that should be 
further trapped.  

Start/End Region traps generally make use of exact-match traps to specify at which line of a 
report trapping should begin/end. Only one Start and one End Region trap may be created in a 
model/project.  

 

 

NOTE 

Start and End Region traps are not generally used to specify 
sections that should not be trapped. In this case, exclusion traps 

should be used. 

 

 

In the following example, we’ll create start and end traps spanning the first 10 entries of a 

patient report and then extract the patient name and service code from these entries.   

Steps: 

1. Open the report file Patient.prn. 

2. In Report Design view, choose the line in the report beginning with “Michael Canton” as 
the sample text and then select Start Region from the New Template drop-down. 

3. Create the trap shown below.   

 

Figure 9-47. Establishing a Start Region trap. 
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Note that a chevron character marks the first instance of “Michael” in the report and that 
all other lines before this one are marked with an X. 

Because the entry “Michael Eagan” in page 2 of this report, we can’t simply use the trap 
“Michael.” Otherwise, data beginning from this line and continuing downward would also 

be captured.  

4. Click to the left of the line beginning with “St Louis MO” so that the line is selected and 
then choose End Region from the New Template drop-down. 

5. Create the trap shown below. 

 

Figure 9-48. Data preview of the newly created Customer field. 

Note that a chevron character appears to the left of the line marked “St Louis MO” and 
that all other lines after this one are marked with an X. 

6. Click on the first line of the report marked “Michael Canton” once more and then select 
Detail from the New Template Region. 

7. Create the trap shown below. 
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Figure 9-49. Trapping specific patient information. 

8. Highlight the fields Michael Canton and A0028. Extend these fields to ensure that all of 
the names are correctly captured. 

9. Click Accept to finish trapping and then select the Table tab.  

The trapped data display as follows. 

 

Figure 9-50. The results of the present trapping operation. 
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[10] Working in Table View 

Since you’ve learned how to create several templates for and extract data from a report in the 
previous lesson, let’s see how you can work between the Report and Table views.  

When Monarch extracts data from a report, the data is placed in a table, which you can view 
and manipulate in Table view. You can filter and sort the data, and export it to other 
applications. You can also use Table view together with Summary view to analyze the data 
and/or further refine it for export. This lesson will show you the basics of navigating and 
working in the Table view. Later lessons describe how to use Monarch’s built-in expressions to 

calculate new fields, create filters, and create sort definitions in the Table view. 

When analyzing data in Table view, you may want to refer to the actual report to verify 

whether or not the captured information is correct. You may also want to refer to the Table 
view, when in the Report view, to obtain a summary of the information relevant to a specific 
record. The ability to switch between Report view and Table view with ease will certainly 
benefit your working experience with Monarch.  

To start, open the Classic.prn report and the Lesson1.dmod model. 

Getting to Know Table View 
The previous lesson introduced you to Table view, which you can access by selecting the 

Table tab. Let’s take a minute to explore what you can find in the Table view interface. 

 

Figure 10-1. An open table in Table view.   
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The Table interface is divided into three distinct areas. The Table ribbon is located on the top-
most portion of the interface and spans the entire width of the screen. This ribbon will allow 
you to perform many of the table functions made available by Monarch. The Table Selector 
displays as a panel on the left-hand side of the interface, and the actual table is displayed on 

the right-hand portion of the interface. 

Right-clicking on the Table selector displays a context menu that will allow you to perform the 
following operations: 

 Perform a quick export - This export operation uses the default file extension and values 
specified in Export Settings and presents the Create Export dialog with all elements 
prefilled 

 Rebuild the table 

 Add an external lookup to a table 

 Print a table 

 Quick print a table 

 Preview a table before printing 

 View model information 

 View project information 

 View the model audit trail 

 View the project audit trail 

You are already familiar with the Table Design interface because we used this interface to 
rename fields in the previous lesson. We’ll discuss other features of the Table Design interface 

later in this lesson.  

The Active Filter and Active Sort fields shown in Figure 10-1 display No Filter and No Sort, 
respectively, because we have neither defined filters/sorts nor applied them to this table. 

When filters and/or sorts are available, the corresponding drop-down lists will allow us to 
further specify what information we want to see in the table. 

The following table summarizes the functions of each of the buttons in the Table ribbon.  

USE THIS BUTTON… TO… 

 Table Design  
Launch the Table Design interface 

 Font Style 
Select a font style 

 Font Size 
Select a font size 

 Zoom to Fit 
Set the zoom level to fit all fields on screen 

 Autosize Columns Resize columns in a table  

 Select All 
Select all of the records in the table 

 Copy 
Copy records in the table 

 Search 
Search for a specific record in the table 
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USE THIS BUTTON… TO… 

 Active Filter 
Select a filter to apply to the table 

 Active Sort 
Select a sort to apply to the table 

 Go to Row 
Locate a specific row or column in a table 

 Find in Report 
Find the line in the report from which the value in 
a table row was obtained  

 Rebuild Data View 
Recalculate the table. This can be useful if you use 

external lookups and wish to check for the most 
current data. 

 Show Field Contents 
Show the contents of memo fields 

 Freeze Panes 
Freeze specific columns and/or rows while scrolling 
through a table 

 Open Table in Data Prep Studio 
Open the table in Data Prep Studio 

 Datawatch Designer 
Launch Datawatch Designer and create a new data 
table populated with data from the current table. 
This option is disabled if you do not have a 

Datawatch Designer installation. 

 

Right-clicking on a column in the table reveals a menu that will allow you to quickly format the 
column. 

SELECT THIS MENU ITEM… TO… 

Copy Copy the contents of the column 

Search Search for a specific column entry 

Autosize Columns Automatically resize columns to fit the table best 

Column Widths Resize columns according to specific criteria: 

 Size columns to width of widest column 
label 

 Size all columns to width of widest data 
value 

 Size all columns to a width of <Field 

Name> 

Field Properties Launch the Edit Table Properties window 

Rename Field Modify the field name via the Edit Table Properties 
window 

Hide <Field Name> Remove the column from active view 

New Calculated Field Create a new calculated field  

Filter Filter the column 

Sort Sort the column 

Print Print the table 
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SELECT THIS MENU ITEM… TO… 

Print Preview Print preview the table 

Export Table Export the table to a number of formats 

Table Design Select other Table Design options  

 Input fields 

 Formula fields 

 Lookup fields 

 Runtime parameter fields 

 User-edited fields 

 Field list 

 Filters 

 Sorts 

 Address blocks 

 External lookups 

 Functions 

 

Getting to Know Table Design View 
The Table Design interface allows you to actively work with your data to obtain the information 
you need using the fields you extracted in a report. This interface initially shows you a list of 
all of the fields you extracted, as well as their properties, and a ribbon from which you can 

select several tools to further build your data table.   

 

Figure 10-2. The Table Design interface.  
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At the bottom of the Table Design interface is a Data Preview panel, which functions exactly 
like the Data Preview of the Template Editor. This panel will show you how your Table view is 
going to look once changes made using the Table Design interface have been applied.  

 

Figure 10-3. The Data Preview panel provides users with a real-time preview of changes made 

to any of the table fields.  

The following table summarizes the functions of each of the buttons in the Table Design 
ribbon.  

USE THIS BUTTON… TO… 

 Accept Accept the new template or changes to an existing 
template 

 Cancel 
Cancel the new template or changes to an existing 
template 

 Add 
Add a new field to the table. This table could be a 
formula field, a lookup field, a runtime field, etc. 

 Duplicate 
Duplicate the summary 

 Delete  
Delete a selected field 

 External Lookups  
Add an external lookup to the table 

 Field List 
Display the field list 

 Input Fields 
Display the properties of each input field 

 Database fields 
Display the properties of each database field 

 Formula Fields 
Add a formula field to the table 

 Lookup Fields 
Add a lookup field to the table 

 Runtime Parameter Fields 
Add a runtime parameter field to the table 

 User Edit Fields 
Add a user-edited field to the table 

 Filters 
Add a filter definition to the table 

 Sorts 
Add a sort definition to the table 

 Address Blocks Extract data from addresses 

 Functions 
Add a field function to the table 
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USE THIS BUTTON… TO… 

 Help 

Launch the Help file 

Navigating Through a Table 
FINDING INFORMATION IN A TABLE 

During the course of working with Monarch, you may need to locate information in the Table 
view. You can easily do this if the report is short enough using the scroll bars. Classic.prn, for 

example, spans only 149 rows, so you might opt to use the scroll bar to search for information 
in this report. However, what if the report spans 376 lines? How would you search these lines 
to locate a single record? Monarch presents an easy way to do this via the Search box, which 
may be accessed by clicking Search on the Table ribbon. 

The search options for Table view varies significantly from the search options for Report view 
in that the former includes a search option for expressions. 

 

Figure 10-4. The Search panel for Table view.  

Since we already know how to do basic keyword searches, let’s try searching through Table 
view using the Expression Builder. Before we do so, ensure that the first field of the first 
column is selected, signaling the beginning of the table.  

Steps: 

1. In Table view, select Search  from the ribbon. 

The Search box displays on top of the table. 

2. Check the box for Expression Search. 

3. Let’s search for all records with amounts of greater than or equal to 100. In the search 
box, type in Amount >=100 and then click Find Next.  

Record 49 in Table view is highlighted. If you scroll all the way to the right of this record, 

you will see that it has a total amount of 307.20. A quick look through all other amounts 
preceding Record 49 shows no other record with an amount greater than or equal to 100.  
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Figure 10-5. Record 49 is highlighted, signifying the first record for which the expression 
Amount >= 100 is true as a search parameter.  

4. Click Find Next once more.  

This time, Record 78 is highlighted, signifying the second record with an Amount value 
greater than or equal to 100. 

5. Close the Search box by selecting Search  on your keyboard once more.  

DISPLAYING THE SOURCE OF A RECORD 

To locate the source of Record 28, we’ll use the Find in Report  button.  

Steps: 

1. From the top of the table, scroll down until Row 28 is visible. 

Notice that Record (Row) 28 has a value of –59.90 entered in the Amount column. 

2. In the Table ribbon, select Find in Report .  

The Report view displays, showing the report for Record 28 in the table. The line from 
which the detail fields were extracted is highlighted (see Figure 10-6). 
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Figure 10-6. The details for Record 28 in the Table view are located in the Report view.  

 

 

NOTE 

Using the Find in Table  Button 

You can also locate the record number (table record) of any item 
within a report, along with pertinent information regarding the 

item (the amount of information you can obtain depends on the 
templates you’ve set up) from the Report view. To do so, click on 
the detail item of interest in the Report view and then select Find 

in Table  from the Report ribbon. Table view displays the 

record number, as well as other information, for the detail item. 
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CHANGING FONTS AND FONT SIZES 

As in Report view, Monarch allows you to change the font and font size used to display tables 
on screen.  

Steps: 

1. To change the font, in the Table ribbon, click the drop-down  button on the Font Style 
box.  

 

Figure 10-7. Changing font styles. 

2. Select the Trebuchet MS font from the list.  

The font style is changed throughout the entire report. 

 
You may also change font size in order to zoom in or zoom out on the table. Experiment with 
the font size until you find the size you like best. 

Steps: 

1. Click the drop-down  button on the Font Size box. 

 

Figure 10-8. Changing font sizes.  
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Font sizes vary depending on the font style selected. If the size you want isn’t available, 
use the font list to select another font. You can let Monarch select the font size for you 

using the Autosize Columns  command. This selects the font size that matches the 

table width to the display width, so you can view the entire width of the table, or as much 
of it as possible, on screen. 

2. To change the font size to match the table width to the display width, from the Table 

ribbon, select Autosize Columns . 

If the table is too wide to fit on screen even at the smallest available font size, Monarch 
will select the smallest font size to fit as much of the table width as possible in the 

available display area. 

Formatting Fields 
As we’ve seen, Monarch automatically formats the data as it builds the table. The column 
width is also set for each field in order to display the widest field value. You can override these 

automatic assignments, and you can make several other format adjustments, as discussed in 
the next few sections.  

You will learn how to: 

 Fill empty cells 

 Adjust field widths 

 Move fields 

 Hide fields 

For this lesson, ensure that Classic.prn and Lesson1.dmod are open in Monarch and that you 
are viewing the Table interface.  

FILLING EMPTY CELLS 

Sometimes the report data includes “assumed dittos.” An example would be the Media column 

sample shown in Figure 10-9. 

 

Figure 10-9. An assumed ditto in the Report view.  



 

 

242    Monarch 14.2 Learning Guide 

 

In this list, the media identifier “CD” obviously applies to the first three entries in the list, 
rather than just the first entry, even though it is only shown explicitly in the first entry. When 
these entries appear in the table (Records 1–3 in Table view), the “CD” is missing from the 
last two entries. 

Monarch has an easy solution to this. 

Steps: 

1. In Table view, double-click on the Media field to display its properties via the Field 
Definition window.  

2. Select the Template tab of the Field Definition window to display the template properties 
of the Media field. 

3. Check the box for Empty Cells: Copy from previous record and then click Accept  

to close the Field Definition window. 

The table is rebuilt and Monarch fills in the blank cells in the Media field. 

 

Figure 10-10. Blank cells are no longer present in the field.  

ADJUSTING FIELD WIDTHS 

When you view a table, the columns may sometimes not be wide enough to display the entire 
field name. When this happens, the field name will appear truncated. In other instances, even 
when the field values are not truncated, the columns may appear too close together. 
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Figure 10-11. The widths of the fields Order Number and Description are too narrow.  

In the figure above, for example, the field width for the Order Number column is so narrow 

that the field name is truncated and the field width for the Description field is so narrow that 
the individual records (rows) are truncated.  

You can resize field widths to properly display field names and records via four ways: 

 Using the Field Definitions window 

In the Field Definition window, select the field whose width you want to increase and then 
increase the number shown in the Display Width box in the General tab that displays. 

Select Accept  twice when you are done to apply your changes.  

 Using the mouse 

Move the mouse pointer to the right edge of the relevant field title. The mouse pointer will 
become a resizing handle, which you can drag left or right to resize the field. 

 Using the Autosize Columns  button  

The use of this button resizes all fields to match the widest field value or the field name, 
whichever is wider. 

If you reduce the width of a character field or a date field to less than the length of a field 
value, the field value is truncated on screen. If you reduce the width of a numeric field to 

less than the width of a field value, the field value is truncated as well.  

 Using the Column Widths functionality 

Right-clicking on a field produces a menu from which you can choose “Column Widths” and 
then three other options for resizing the width of a field. 

You can either: 

 Set the column size to the width of the widest column label, or 

 Set the column size to the width of the widest data value, or 

 Set the column size to the width of a specific field 
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NOTE 

The column width setting affects only the appearance of the data 
on screen and in printed output. It does not affect the underlying 
data. 

 

 

ORDERING FIELDS 

Table fields may be ordered any way you wish by dragging and dropping a field or several 
fields into a new location in the table or using the Move Up/Move Down buttons in Table 

Design view.  

HIDING FIELDS 

Frequently, you may want some data hidden from view but not deleted from the table.  

 

 

NOTE 

Hidden table fields are not available for export and copy 
operations.  

 

 

For example, the Report Date and Page fields contain useful information, but you may not 
want them visible while working with data from the other fields. Let’s hide these fields. To do 
so: 

Steps: 

1. In Table view, click anywhere on the Report date field. 

2. Using your mouse, right-click and then select Hide from the context menu that displays.  

The field is immediately hidden.  

3. Repeat Steps 1 and 2 to hide the Page field. The selected fields are now hidden (see 

Figure 10-12). 
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Figure 10-12. The Report Date and Page fields are now hidden.  

Assigning Field Types 
When Monarch builds a table, it automatically assigns a field type to each field based on the 

first instance of that field in the report. If Monarch finds a number when it first extracts a field, 
for example, it assigns the numeric format. Usually, the first instance of a field is 
representative of other instances, but when it is not, you must manually override the assigned 

format to assign the proper format. 

You can set fields to have one of the following formats: 

 Character 

 Numeric 

 Date/Time 

 Memo 

When Monarch assigns an incorrect field format, you can change the setting to a more 

appropriate one using either the Field Definition window or the Table Design interface. 

 Using the Field Definitions window 

Launch the Field Definitions window by clicking Edit Field  on the Template Editor or 

double-clicking on the relevant field in Table view. From the list of fields that displays, 
select the field whose format type you want to change and then select the appropriate 
field type from the Type drop-down field in the General tab.  
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 Using the Table Design interface 

On Table view, select Table Design . Select the field whose format type you wish to 

change from the list that displays and then click its corresponding cell under the column 
Type. A drop-down button displays to the right of the cell. Use this drop-down to select a 
new field type.  

At this point, you can either save your work or simply close the report and model you 
opened.  

Creating Headers and Footers 
CREATING A PAGE HEADER 

Monarch allows you to add a descriptive title to the top of each printed page via the Header 

Layout settings of the Page Setup dialog. 

A page header is divided into three sections, Left, Center, and Right, all of which represent 
locations in which you may want to add information. You can dynamically add information to 
the page header, including page numbers, the print date and time, the names of the active 
filter and sort, as well as the first value of any field in the table. You can also add any text you 
wish and even specify the font to use in the header.  

Before we begin, ensure that you have the Classic.prn report and Lesson1.dmod model 
open and that you are in Table view. 

Steps: 

1. Select File > Page Setup . 

Note that because you have both a report and a table open in the current Monarch 
session, the Page Setup dialog slightly differs from the dialog we saw in Chapter 6.  

 

Figure 10-13. Adding a page header to the printout.  
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2. On the left-hand side of the dialog, select Table from the list of available views. 

The Page Setup dialog displays page options available for Table view. 

 

Figure 10-14. Page preferences for Table view.  

3. Select the Header Layout tab. 

4. Double click on the first cell of the column labeled Left. 

A menu options arrow displays on the cell. 

 

Figure 10-15. Adding a page header to the printout.  

5. Click the arrow that appears and then select Date from the options that display.  

6. Double-click on the first row of the column labeled Center. 

7. Type Classical Music Distributors into the cell.  

8. Double-click on the first row of the column labeled Right. 

9. Click the arrow on the cell and then select Page Number from the options that display.  

10. Double-click on the second row of the column labeled Left. 
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11. Type Report: followed by a space, and then click the arrow on the cell. Select Input 
Name from the options that display. 

12. Double-click on the third and last row of the column labeled Left. 

13. Type Model: followed by a space, and then click the arrow on the cell. Select Model File 

Name from the options that display. 

This is how the Page Header section of your Page Setup dialog should look when you are 
finished.  

 

Figure 10-16. A fully set up page header.  

14. Click OK to accept your changes and close the Page Setup dialog. 

15. To view your new header, select File > Print  > Print Preview. 

 

Figure 10-17. A fully set up page header.  
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NOTE 

If your table is wider than it is long, you may wish to change your 
paper orientation to landscape. To do so, select the Paper 

Orientation  icon on the Print Preview window and then select 

Landscape.   

 

 

CREATING A PAGE FOOTER 

Creating a page footer is no different from creating a page header except that, this time, your 
definition appears at the foot of the page.  

Printing Table Data 
In this lesson, you will learn how to print and copy data from Table view.  

This chapter assumes you are familiar with importing and viewing report files, creating data 
extraction templates and working in the Table view. 

ADJUSTING PAGE SETUP OPTIONS 

Several page setup options are provided that you can use to establish margins, add a page 
header to each page, print column titles and row numbers, and print the grid lines that you 
see on-screen. 

To edit the page setup options, we’ll use the Page Setup dialog. 

Steps: 

1. Select File, and then click Page Setup . The Page Setup dialog displays. 

2. On the left-hand side of the dialog, select Table from the list of available views. 

The Page Setup dialog displays page options available for Table view. 
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Figure 10-18. The Page Setup dialog.  

The tab shows the current margin settings and print options for the table. 

3. Ensure that the Show Row Numbers box is unchecked to deactivate row numbers in our 
printout. 

PRINTING TABLE DATA 

The table is usually much wider than the report as Monarch combines fields from various 

levels in the report to create each row of the table. When Monarch prints data from the table, 
it prints as many fields as will fit across the page. If all of the fields will not fit on a single 
page, the remaining fields are wrapped to the next page. The amount of information that will 
fit on each page is determined by several factors: 

 The font size has a dramatic effect on the amount of data that fits on each page. To fit all 
the fields across the page, you may need to select a smaller font size. 

 The Paper orientation setting specifies the direction that text will print. For wide tables, set 

the paper orientation to Landscape to print the text sideways on the page. 

 Margins affect how close text is allowed to print to the edge of the page. You can use the 
margins to make small adjustments to the amount of text that will fit on each page. 

Monarch lets you print just the data you need. You can print the entire table or any selection 
from the table. Let’s select and print the first page of the report. 

Steps: 

1. Select File, and then click on the arrow of the Print  menu. Select Print from the 
options that display. 

  



 

 

Monarch 14.2 Learning Guide   251 

 

The Print dialog displays. 

 

Figure 10-19. The Print dialog.  

2. Select the printer you would like to use to print the first page of the report if it has not 
been selected yet. In the above screenshot, for example, the printer HP Laserjet 

Professional M1212nf MFP was selected.  

3. In the Page Range section, select the button for Pages, and then type the number 1 in 
the box beside it. 

4. Choose Print to print the page. 

The first page of the report is printed. 

Copying Data to Other Applications 
You can use the Windows clipboard to copy table data to other applications. When you copy 
data to the clipboard, Monarch creates both a text image and a worksheet image (with 
separate rows and columns). When you subsequently paste the data to another application, 
the application selects the format it needs. 

Let’s copy the records for Betty’s Music Store to your spreadsheet. 

Steps: 

1. Return to Table view.  

2. Select the first 9 records in the table by clicking down on the row selector to the left of 
Record 1, then dragging down to Record 9. 

3. Select Copy from the Table ribbon. 

4. Launch your spreadsheet. (If you don’t have a spreadsheet, just follow along in the 

tutorial.) 
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5. Position the cell pointer where you want the data to appear and use your spreadsheet’s 
Paste command to paste the data. For some spreadsheet applications, you may need to 
use the Paste Special command. 

6. Adjust the column fields as necessary to view all of the data. 

 

Figure 10-20. Pasting to a spreadsheet.  

7. Adjust column widths and cell formats in your spreadsheet as necessary. 

 

 

NOTE 

Monarch does not set the column widths automatically because 
this might alter an existing worksheet’s column widths when the 
data is pasted. If the spreadsheet that you are pasting into is 
empty, you may prefer to export the data using the Export 
command. When data is exported, the column widths are set 
appropriately for the data. 

 

 

8. Exit your spreadsheet without saving. 
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Redacting Fields 
The redaction feature provides a way to remove private or sensitive data from a report. A 
simple form of redaction involves overstriking the sensitive data with “X”s. More advanced 
forms involve replacing the sensitive data with “pseudo” data, i.e., values which are similar in 
form but have no relation to the actual data. For example, suppose a report contains Social 
Security numbers. It would be difficult to publish an analysis of this report without 
compromising the privacy of the SSNs involved. Monarch’s SSN redaction capability solves this 
problem by replacing the actual SSNs with “pseudo” SSNs – 9 digit numbers which look like 

Social Security numbers but are actually just patterns of digits. The cleansed data may then 
be analyzed and published without fear of compromise. 

REDACTING A SINGLE FIELD 

To define redaction for any report field, simply choose the desired type of redaction from the 

Redaction dropdown located on the Template tab of the report field editor, as shown below. 
Choose None if no redaction is desired. Newly created report fields always start with redaction 
set to None. 

 

Figure 10-21. Specifying a redaction format for a single field.  
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REDACTING AN ENTIRE MODEL 

It is possible to enable or disable the report field redactions across the entire model, via a 
checkbox on the Options > Input page as shown below. When this box is checked, each 
report field is redacted (or not) according to its specific redaction setting. When this box is not 
checked, then report field redactions are disabled, so each report field behaves as if its 
redaction was set to None. It should be noted that this setting affects only redactions 

specified for report fields – it has no effect on the behavior of any redaction functions used in 
calculated field expressions. 

The figure below, for example, shows the redaction properties for all models to be applied in 
the current Monarch session.  

 

Figure 10-22. Specifying redaction for an entire model.  
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[11] Working with Sorts 

In this chapter, you will learn how to sort data in the Table view. The lesson topics include: 

 Sorting the table 

 Creating a sort definition 

 Sorting on multiple fields 

 Duplicating a sort order definition 

 Restoring the original sort order 

This chapter assumes that you are familiar with importing and viewing report files, and 
working in the Table view. 

When you extract data from a report file, the information is arranged in the Table view in the 

order that it appears in the report but you may want to view, print, or export the data in 
another order. Sorting allows you to re-order the table to suit your needs. 

To sort the data in the Table view, you create a sort order definition, which specifies the 
parameters for sorting. The sort order definition includes the fields to sort on, the sort order 
for each field (ascending or descending), and the hierarchy for the sort. You can create 
multiple sort order definitions and switch between them to see different views of your data. 

To start the lesson, load Monarch and open the Classic.prn and Lesson2.dmod. 

Creating a Sort Order Definition 
The Classic report is sorted by Customer and Ship Date. When the report data is extracted and 
assembled as records in the Table view, the records appear in the same order. Records for 
Betty’s Music Store appear first, then records for Big Shanty Music, and so on. Within each 

customer, the records are sorted by ship dates. While this sort order is useful, you may want 
to view the data in another order. Let’s sort the table based on the Description field. 

To sort the table, you use the Sort Order Definition window to create a sort definition.  

Steps: 

1. Select Table Design  from the ribbon to launch the Table Design interface and then 

click Add > Sort  from the Table Design ribbon.  

The Sort Order Definition window displays.  
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Figure 11-1. The Sort Order Definition window.  

From this window, you can create multiple sort definitions and switch between them to see 
different views of the table. 

The Available Fields box displays the fields from the table. The Selected Fields box displays 
the fields used in the sort definition, from highest sort level to lowest. To add a field to the 
definition, select the field from the Fields box, then click Add >>. To remove a field, 

select the field from the Selected Fields box, then click << Remove. 

2. Type Product Description in the Name box then select . 

 

 

NOTE 

Sort definition names may be up to 31 characters in length and 
may contain uppercase and lowercase characters, spaces, and 
punctuation. However, periods (.), exclamation points (!), accent 
graves (`), and brackets ([ ]) may not appear in any part of the 
name. As well, names may not begin with spaces. If a name is 

entered with leading spaces, the name is accepted but the leading 
spaces are trimmed. 

 

 

3. Select the Description field from the Available Fields box, and then click the Add >> 
button. 

The Description field appears in the Selected Fields box. When a field is added to the 
Selected Fields box, its initial sort order is Ascending. To change the sort order of a field, 
right-click on the field to display a context menu and select Change Order from the 
menu. Since we want to sort the field values in ascending order, we’ll leave the sort order 
as it appears. 
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4. Choose Accept  to accept the sort definition and close the Sort Order Definition 
window. 

5. On the Table ribbon, select the drop-down button of the Active Sort box and then select 

Product Description. 

The data in the Table view is rearranged according to the Product Description sort order. 

 

Figure 11-2. Table view sorted by the Description field values.  

Sorting on Multiple Fields 
In the previous section, we sorted the table on a single field. Monarch also lets you sort on 
multiple fields. Let’s sort the table again, this time on two fields, Media (in ascending order) 
and Amount (in descending order). 

Steps: 

1. Launch the Sort Definition window once more by selecting Table Design  > Add > 
Sort.  

The Sort Order Definition window displays.  

2. Type Descending Sales by Media in the Name box then select . 

3. Select the Media field from the Available Fields box and choose Add >>. 

4. Select the Amount field from the Available Fields box and choose Add >>. 
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Let’s change the sort order of the Amount field to sort the values in descending order 
(largest values to smallest value). 

5. Right-click on the Amount field, then select Change Order from the context menu. 

If you don’t provide a name, Monarch will attempt to name the sort definition using the 

name of the first sort field you specified, in this case, Media. If this name is already in use 
by another sort definition, you will be prompted to enter a name. 

6. Choose Accept  to accept the sort definition and close the Sort Order Definition 
window. 

7. In Table view, click on the drop-down button of the Active Sort box and then select 
Descending Sales by Media. 

The data in the Table view is sorted, first by Media, then by Amount. The Amount field 

values for each media type are sorted in descending order. 

 

Figure 11-3. Table view sorted by ascending Media and descending Amount.  
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Restoring the Original Table Order 
You can turn off sorting and restore the original record order by simply selecting the No Sort 
option in the Active Sort drop-down.  

 

Figure 11-4. The original table order displays when the No Sort is applied to the table.  

Duplicating Sorts 
You may want to create a new sort that closely resembles a sort you previously defined. An 

easy way to do this is by using the Duplicate  button. To duplicate a sort, simply select 

the sort you want to duplicate from the Sort list and then select Duplicate  from the Table 

Design ribbon. The duplicated sort appears on the Sort list; this sort will have the name of the 
sort you duplicated and a number appended to it. Select this sort to display its properties in 
the Sort Definition window and make further revisions to it. Select Accept when you are 
finished to accept and save your new sort definition. 
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[12] Working with Filters 

In this chapter, you will learn how to use a filter to display a subset of the table data. The 
lesson topics include: 

 A discussion of what a filter is 

 Creating a filter expression 

 Testing a filter expression 

 Using functions 

 Restoring the original table data 

 Working with value-based filters 

This chapter assumes that you are familiar with opening reports, creating a data extraction 

template, and working in Monarch’s Table view. 

There are several types of filters you can create: 

 Value-based filters  

Value-based filters offer simple filters that are typically used to obtain records with only 
one or two specifications. In Classic.prn, for example, you could use a value-based filter to 
return details for records with descriptions of “Mozart” and “Chopin”. Creating a value 

based filter entails identification of a single field on which your filter will be based, and 

then specifying the exact value(s) of the filter.  

 Formula-based filters 

Formula-based filters, in their simplest form, function very much like value-based filters. 
However, formula-based filters offer increased filter-making versatility. Working with 
Classic.prn again, let’s say you want to filter a table for all CD sales amounting to $50.00 
and above. Using a value-based filter here is out of the question because only one field 

name can be specified with such filters. The filter you want to create specifies conditions 
for two fields, Media and Amount. Here, a formula-based filter would be more appropriate.  

 Compound filters Compound filters function as extensions of formula-based filters, and 
help you create longer filters with two or more component filters.   
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To start the lesson, load Monarch and open Classic.prn and Lesson3.dmod. 

  

Figure 12-1. Extracted data displayed in the Table view.  

The table in Figure 12-1 lists transactions for distributors of classical music recordings. 
Transactions are included for each customer and are broken down by media types, including 
CDs, LPs, DVDs, SACDs and Blu-ray discs. In all, there are 149 records in the table. 

By applying a filter, you can select only those records that interest you and filter out the rest. 
Let’s use a filter to view only the records for a particular customer, Big Shanty Music. 

Creating Value-Based Filters 
To filter table data, you create a filter expression via the Filter Definition window. In the 

following exercise, we will create a value-based filter such that only records for the customer 
“Big Shanty Music” are returned.  

Steps: 

1. From the ribbon of Table view, select Table Design  to launch the Table Design 

interface and then click Add > Filter > Value Based Filter.  
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The Value-Based Filter Definition window displays. 

 

Figure 12-2. The Value-Based Filter Definition window.  

Let’s take a moment to study the Value-Based Filter Definition window. The panel on the 
left-hand side of the window is a Filter Selector. This panel is particularly useful if you 

want to modify an existing filter, for example, and you have several filters defined. The 
Value-Based Filter Definition window contains two tabs that help you define your filter. A 
button on the lower left-hand side of the window, the Data Preview button, shows you 
what your table will look like if the filter you’ve just defined is applied to it.  

In the Field Values tab of the Filter Definition window, several options display, each of 
which can help you create your filter. 

Let’s say you are creating a filter where only records for Fandangos Records and Musique 

Royale are to display. You would then select Customer from the Field drop-down list and 
specify values for Fandangos Records and Musique Royale. In the Row Selection 
section, you can specify whether to display all records for either Fandangos Records or 
Musique Royale or display all records that are not by Fandangos Records or Musique 
Royale (i.e., all records except those from Fandangos Records and Musique Royale will 
display). You can also select whether or not records with blank customer names will 

display in your table after the filter is applied. 

The Value box displays the type of values you must enter for the selected field. For 
example, when you select the field Quantity, all the values to be entered into the box 
must be of the type Numeric. When you select the field type Description, all the values to 
be entered into the Value box must be of the type Character. If you enter a character 
string into the Value box for a numeric field, the filter will not be created.  

The Import values filtered by… drop-down list allows you to easily select field values 

for the Value box, including values you entered for previous filters. When you click on this 

box, a list of previously created filters displays, including the “No Filter” option. Clicking on 
any option on the list and then selecting the Add Rows button automatically adds all 
available values for the selected field name. Again, values to be entered must match the 
type of field you selected. When you select the No Filter option and then click Add Rows, 
all possible values for that field display in the Value box. You may delete values added to 

the box by clicking on the value and then selecting the Delete button.  
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In the Advanced tab, you can find options that allow you to either display all rows 
(records) that fit the filter description you specified or limit the display to a certain number 
of rows.  

2. In the Field Values tab, enter Big Shanty Music in the Filter Name box and then select 

.  

3. In the Field drop-list, select Customer.   

4. Click on the cell in the Value box and then enter Big Shanty Music.  

5. Click Accept  to save the details of the filter you specified and close the filter definition 
window.  

6. In Table view, select the drop-down button of the Active Filter field and then select Big 
Shanty Music.  

The table is rebuilt to show only those records from Big Shanty Music. 

 

Figure 12-3. The Table data with a filter applied to it. Only those records for Big Shanty 

Music display. 

You have successfully created a value-based filter.  

Creating Formula-Based Filters 
To display only transactions amounting to US$ 100.00 and above, we’ll use the following 
expression: 

Amount>=100 

To build the expression above, which is a formula-based one, you could type the expression as 
it appears above, or you could build it by inserting components from the list boxes. 

Steps: 

1. From the Table Design ribbon, select Add > Filter > Formula-Based Filter.  

2. In the Filter Name box, enter Sales >=100 and then select . 
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NOTE 

Filter definition names may be up to 31 characters in length and 
may contain uppercase and lowercase characters, spaces, and 
punctuation marks. However, periods (.), exclamation points (!), 
accent graves (`), and brackets ([ ]) may not appear in any part 
of the name. As well, names may not begin with spaces. If a name 
is entered with leading spaces, the name is accepted but the 

leading spaces are trimmed. 

 

 

3. Double-click Amount from the Fields list  

“Amount” displays on the Expression box.  

4. Double-click the greater than or equal to (>=) sign from the Operators list. 

The greater than or equal to sign is added to the expression. 

5. Click on the Expression box right after the operator “>=” and then type in 100. 

Now we can use the Data Preview to test our expression before saving it. 

6. Check the Data Preview panel. 

All of the records that display should have amounts greater than or equal to 100. Note, 

however, that the Data Preview only shows the first 100 records extracted from a report, 
or first 100 rows imported from a database, so depending on the data, you may not see 
rows affected by the filter in the Data Preview. 

7. Click Apply  to apply your changes. 

8. Select Accept  to save your new filter and close the Table Design interface. 

9. In Table view, select the drop-down button of the Active Filter box and then choose the 

filter Sales >=100. 

The table displays only those transactions amounting to US$ 100.00 or greater (see Figure 
12-4). 

 

Figure 12-4. The Table view showing all transactions amounting to or over $100.00.  

 



 

 

Monarch 14.2 Learning Guide   265 

 

Creating Compound Filters 
Compound filters allow you to create longer, more-complicated filters composed of previously 
created ones. Let’s create a compound filter using the value- and formula-based ones we 
specified earlier.  

If you wanted to create a filter that will return all records from Big Shanty Music AND all 
records with transaction amounts greater than or equal to US$ 100.00, you could create a 
formula-based filter such as the following: 

Customer=”Big Shanty Music”.AND.Amount>=100 

If you wanted to create a filter that will return all records from Big Shanty Music OR all records 

with transaction amounts greater than or equal to US$ 100.00, you would create the following 

formula-based filter: 

Customer=”Big Shanty Music”.OR.Amount>=100 

While you can create either of the filters this way, selecting fields, operators, and values, as 
well as determining the correct way to link individual filter expressions may be a tedious task. 
Here, Monarch allows you to create compound filters whose components you can simply select 
from a list.  

The following steps will show you how to create a compound filter that will return all records 

that are either by Big Shanty Music or have amounts greater than or equal to US$ 100.00. 

Steps: 

1. From the Table Design ribbon, select Add > Filter > Compound Filter.  

2. In the Filter Name field, enter Big Shanty Music and Sales>=100 then select . 

3. Select Big Shanty Music from the Available filters box by clicking on it and then move it 
to the Component filters box by clicking Add>>. 

4. Repeat Step 3 to move the filter Sales>=100 to the Component filters box. 

5. In the Select rows that satisfy section, select the radio button for any one of the 
component filters.  

This instructs Monarch to display records that have either Big Shanty Music as the 
customer or transaction amounts greater than or equal to US$ 100.00.  

If you select all of the component filters, only those records that are by Big Shanty 
Music and have sales amounts greater than or equal to US$ 100.00 will display in the 

Table view. Of course, in this case, no records will display because none of Big Shanty 
Music’s sales amounted to over US$100.00. 

Note that the component filters, as well as the type of link (AND/OR), display in the 
Component filter expression box.  

6. Select Accept  to accept your new filter definition.  

7. From the Active Filter drop-down, select the filter Big Shanty Music and Sales>=100. 
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The table is rebuilt and your filter is applied.  

 

Figure 12-5. The resulting compound filter.  

Using Functions in Filters 
Monarch provides a host of functions you can use in your filter expressions. For example, to 
display only shipments of symphony recordings, you can use the expression: 

Instr("Symphony",[Description]) 

The Instr() function searches a field for the occurrence of a string. In the above example, the 
expression returns only those records where the word “Symphony” appears anywhere in the 
Description field. The brackets surrounding the Description field name are required, as this 

field name is longer than 10 characters. 

 

Figure 12-6. Using a filter to display Symphony recordings.  

Monarch supports over 70 functions. The Monarch Help file contains detailed information 
about each function, including examples of their use in filter expressions. Monarch also 
includes user-defined functions, where you can create your own functions to provide an easy 
way to store and use complex expressions that you develop. These can even be shared easily, 

if you and your co-workers use Monarch.  
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Restoring the Original Table Order 
You can turn off filtering and re-display all of the table data by selecting the No Filter option in 
the Filters menu. 

Steps: 

1. Select the Active Filter drop-down button and then select No Filter to disable all filters. 

Table view displays all of the original data. 

At this point, you can opt to either save your work or simply close the report and model 
files you opened for this lesson.  

Duplicating Filters 
You may want to create a new filter that closely resembles a filter you previously defined. An 

easy way to do this is by using the Duplicate  button. To duplicate a filter, simply select 

the filter you want to duplicate from the Filter list and then select Duplicate  from the 
Table Design ribbon. The duplicated filter appears on the Filter list; this filter will have the 
name of the filter you duplicated and a number appended to it. Select this filter to display its 
properties in the Filter Definition window and make further revisions to it. Select Accept when 
you are finished to accept and save your new filter definition. 
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[13] Working with Calculated 
Fields 

In this chapter, you will learn how to calculate new fields from the data in the Table view. The 

lesson topics include: 

 A discussion of what a calculated field is 

 Creating a calculated field 

 Making comparisons 

 Hiding and deleting calculated fields 

This chapter assumes that you are familiar with opening reports, creating a data extraction 

template, and working in the Monarch’s Table view. 

 

A calculated field is a field whose value is derived from other fields in the same record. 
Calculated fields can be used to perform a variety of tasks, including arithmetical 
computations, concatenating character fields, and extracting information from a field. You can 
create and save multiple calculated fields. Once a calculated field is created, you can use it in 

filter, sort and summary definitions and copy, print and export it along with other fields. 

You can create several types of calculated fields in Monarch via the Table Design interface. 
These fields include: 

 Formula-based  

To create a formula-based calculated field, you create a calculated field expression. A 
calculated field expression is a formula that returns a value to a calculated field. 

 Runtime Parameter  

Runtime parameter calculated fields are very much like formula-based ones. The major 

difference between them is that runtime parameter calculated fields do not contain a 
formula, just a simple string, number or date value. The user is prompted to supply values 
for each runtime parameter when the model is loaded. 

 Lookup  

A lookup calculated field provides a convenient "table lookup" where the value of a 
designated input field is checked against a lookup table. They can be useful in avoiding the 

long and complicated IF statements that can occur in formula-based calculated fields. 

 User-edited  

A user-edited calculated field is special in that it allows the user to enter text to annotate 
rows in the table or enter corrections for bad data. 
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To start the lesson, we’ll load Monarch and open Classic.prn and Lesson4.dmod. 

 

Figure 13-1. Extracted data displayed in the Table view.  

The table in Figure 13-1 lists transactions for distributors of classical music recordings. We’ve 
extracted the detail information for each transaction along with the customer name and 
address.  

By creating calculated fields, we can derive new information from the table data. For example, 
we can create a new field that calculates a 20% discount for all transactions. Let’s give this a 
try.  

Creating a Formula Field 
Steps: 

1. Select Table Design  to activate the Table Design interface and then click Add > 

Formula Field  from the Table Design ribbon.  

The Formula Fields Definition window displays.  
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Figure 13-2. The Formula Field Definition window.  

2. In the General tab of the window, enter Discount in the Name box and then select . 
This name will display as the field name when the results of our calculation definition are 
shown in Table view.  

 

 

NOTE 

Field names may be up to 62 characters in length and may contain 

uppercase and lowercase characters, spaces, and punctuation 
marks. However, periods (.), exclamation points (!), accent graves 
(`), and brackets ([ ]) may not appear in any part of the name. As 

well, names may not begin with spaces or underscores (_). If a 
name is entered with leading spaces, the name is accepted but the 
leading spaces are trimmed.  

 

 

Since this expression will result in a numeric value, we need to set the appropriate 
formatting for the field. 

3. From the Type drop-down list, select Numeric. 

4. Enter 2 in the Decimals box. 

5. Select the Formula tab. 

To define a calculated field, you build a calculated field expression that returns a value to 

the field. The calculated field expression appears in the Expression box near the bottom of 
the Formula tab. Several list boxes display the field names from the table, arithmetic and 
logical operators, and functions that you can use in your calculated field expressions. 

To calculate a 20% discount for all transactions, we’ll use the expression, 

Amount*0.2 
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To build this expression, you could type the expression as it appears above, or you could 
build it by inserting components from the list boxes. Let’s start by inserting the Amount 
field. 

6. Double-click on the Amount field in the Fields box. 

The Amount field is inserted in the Expression box. Double-clicking an item inserts it 
automatically. 

7. From the Operators list, double-click the multiplication sign (*) so that it is added to 
the Expression box. 

8. Click on the space beside the * in the Expression box, type 0.2, and then click Apply . 

The calculated field expression is now complete. 

If we wanted to, we could test the calculated field by using the Data Preview tab, as we 
did previously in the Filters lesson. In this case, the preview would show a new field 
containing values obtained from the expression we defined. 

9. Choose Accept  to accept the calculated field definition and close the window. 

A new field name, labeled Discount, is added to the end (far right) of the table. Scroll right 
until the Discount field is visible. 

 

Figure 13-3. Table view with Discount calculated field.  
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Creating a User-Edited Field 
CREATING USER-EDITED FIELDS 

Let’s create a user-edited field and see what it can do to a table. Note that user-defined fields 
are only saved in project files, not model files.  

Steps: 

1. Select Table Design  to activate the Table Design interface and then click Add > User 

Edited Field from the Table Design ribbon.  

The User-Edited Field Definition window displays. 

 

Figure 13-4. The User-Edited Field Definition window.  

2. In the General tab, enter the name Comments and then click . 

3. Change the display width to 40 and then click Accept  to save your field.  

Table view displays the new field to the far right of the table. 
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Figure 13-5. The user-edited field displays in Table view.  

USING USER-EDITED FIELDS 

Steps: 

1. Double-click on the first cell of the Comments field (Row 1).  

Note that the interface changes and the cell you selected becomes editable. 

 

Figure 13-6. Activating the user-defined field.  
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2. In the cell, type in “New delivery 11/2013” and then click Apply. 

The table is refreshed and the text you added displays.  

 

Figure 13-7. The results of modifying a user-define field.  

Making Comparisons 
In the previous section we created a calculated field using a simple arithmetical expression. 

Monarch lets you create more complex expressions involving comparisons. Let’s use this 
feature to calculate a discount only for sales amounts of 75 or more. Rather than create a new 
calculated field, we’ll edit the existing field to apply our new discount strategy. 

Steps: 

1. Select Table Design  and then click Formula Fields on the ribbon that displays to 

launch the Formula Field window once more.  

2. Select Discount from the Formula Field Selector and then click on the Formula tab to 
display its properties. 

To apply the discount only for sales amounts of 75 or more, we’ll use the IF() function in 
our calculated field expression: 

If(Amount>=75,Amount*0.2,0) 

In plain English, this expression reads, “If the Amount field contains a value of 75 or 

greater, use the first expression (Amount*0.2) to calculate a discount, otherwise, use the 
second expression (0) to show no discount.” 

3. Enter the calculated field expression above so that it reads as shown below and then click 

Apply .  
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Figure 13-8. The modified Discount calculated field definition.  

4. Choose Accept  to accept the new calculated field definition and close the window. 

The field is re-calculated to show a discount only for transactions with an amount of 75 or 
more. 

 

Figure 13-9. Updated Discount field.  

Now let’s use another Monarch feature to suppress the zero values so that our discount 
values will appear more prominent. 

5. Select the Home tab, and then click Options .  

The Options window displays. 

This window includes several options that control the way data appears in Monarch.  

6. Select View to display the View options.  
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Figure 13-10. The View Options window.  

7. Check the Suppress zero values box. 

8. Choose Accept  to close the window and apply its settings to the table data. 

The table displays with zero values suppressed. 

 

Figure 13-11. Zero values suppressed.  

At this point, you can opt to either save your work or simply close the report and model 

files you opened for this lesson.  
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Redaction Functions 
Monarch supports a set of redaction functions for use in calculated field expressions. These 
functions appear in the Redaction section in the Functions list box of the formula editor, as 
shown below. See the Help file for more information on these functions.  

 

Figure 13-12. Several redaction functions are available in the formula editor.  

Regex Functions 
Besides redaction functions, Monarch also supports a number of Regex functions. These 

functions appear in the Regex section in the Functions list box of the formula editor, as shown 
below. See the Help file for more information on these functions. 

 

Figure 13-13. Regex functions available in the formula editor. 
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Hiding and Deleting Calculated Fields 
You can temporarily turn off the display of a calculated field by hiding it. Monarch will still re-
calculate the hidden field while you make other changes to the table. However, if your 
calculated field expression is computationally intensive, this can slow down the display of the 
table. 

Of course, you can get rid of a calculated field altogether by deleting it altogether. When you 
delete a calculated field, the field is removed from the table and the calculated field definition 
is deleted. 

To delete a calculated field, launch the Formula Field Definition window, and then select the 
name of the calculated field you wish to delete. Select Delete from the ribbon. Be careful to 

select the correct field name – Monarch has no undo facility for deleted objects. 

Duplicating Calculated Fields 
You may want to create a new calculated field that closely resembles a calculated field you 

previously defined. An easy way to do this is by using the Duplicate  button. To duplicate 
a calculated field, simply select the calculated field you want to duplicate from the Calculated 

Field list and then select Duplicate  from the Table Design ribbon. The duplicated 
calculated field appears on the Calculated Field list; this calculated field will have the name of 

the field you duplicated and a number appended to it. Select this calculated field to display its 
properties in the Calculated Field Definition window and make further revisions to it. Select 

Accept when you are finished to accept and save your new calculated field definition. 

 



 

 

Monarch 14.2 Learning Guide   279 

 

[14] Working with Multiple 
Instances of a Report 

In the previous chapters, we’ve worked with only one report at a time. In this chapter, you will 

learn how to open and analyze data from multiple reports. The lesson topics include: 

 Analyzing data from a series of reports 

 Opening multiple instances of a report 

 Extracting data 

 Working in the Table view 

 Creating a summary to analyze data from multiple reports 

 

In most organizations, reports are run on a regular basis -- typically weekly or monthly. Each 
instance of a report contains information about a specific period of time. 

In addition to producing a new report each week or month, some organizations produce a 
separate report for each department, division or region. For example, a retailer might divide 

its market into four distinct regions: Northeast, Central, South and West. A monthly sales 
report is generated for each region. 

 

Figure 14-1. Each report includes information for a specific region.  

Each instance of the report contains useful sales information for a single region, but it does 
not tell you how a particular product is selling nationally. For that, you will need to analyze 
data from all four regions. With Monarch, you can open all four regional reports and create a 

summary showing sales of the product within each region with a grand total for all four 
regions. The resulting summary might look like Figure 14-2. 

 

Figure 14-2. Comparing product sales across four regions. 

By analyzing data from all four regional sales reports, you can compare sales results for each 
region. Since each sales report is generated on a monthly basis, our analysis compares sales 
for only a single month. We can add another dimension by opening several monthly sales 
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reports for each region. Figure 14-3 compares sales results by region broken down by month 
for a three month period. 

 

Figure 14-3. Comparing product sales across four regions for a three-month period. 

To create this summary, we opened a total of 12 reports – 3 monthly reports for each of 4 
regions (see Figure 14-4). 

 

Figure 14-4. Each report contains information for a specific region and time period.  

As we’ve seen, each report contains only a piece of the overall puzzle. However, taken 
together, these same reports can reveal a wealth of information about your business. 

In the previous chapters, you’ve become familiar with the Classic.prn report. Classic.prn is a 
periodic report produced on a monthly basis. Each report contains shipments of classical music 
recordings for a single month. For this lesson, we’ve provided three instances of the Classic 

report representing shipments for the months of January, February, and March. 

When you load a model file or create a new model, Monarch applies the model parameters to 
all open reports. Data extracted from each report is concatenated in the Table view. 

 

 

NOTE 

Although you can open multiple report files at the same time, 
Monarch allows you to open only a single model file. The model file 
is automatically applied to all open reports. Thus, all reports must 
have the same format. For example, although the shipping reports 
used in this lesson all contain different data, they all share the 
same structure. You cannot extract data from two different types 

of reports at the same time. 

 

 

Let’s get started by opening ClassJan.prn, ClassFeb.prn, and ClassMar.prn as well as 

Lesson5.dmod. Go on ahead to Table View and select Autosize Columns  to view all of 

the fields properly.  
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Working in Table View  
Working with data from multiple reports is virtually the same as working with data from a 
single report. You can view, sort, filter, export and print the data just as though it were 
extracted from a single report. There are, however, a few differences that should be 
examined. 

SORTING 

Initially, the data is arranged in the order that the report files were opened. Since we opened 

the January report first, the January records appear first in the table followed by February and 
then March. This initial order has no particular relevance. In fact, it may not be desirable at 
all. By arranging the records this way, Monarch may be violating the natural sort order of the 
reports. For example, each of our shipping reports is sorted by customer and then by ship 
date. By concatenating the records from all three reports, we’ve added a higher sort level. 

Now the data is sorted by period (month) and then, within period, by customer and ship date. 
Let’s restore the original sort order found in the reports. 

Steps: 

1. From the Table ribbon, select Table Design  to launch the Table Design interface and 

then click Add > Sort .  

The Sort Order Definition window displays. 

  

Figure 14-5. The Sort Order Definition window.  

2. Type Original Sort Order in the Name box and then select .  

3. Select the Customer field from the Available Fields box then click the Add >> button. 

4. Select the Ship Date field from the Fields box then click the Add >> button. 
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5. Select Accept  to accept your changes. 

6. Once back in Table view, select Original Sort Order from the Active Sort drop-down list.  

7. Select Autosize Columns  from the Table tab to view all the fields properly.  

The table is rebuilt, sorted by customer and then by ship date. 

 

Figure 14-6. Original Sort Order sorts all of the data extracted from all three open reports.  

By using Customer as the first sort field, Monarch groups all the records from each 
customer together, regardless of which report each record was extracted from (note the 

highlighted ship dates for Betty’s Music Store which range from January 10th through 
March 4th - spanning all three reports). 

IDENTIFYING THE SOURCE OF EACH RECORD 

There are times when you will need to know from which report each record is extracted. You 

may want to apply a filter that excludes some or all of the records from one or more reports or 
create a summary that generates subtotals broken down by period. In either case, Monarch 

will need to be able to identify the source report for each record. 

Sometimes, this information is available within the reports. In our shipping reports, each page 
header contains the date the report was printed. By extracting this information as a field, you 
can easily identify the source of each record.  
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Figure 14-7. The report run date is included in the page header.  

For reports that lack a run date or other unique identifying information, Monarch provides a 
pair of functions - File() and ID() - that you can use to identify the source of each record. 

THE FILE() FUNCTION 

The File() function returns the path and filename of the report file from which each record was 
extracted. For example, for records extracted from the Classjan.prn file, the File() function 

would return the value "C:\Reports\Classjan.prn", assuming that Classjan.prn is located in the 
\Reports folder on drive C. 

Let’s create a calculated field using the File() function. 

Steps: 

1. From the Table ribbon, select Table Design  to launch the Table Design interface and 

then click Add > Formula Field.  

The Formula Field Definition window displays. 

2. In the Name box, type Filename and then click the  button. 

3. From the Type drop-down list, select Character. 

4. Enter 60 in the Display Width box and then select the Formula tab. 

5. Double-click on the File() function from the Functions list so that it is added to the 

Expression box.  
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6. Select Apply  to save the newly defined field and then click Accept  to close the 
Formula Field Definition window. 

7. Select Table Design  from the Table ribbon once more.  

8. Locate the row for Filename. In the cell for Size, enter the value 60. 

9. Select Accept  to apply your changes.  

The new field is added to the end of the table. To view the field, scroll to the right by 
clicking twice in the horizontal scroll bar to the right of the slider. 

 

Figure 14-8. The Filename field, including the path.  

For each record, the Filename field returns the entire path and filename of the report from 
which the record was extracted. Let’s use another function to reduce the field values to only 
the file name. 

Steps: 

1. Launch the Formula Field Definition window by selecting Table Design  > Formula 

Fields.  

2. Highlight the field Filename from the Formula Field Selector.  

3. Enter 12 in the Display Width box. 

4. Select the Formula tab, highlight the expression File() from the Expression box, and 
then press Delete on your keyboard. 

5. Type the following expression into the Expression box: 

RSplit(File(),2,"\",1) 
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This expression separates the path from the filename and returns the filename by itself. 

6. Click Apply  to save your newly defined field and then select Accept  to close the 
Formula Field Definition window.  

Now the Filename field displays only the name of each report file. 

 

Figure 14-9. The Filename field, excluding the path.  

THE ID() FUNCTION 

The ID function assigns a numeric designation to each report at the time the report is opened. 

The first report opened is assigned 1, the second 2 and so on. If a report is subsequently 
closed, the list of designations is collapsed to fill any gap in the assigned numbers. Let’s create 
another calculated field using this function. 

Steps: 

1. From the Table ribbon, select Table Design to launch the Table Design interface and then 
click Add > Formula Field.  

The Formula Field Definition window displays. 

2. In the Name box, type File ID, select , and then select Numeric from the Type drop-
down list. 

3. Select the Formula tab. 

4. Double-click on the ID() function from the Functions list so that it is added to the 
Expression box. 
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5. Click Apply  to save your newly defined field and then select Accept  to close the 
Formula Field Definition window. 

The File ID field displays as a new column in the table.  

 

Figure 14-10. The Filename and File ID fields.  

Since ClassJan.prn was the first report we opened, it is assigned 1. ClassFeb.prn was the 
second report opened, so it is assigned 2 and ClassMar.prn is assigned 3. By opening the 
reports in another order, we could change the designations. You can use the ID function to 
order records in the table or in a summary based on the order in which you open the files, 
rather than alphabetically by file name.  

Creating a Summary to Analyze Data 
from Multiple Reports 
The Summary window provides a powerful tool for analyzing information from multiple 

reports. Since Monarch summarizes data from all open reports, it’s easy to draw comparisons, 
perform roll-ups and spot trends in the data. 

For this lesson we’ve included a summary definition - Sales By Month - that generates sales 
totals for each customer broken down by month. Let’s build the Sales by Month summary. 
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Steps: 

1. Select the Summary tab.  

The Sales by Month summary, which is the only summary included in the model, is built 
and displayed. 

  

Figure 14-11. Summary showing sales for each customer for three monthly periods.  

This summary shows sales for each customer broken down by period. The right-most 

column shows the total sales for each customer for the entire three-month period and the 

bottom row shows the total sales for all customers for each month. 

You could use this same model with a single instance of the shipping report or with any 
number of instances of the report. You could also roll forward a single month by closing 
the January report and opening the April report. The summary would then show subtotals 
for February through April. 

At this point, you can either save your work or simply close the report and model files you 
opened for this lesson.  

Note that the summary above presents null values as “null.” You can configure how nulls 
are displayed in Monarch and we will do so in Lesson 16.  
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[15] Extracting Multiple-Line 
Fields 

In many reports, the majority of fields are single line fields - character, numeric and date 

fields that occupy space on a single line. However, some reports contain large fields that span 
multiple lines. These multiple line fields are variously known as comment fields, description 
fields, memo fields, text blocks or word wrapped fields. In this chapter, you’ll learn how to 

extract a multiple line field from a report and work with it in Monarch. 

To get started, load Monarch and open the Homes.prn report and Lesson6.dmod model file. 

  

Figure 15-1. The Homes real estate report contains new property listings.  

Homes.prn is a weekly real estate report describing properties that were offered for sale 

during the previous week. For each property, the report includes the address, style, price, 
listing broker and numerous other points of interest to prospective buyers. Chief among these 
is a description of the property provided by the listing broker. The Remarks field is typical of 
multiple line fields found in many reports. Each instance of the field contains several lines of 
descriptive text - some of the descriptions are only a few lines long and several are as many 
as nine lines.  

The Lesson6 model contains a detail template that captures several fields from each property 

listing. The first line of the multiple line Remarks field is included in the template, but that field 
is not yet captured. We’ll capture the Remarks field together to illustrate how to capture a 
multiple line field.  
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Capturing a Multiple-Line Field 
To capture a multiple-line field, you need to tell Monarch where the field begins and ends. 
Typically, locating the beginning of a multiple line field is easy - most multiple line fields begin 
at an absolute offset from the first line of the template. Locating the end of a multiple line field 
is sometimes more difficult. Since the number of lines in the field often varies, you can’t tell 
Monarch how big the field is in absolute terms. Instead, you must describe some characteristic 
that is common to the end of the field. For example, the field may end when a blank line is 
reached or when another field is encountered. Monarch includes these and several more 

options that you can use to indicate where your multiple line field ends. 

Steps: 

1. Select Report Design  to switch to the Report Design (Template Editor) view. 

The Template Editor displays, showing several lines of the detail template. In this 

example, the detail template contains a total of 16 lines. 

  

Figure 15-2. The Sample Text box displays several sample lines.  

We can scroll the template sample text to view the remaining sample lines. The last line of 
the template contains the beginning of the Remarks field. Let’s scroll down until that line 

is displayed.  
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2. Scroll down in the Sample Text box until the Remarks field is visible, as in Figure 15-3.  

  

Figure 15-3. The last template sample line represents the beginning of the Remarks field.  

Let’s also scroll the report to display the first instance of the Remarks field. Having this 
field displayed on screen will provide valuable feedback during the capture process.  

3. Use the vertical scroll bar on the right side of the Template Editor (the lower of the two 

vertical scroll bars that are visible on screen) to scroll down so that the Remarks field is 

fully visible on screen, as shown in Figure 15-4.  

   

Figure 15-4. Displaying the multiple line Remarks field in the Report view to provide 

feedback.  

Now we’re ready to capture the multiple-line Remarks field. 

4. In the Sample Text line, use the mouse or the keyboard to highlight only the first line of 
the Remarks field. Highlight this entire line, making sure to extend several spaces toward 
the right to capture all of the data for all of the records in the report.  

The field highlight should look like that shown in Figure 15-5. 

   

Figure 15-5. The last template sample line represents the beginning of the Remarks field.  
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Note that the first line of the field in the report is now highlighted. 

    

Figure 15-6. The Sample Text box displays several template sample lines.  

You might be wondering why we highlighted only the first line of the field. Why not 
highlight the entire field? For a multiple line field, we must indicate the horizontal size of 
the field and the vertical size. The horizontal size is indicated by highlighting the first line 
of the field. However, the vertical size cannot be indicated by highlighting multiple lines 
because the number of lines occupied by each instance of the field varies. What would be 
correct for the first instance of the field may be incorrect for the others. To indicate the 

vertical size of a multiple line field, we must tell Monarch where the field begins and where 

it ends. To do this, we’ll use the Field Definition window. 

5. Select Edit Field  on the Action bar of the Template Editor.  

The Field Definition window appears, showing all of the fields defined for the Detail 
template. Note that at the bottom of the list of fields, the field name eg_Formal, 
fireplaced dining ro… may be found. This is the field we are extracting in the current 
lesson. 

6. Select the field eg_Formal, fireplaced dining ro… to display its properties. Rename this 

field Remarks and then select . 

7. Click the Advanced tab.  
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Figure 15-7. The Advanced tab.  

The Advanced tab includes options for indicating the beginning and ending locations of 
the field. Let’s begin by examining each of the Start Field On options. These options tell 
Monarch how to locate the beginning of a multiple line field. The Start Field On options 
are: 

 Line Number 

The Line Number option indicates that the first line of the field begins at an absolute 

offset from the top of the template. The line number represented by this setting is 

determined by the position of the field highlight in the template sample. Since we 
painted the first line of the Remarks field at Line Number 16, this option displays as 
Line Number 16. 

 

 

NOTE 

The Line Number option is almost always the correct choice for 
indicating the beginning of a multiple line field. The only time the 
Line Number option would not be the correct choice is when the 
multiple line field begins after another multiple line field. In this 

case, the first multiple line field, if it contains a varying number of 
lines, would cause the beginning position of the second multiple 
line field to vary (see Figure 15-8). Only then would you need to 

employ one of the other Start Field On options.  

 

 

 String  

The String option indicates that the first line of the field begins on the next line down 
from (i.e., the line below) a line containing a string. This option is particularly useful 
when trapping HTML data. To use this option, enter the string in the adjacent box.  
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 Preceding String 

The Preceding String option indicates that the first line of the field begins to the right 
of a string, such as a label. To use this option, you simply enter the string in the 
adjacent box. Figure 15-8 shows a modified version of the Homes report where the 

Remarks field falls after another multiple line field, the Directions field. Here the Line 
number option would not work because the varying length of the Directions field would 
cause the beginning of the Remarks field to bob up and down. In this case, the 
preceding string option could be used by entering the label "Remarks:" (without the 
quotation marks). 

 

Figure 15-8. Offset of Remarks field varies due to preceding multiple line Directions 
field.  

 After Last Defined Field in Template 

The After Last Defined Field option indicates that the first line of the field begins two 
lines below a previous multiple line field. Figure 15-9 is an excerpt from Figure 15-8, 
except this time there is no identifying label next to the Remarks field. In this case, 
you could use the After Last Defined Field option to indicate that the Remarks field 
begins immediately after the Directions field. To do this, you must also capture the 

Directions field so Monarch will know where it ends. 
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Figure 15-9. Use After Last Defined Field if no label exists to mark the beginning of the 

second multiple line field.  

Since the Remarks field always begins on the same line in the template (Line Number 
16), we’ll use the Line Number option to indicate where the field starts. Line Number is 
the default option, so it’s already selected.  

Next, we need to indicate where the multiple line field ends. To do this, we’ll select an 
End Field On option. The End Field On options tell Monarch how to locate the end of a 
multiple line field. Let’s examine each option. 

 Line Count 

The Line Count option terminates a multiple line field after a fixed number of lines. 
This option should be used only when every instance of the field has the same number 
of lines. This won’t do for our Remarks field, as each instance contains a different 
number of lines. 

 Nonblank Preceding String of 

The Nonblank Preceding String option terminates a multiple line field when any 
nonblank character appears within a specified number of columns to the left of the 

field. Typically, the character is part of a label that appears to the left of a subsequent 
field. As an example, let’s suppose our fictitious Directions field appeared immediately 
after the Remarks field rather than before (see Figure 15-10). With no blank line to 
separate the fields, it is difficult to determine where the Remarks field ends, but we 
can find the label "Directions:" preceding the first line of the Directions field. We can 
use this label to terminate the Remarks field by selecting the Nonblank Preceding 

String of option and specifying 3 or more columns.  

Monarch will look for any nonblank character in these columns, terminating the field 
when it encounters the colon (:) in the "Directions:" label. 
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Figure 15-10. Use Nonblank Preceding String to terminate a field when another field is 
encountered.  

The Nonblank Preceding String option cannot be used to indicate the end of the 
Remarks field in the report that we are using for this lesson because there is no label 
in an appropriate position near the end of the Remarks field. 

 Blank Field Values  

The Blank Field Values option terminates a multiple line field when Monarch 
encounters a single blank line or a pair of blank lines. Monarch does not require the 
entire line to be blank, only the column positions immediately under the field. Since 
our Remarks field is always followed by a blank line, this option is a good choice.  

In the case of a large text block containing multiple paragraphs, like the one shown in 
Figure 15-11, you would indicate 2 blank lines - to prevent Monarch from terminating 

the field when it encounters the blank line that falls between the first and second 
paragraphs.  

Note that using two blank lines to terminate a multiple line field is possible only when 
the entire text block is followed by at least two blank lines, as is the case in our 
example below. 
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Figure 15-11. Example of a multi-paragraph text block with a single blank line between 

paragraphs.  

 End of Left Justification 

This option terminates a multiple line field when Monarch encounters a line with a 
blank in the first column position of the field or any nonblank character in the column 
immediately preceding the field. Either condition indicates that left justification within 
the field has ended. This option is useful for capturing left aligned text blocks. 
However, if the text block contains a blank line, such as that found between 
paragraphs, Monarch will consider the blank line an end to left justification and will 

therefore terminate the field. Although this option could be used to terminate the 
Remarks field, the Blank Fields option is preferable as it better describes the way that 
the field is actually terminated. 

 None of the Above 

This option terminates a multiple line field only when Monarch encounters another 
template, including another instance of the template in which the multiple line field 
resides. Monarch will also terminate a multiple line field after it extends two pages. 

The field will be terminated on the second page where the page break character 
(ASCII 12) is encountered. This prevents a field from continuing without end if the 
selected End Field On action is not appropriate to end the field. 

This option should be used only when none of the other End Field On options are 
suitable. By employing the minimum actions, you might capture more data than is 
actually occupied by the field. 

 

 

NOTE 

The minimum actions described above are always enforced by 

Monarch, even when the None of the Above option is not selected. 

Select this option only when none of the other options would 
apply. 

 

 

From our review of each of the End Field On options, we find that either the Blank Field 
Values option or the End of Left Justification option will properly terminate the field. We 
recommend using the Blank Field Values option in such cases, since it is more descriptive 
of how the field ends. 
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8. Select the Blank Field Values option to indicate to Monarch that the field will end when a 
blank line is encountered. The default value is 1, which tells Monarch that the field should 
end as soon as 1 blank line is found.  

9. Select Accept  to accept your changes and close the window. 

Note that Monarch has correctly highlighted the first instance of the Remarks field. 

  

Figure 15-12. Testing the multiple line field definition.  

Let’s double check the field definition by inspecting several more instances of the multiple-

line field. 

10. Scroll down in the report to the next Remarks field. 

Note that the second instance of the Remarks field is also correctly highlighted. 

  

Figure 15-13. Double checking the multiple line field definition.  

11. Select Accept  to accept your changes and close the Template Editor.  
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Displaying a Multiple-Line Field in Table 
View  
Now that we are satisfied that the multiple line field is captured properly, we’ll extract the field 
and display it in the Table view. 

Steps: 

1. Select the Table tab to display the extracted data in Table view. 

The table displays, and the Remarks field is found at the far right. 

   

Figure 15-14. Displaying the Remarks field in the Table view.  

The initial field type assigned to the Remarks field is character with a data length of 254 - 
the maximum data length for a character field. The column width is set to the field’s 
template width, which in this case is 62 characters.  

These default settings are appropriate for multiple line fields that extract a small amount 

of data, i.e., when the largest field value is less than the 254 character maximum for a 
character field. For multiple line fields that extract large blocks of text, however, such as 

our Remarks field, the 254-character limit will cause some of the field values to be 
truncated and the display settings don’t let us see very much of each field value on 
screen. 

Memo Fields 
To accommodate multiple line fields that contain more than 254 characters, Monarch includes 
support for memo fields which can handle up to 65,536 characters (64KB). 
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Let’s change the field type of the Remarks field to Memo. 

Steps: 

1. Select Table Design to launch the Table Design interface. 

2. In the field list that displays, locate the row for Remarks and then change its type to 

Memo. 

3. Select Accept  to accept your changes and return to Table view. 

The Remarks field is redisplayed as a memo field. 

To view more information for each memo field, you’ll have to adjust the height of each 
row. Let’s try doing this now. 

4. In the left hand side of the Table view, click on the border between Rows 1 and 2, then 

drag down to expand the height of the rows to at least six lines.  

Even using a row height of 6 lines, we still may not be able to see all of the text in some of 
the Remarks fields. To view more information, we could increase the width of the field, but 
this may still not allow us to view the entire contents of each cell. Although we could 
adjust the row height again (Monarch allows a maximum row height of 12 lines), let’s try 
something new instead. Let’s give Monarch’s Show Field Contents feature a try, which 
displays the entire contents of a cell. 

5. Select Show Field Contents  from the Table ribbon. 

Monarch opens a small window at the top of the display. This window, called the Field 
Contents window, displays the entire contents of the selected table cell. Initially, the 
window height is only a few lines, but you can increase the height to show more lines and 

you can scroll within the window to view the entire contents of a cell. 

  

Figure 15-15. The Field Contents window displays the entire contents of the selected cell.  

As you move the cell pointer from cell to cell in Table view, the Field Contents window will 
display the contents of the selected cell. You can try this by using the down arrow key on 
the keyboard to scroll through the Remarks field cells. 
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Using Memo Fields 
Monarch does not allow a memo field to be used in a sort or summary definition. If you intend 
to include the field in a sort or summary definition, you must leave the field type set to 
Character, or on rare occasions, change it to Numeric or Date. In addition, there are 
differences in the way a memo field is exported and printed versus a character, numeric or 
date field. These differences may or may not provide the results you expect or want. We’ll 
touch on the export and print issues later in this lesson. 

USING MEMO FIELDS IN CALCULATED FIELD AND FILTER 
EXPRESSIONS 

As stated above, you cannot use a memo field in a sort or summary definition. However, you 
can use a memo field as part of a calculated field expression. By creating a calculated field, 
you can extract a subset of the memo field that you can then use in a sort or summary 
definition. 

You can also use a memo field in a filter expression. We’ll illustrate this using the Remarks 
field. Let’s suppose the Real Estate agent has a client interested in purchasing a new home 

and, among the client’s other criteria, she wants a home with a fireplace. Some of the 
property descriptions mention a fireplace and others do not. You could manually review all of 
the Remarks cells in the table to find the ones that mention a fireplace, but this is a tedious 
process, especially if there are hundreds of homes for sale. 

To find out which homes have a fireplace you can create a filter that will search the entire 
Remarks field and return only those records where a fireplace is mentioned. 

Steps: 

1. On the Table ribbon, select Template Design  > Add > Filter > Formula based. 

The Filter Definition window displays. 

2. Type Homes with a Fireplace in the Filter Name box and then select . 

3. Type Instr("fireplace",Remarks)>0 in the Expression box. 

The Instr() function will return the character position of the word "fireplace" in the 
Remarks field. By setting the filter to >0, we are capturing all cases where it appears 

anywhere in the description text. 

4. Choose Apply  to accept your filter and then close the Filter Definition window by 

clicking Accept . 

Monarch applies the filter, which returns 19 records. That may still be more property 
descriptions than you want to read through, so let’s narrow the choices by adding to the 
filter definition. While we’re already supposing, let’s further suppose that the client refuses 
to live in any town other than Tewksbury. 
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5. Select Template Design  > Filters  tool and then click on the Homes with a 

Fireplace filter from the Filter Selector to display its properties. 

6. Add .And.Town="Tewksbury" to the filter expression. The entire expression should now 

read: 

Instr("fireplace",Remarks)>0.And.Town="Tewksbury" 

 

Figure 15-16. Viewing the edited filter expression.  

7. Choose Apply  to accept your filter and then close the Filter Definition window by 

clicking Accept . 

8. Select the Homes with a Fireplace filter from the Active Filter drop-down list. 

This time Monarch returns only three records representing homes with fireplaces in the 
town of Tewksbury. Let’s use the Display Source of Record feature to browse the 
original descriptions in the report. 

  

Figure 15-17. Memo fields used in filter expressions.  

9. Click on any cell in the first row of the table. 

10. Select the Find in Report  button from the Table ribbon.  

Monarch displays the associated property listing in the Report view. 
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Figure 15-18. Displaying the source of a multiple line field.  

You may repeat Steps 8–9 to view each of the other property listings. In Step 8, click any 

cell in the second row to display the second listing or any cell in the third row to view the 
third listing. 

Printing Memo Fields 
When you print a memo field, Monarch treats the field as though it were a character field: it 

prints only that portion of the field that is visible in the Table view. This produces a print 
image that reflects the data you see on screen. To print the entire contents of a memo field, 
you can export the table to a text file, and then use a text editor or a word processor to print 
the file. 

At this point, you can either save your work or simply close the report and model files you 

opened for this lesson.  
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[16] Summaries 

In this chapter, you will learn how to use the Summary window to analyze data from the table. 
The lesson topics include: 

 A discussion of what a summary is 

 Creating a summary 

 Suppressing duplicate values 

 Adding subtotals and blank lines 

 Measure calculations 

 Adding item fields 

 Collapsing and expanding a summary 

 Specifying summary design preferences 

 Creating a quick summary 

 Copying, printing, and exporting summaries 

This chapter assumes that you are familiar with importing and viewing report files, creating 
data extraction templates and working in the Table view. Note also that these features are 

NOT available in Monarch for IBM Analytics. Consider contacting sales@datawatch.com to 
obtain a copy of Monarch Complete and gain access to these additional functions in Monarch.  

 

A summary tabulates information for selected fields and presents the results in a one or two 
dimensional matrix. For example, the summaries shown here show sales totals for a fictional 
distributor of classical music recordings, first broken down by customer, then by media. 

 

Figure 16-1. Sales by customer and media.  

mailto:sales@datawatch.com
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Figure 16-2. Sales by media type.  

The summaries shown above tabulate information about a single key field. In the first 
summary the key field is the Customer field and in the second summary the key field is the 

Media field. The field that is tabulated (or summed) is called a measure. In both of the 
summaries shown above, the Amount field is used as the measure. 

Although only a single key field and a single measure are required, a summary may be quite 
complex, including multiple key fields and measures. Each measure can be used to calculate a 
variety of information about your data, including the sum total, average, percent of total, 
minimum, maximum, standard deviation, and variance. Monarch also provides a count 
function that can be used as a measure. Rather than performing a calculation on a selected 

measure, the count function counts the number of records for each key. 

For example, the summary in Figure 16-3 includes both the Customer and Media fields as key 
fields, and the count function and Amount field as measures. Separate Amount calculations 
are used to break down total sales versus average sales. 

 

Figure 16-3. Sales broken down by customer and media type. The count column displays the 
number of transactions and the Amount and AVG(Amount) columns display the total sales and 
average sales (partial summary shown). 

A summary can also include item fields that expand the summary to show individual 
transactions. Item fields provide an advantage over viewing individual transactions in the 
Table view because you can use the summary to break down subtotals. 

The summary in Figure 16-4 includes the Customer and Media fields as key fields and the 
Quantity and Description fields as item fields. This summary displays individual transactions 
for each media type within each customer. Subtotals are generated for each customer. 
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Figure 16-4. Item fields are used to display individual transactions (partial summary shown). 

The Summary View interface is similar to the Report and Table view interfaces; it includes a 
ribbon, the Summary selector, and the Summary window. 

Right-clicking on the Summary selector displays a context menu that will allow you to perform 
the following operations: 

 Perform a quick export - This export operation uses the default file extension and values 
specified in Export Settings and presents the Create Export dialog with all elements 
prefilled 

 Rename a summary 

 Edit a summary (via the Summary Design interface) 

 Duplicate a summary 

 Rebuild a summary (if a specific summary is selected) 

 Rebuild all summaries 

 Print a summary 

 Quick print a summary 

 Preview a summary before printing 

 Move a summary to the top of the selector 

 Move a summary up one position 

 Move a summary down one position 

 Move a summary to the bottom of the selector 
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To start this lesson, load Monarch and open Classic.prn and Lesson7.dmod. Go on to Table 

view and select Autosize Columns  from the ribbon to view all of the fields properly. 

 

Figure 16-5. Extracted data displayed in the Table view. 

By creating summaries, we can analyze the data to reveal trends and relationships that would 

otherwise remain buried. Let’s create a simple summary that tabulates sales quantities and 
totals for each media type (CDs, SACDs, DVDs, etc.) within each customer. 

 

Creating a Summary 
To create a summary, you select key fields and measures. 

Key fields are used to define the summary matrix. For example, the summary in Figure 16-1 
uses the Customer field as the key field. Monarch examines the field and creates a list of all 
unique values found within the field (e.g., Betty’s Music Store, Big Shanty Music, etc.), then 
uses these values to create the summary matrix. 

Measures are numeric fields that are summed for each unique key field value. For example, in 
Figure 16-1 the Amount field is broken down into separate totals for each customer. Monarch 

also provides a count function that can be used as a measure. Rather than calculating a result 

for a specific field, the count function simply counts the number of records that match each for 
each key field value (for example, there may be 10 records for Betty’s Music Store and 8 for 
Big Shanty Music, etc.). 

Let’s begin by creating a summary that displays sales broken down by customer and media 
type. We’ll use the Customer and Media fields as the key fields and the Amount field as the 

measure. 
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Steps: 

1. Select the Summary tab and then click Summary Design > Add Summary  to 

activate the Summary Design interface.  

 

Figure 16-6. The Summary Definition window.  

The following table summarizes the functions of each of the buttons in the Summary 
Design ribbon.  

USE THIS BUTTON… TO… 

 Accept 
Accept the new template or changes to an existing 
template 

 Cancel 
Cancel the new template or changes to an existing 
template 

 Add summary 
Add a new summary 

 Duplicate summary 
Duplicate a summary 

 Delete summary 
Delete the selected summary 

 Definition 
Add or modify a summary definition. 

 Add/Remove fields  
Add or remove key, measure, and item fields 

 All fields 
Display the properties of all of the fields 

 Keys 
Display the properties of all key fields 
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USE THIS BUTTON… TO… 

 Items 
Display the properties of all measure fields 

 Measures 
Display the properties of all item fields 

 Page setup 
Launch the Page Setup window 

 Help 
Launch the Help file 

 

2. In the Name field, type in Summary1 and then click the adjacent  button.  

3. Select Add/Remove Fields to begin specifying your key, measure, and item fields.   

Adding Key Fields and Measures 
Let’s get right to adding key fields and measures by clicking on the  Add/Remove Fields 
button. The Add/Remove Fields command displays a list of the fields that are available for 
use in a summary definition. This list includes all the fields available in Table view except for 
memo fields. To add a field to the summary definition, you select the field from the Table Field 
box, and then click the appropriate button (Key, Item, or Measure) to add the field to the 
corresponding box at the right. Our summary requires the Customer and Media fields as key 

fields, so let’s select those fields.  

Steps: 

1. Select Customer from the list of available fields, and then select Add Key.  

Customer displays in the Key Field list.  

2. Select Media from the list of available table fields and then select Add Key.  

Now, both Customer and Media display in the Key Field list.  

 

Figure 16-7. Specified key fields. 

Several properties are assigned to each field, as you can see from the entries in the 
corresponding subtabs in the Key screen. For now, we’ll accept these default properties. 
(We’ll explore the properties for Key fields, Item fields, and Measures later in this lesson 
and in the next lesson.) 
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The next step is to select the measures that we want to include in our summary definition. 
Since we want our summary to tabulate sales totals, we’ll select the Amount field as a 
measure. 

3. Select Amount from the list, and then click Add Measure.  

Amount displays in the Measure Field list.  

 

Figure 16-8. The specified measure. 

We have just finished specifying our key and measure fields. 

Selecting Filters to Apply in Summaries 
When you create a summary definition, you may assign a filter to limit the records available to 

the summary. The Apply Filter box, which is accessed by selecting the Definition button on 

the Summary Design ribbon, provides several filtering options. 

 You may select a filter to apply when building the summary. The filter you select is applied 
to the data only for the purpose of building the summary. It is not applied to the Table 
view and it does not limit the data available to other summaries. When building and 
displaying the summary, the filter overrides any filter that you may have applied in the 

Table view - it is not applied along with the active table filter. 

 You may select No Filter. The No Filter option turns off filtering for the summary. The 
summary is built using all records. This option, like the previous option, overrides any 
filter that you may have applied in the Table view. 

 You may select Default Filter. The Default Filter option applies the filter that is currently 
applied to the Table view. This option uses only the records that are available to the Table 
view at the time the summary is built. If you switch the filter that is applied to the Table 

view or modify its definition, the summary is recalculated to reflect the changes. 

We want to use all records to build our summary, so we’ll use the default value of No filter to 
turn off filtering for this summary. 
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Suppressing Duplicate Values 
Most report writers include a facility to suppress duplicate values for selected fields. 
Suppressing duplicate values reduces the amount of visual clutter in a report and helps to 
emphasize details. Monarch also includes this facility, allowing you to suppress duplicate 
values for any key field in a summary (except for the rightmost key field, which never contains 
duplicate values). 

Let’s suppress duplicate values for the Customer key field. 

Steps: 

1. Select the Keys button from the Summary Design ribbon.  

A list of specified key fields as well as their corresponding properties displays.  

The Keys screen includes several subtabs that organize key field properties into logical 
groups. The Layout subtab includes key field properties that determine how the key field 
is displayed, including an option to suppress duplicate values. 

2. Select the field Customer from the Key Field Selector and then click the Layout subtab. 

Locate the drop-down box for Orientation > Down, click the drop-down arrow, and then 

select Suppress duplicates.  

3. Click Accept  to accept the changes made to your summary. 

The summary is rebuilt, and the duplicate customer names are removed.  

 

Figure 16-9. Duplicate values removed from the Customer column. 
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Adding Subtotals and Blank Lines 
You can add subtotals and blank lines to a summary after each logical group of information. 
Subtotal lines and blank lines are added whenever the value of the selected key field changes. 
To illustrate this, let’s add subtotals for each customer and add blank lines to separate each 
customer group.  

Steps: 

1. Select Summary Design > Keys.  

2. Select the Customer key and then click the Layout subtab. 

3. Under the “After each key value change” heading, check the Insert subtotal line check 
box. 

4. Select 1 from the “Insert n blank line(s) after each key value change” field drop-down list. 

5. Click Accept to accept the changes made to your summary. 

The summary is rebuilt. A subtotal line and a blank line are added directly underneath 
each customer group. 

 

Figure 16-10. Subtotals are displayed for each customer. Blank lines separate each 

customer group. 
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Adding Measure Calculations 
Our summary report breaks out sales totals for each media type and each customer. While 
this is useful, you may want to perform other analyses on the data. Monarch supports several 
calculations you can perform when building a summary.  

For each measure you include in your summary definition, you can calculate the total, 
average, percent of total, minimum or maximum value, standard deviation, or variance. To 
perform multiple calculations, you add multiple copies of a measure to the summary definition, 
one for each calculation you want to perform. In addition to the measure calculations, a count 

function is included that you can use to tabulate the number of records matching each set of 
key field values and a special ratio calculation option that divides subtotals for one field by 
subtotals for another field.  

Let’s edit the summary definition to add the percent of total sales calculation for the Amount 
measure. 

Steps: 

1. Select Summary Design > Add/Remove Fields.  

2. Select Amount from the list of available fields that displays, and then click Add Measure. 

This adds a new Amount field to the Measures screen. 

3. Select the Measures button from the Summary Design ribbon. 

4. Select this new Amount field (the second one on the list) and then click the Formula 
subtab.  

 

Figure 16-11. The new Amount subtab showing the Formula options.  
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5. Delete SUM ([Amount]) from the Expression field, and then enter PCT([Amount]) 
instead. Click Apply  when you are finished.  

 

Figure 16-12. Entering a new expression.  

6. Select the General subtab. 

Note that Amount is suggested as the column title. Let’s modify this title to read 

%Amount. 

7. Click on the Use default title check box to deselect this option (the check mark should be 

removed). 

When the Use Default Title option is unselected, the Title box becomes available. 

8. Type %Amount in the Title box. 

9. Under Display Settings, click on the Custom radio button. 

10. Select Percentage from the Format drop-down list.  

11. Specify a Decimals setting of 1. 

12. Choose Accept  to accept your changes and close the Summary Definition window. 

The summary is rebuilt with the new %Amount measure.  

13. Click Autosize Columns  to view all the fields properly. 
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Figure 16-13. Summary with a %Amount calculation.  

Adding Item Fields 
Item fields are optional fields that you can use to expand a summary to show individual 
transactions. Item fields provide an advantage over viewing individual transactions in the 
Table view because you can use the summary to break down subtotals. 

Let’s add the Quantity and Description fields to our summary definition as item fields. 

Steps: 

1. Select Summary Design > Add/Remove Fields.  

2. Select Quantity from the Table Fields list that displays, and then select Add Item. 

3. Select Description from the Table Fields list and then select Add Item.  

4. Choose Accept  to accept the modified summary definition. 

Monarch rebuilds the summary and displays the item fields. 

5. Select Autosize Columns  to view all the fields properly.  
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Figure 16-14. A newly constructed summary showing item fields.  

Collapsing and Expanding a Summary 
Expanding or collapsing (referred to as drilling down or drilling up) a summary provides a 
quick way of exploring summary data. 

 Collapsing (Drilling up)  

Reduces the level of detail in the summary, revealing higher level information. To collapse 
a summary, Monarch removes the rightmost key field from the summary, then re-
calculates and re-displays the summary. 

 Expanding (Drilling down)  

Restores the previously removed key fields to the summary display. When item fields are 
included as part of the summary definition, you view the item fields by drilling down the 
itemized level. 

Let’s start by drilling up to hide the item fields we added to our summary definition. 

Steps: 

1. From the Summary View ribbon, select Drill Up . 

The item fields are removed, restoring the summary to its initial state. 

2. Click Drill Up  once more. 

Monarch further collapses the summary by removing a key field; in this case, the Media 
field. The collapsed version of the summary shows sales broken down by customer. 
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Figure 16-15. After drilling up twice, the summary breaks out totals only by customer.  

3. Select Drill Down  from Summary View ribbon.  

The summary is restored to its original state. Let’s expand the summary even further to 
once again view the item fields we added. 

4. Click Drill Down  once more.  

The summary is expanded to display the item fields. At this itemized level, each line in 
the summary corresponds to an individual transaction from the Classic report. 

 

Figure 16-16. Completely expanded, the summary displays individual transactions (partial 

summary shown).  
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Copying and Printing Summaries 
You can copy summary data to other applications or print it. You perform these operations in 
the Summary window the same way you perform them in Report view or Table view.  

Duplicating Summaries 
You may want to create a new summary that closely resembles a summary you previously 

defined. An easy way to do this is by using the Duplicate  button. To duplicate a 

summary, simply select the summary you want to duplicate from the Summary list and then 

select Duplicate  from the Summary Design ribbon. The duplicated summary appears on 
the Summary list; this summary will have the name of the summary you duplicated and a 
number appended to it. Select this summary to display its properties in the Summary 
Definition window and make further revisions to it. Select Accept when you are finished to 

accept and save your new summary definition. 
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[17] Advanced Summary 
Capabilities 

In the previous chapter, you learned how to define a summary report using Monarch’s 

Summary window. In this chapter, you’ll continue your tour of the Summary window and learn 
how to create more advanced summary reports to reveal more information about your data. 
The lesson topics include: 

 Displaying key field values across 

 Sorting a summary 

 Creating a top 10 analysis 

 Specifying key field values 

This chapter assumes that you have completed Chapter 15 and are familiar with the process of 
creating a summary definition. 

To start the lesson, we’ll load Monarch and open Classic.prn and Lesson8.dmod. Go on and 
display Summary view.  

Summary Displays 
Summaries can be configured to show various details. The following sections outline the steps 
to do so.  

DISPLAYING KEY FIELD VALUES ACROSS 

When more than one key field is included in a summary report, the values for the first key 
field are repeated (see the values for the Customer field in the preceding illustration). This can 
sometimes make for a crowded feel and does not offer the most efficient method of displaying 

data. 

While you could suppress duplicate values to provide a cleaner summary display, the summary 
still requires a large number of rows on screen. With only 20 customers represented in our 

summary, the summary extends 95 rows, or about two pages. 

To provide a more compact summary display, Monarch allows you to display the values for the 
rightmost key field (in this case, Media) across the top of the summary, creating a two 
dimensional matrix. This format, sometimes referred to as a crosstab summary, allows for 
quick comparisons of multiple data groups. 
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For summaries like the one we’ve created, this format provides an ideal solution since it 
displays the entire summary matrix on screen at one time. Let’s see how this works. 

Steps: 

1. Select Summary Design > Keys and then select Media from the Key Fields Selector to 

display its properties.  

2. Select the Layout subtab, select the Across (row) radio button, and then choose Accept 
. 

The summary is rebuilt with the Media values spread across the top row.  

  

Figure 17-1. Summary with customer values displayed down and media values displayed 
across.  

DISPLAYING NULL VALUES 

For some media types, such as BLU (Blu-ray discs) and LP (Long Play albums), no sales have 
been made to certain customers. For example, see the “---” strings in the BLU column for the 
first ten customers. In this case, it would be incorrect to display a zero value in the summary 
report, since zero might suggest that some amount of sales were made to this customer.  

For example, consider the case where a customer places an order for several DVDs and in the 
same period returns several previously purchased DVDs. If the total purchase price of the 

returned media equals the price of the new media, the value for this customer would be zero, 
indicating a net purchase of zero. However, if the customer never placed any orders for digital 
compact cassettes, a zero would not be appropriate. In this case, the value of “---” indicates 
that no sales or returns have been recorded for this media type. 

By default, Monarch displays null values as the string “---”, but you can specify another string, 
or a blank string, to represent null values if you like. You might find the string “---” a bit 
distracting when you’re viewing this type of summary report, so let’s change the default string 
to something else. 
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Steps: 

1. Select Home and then click the Options  button to launch the Options window. 

2. Select the View button from the Options ribbon to display the View options.  

From this screen, you can set several options that affect the way data is displayed on 
screen in Monarch. 

3. Click in the Display null values as edit box, change the “---” string to “*”, and then 
choose Accept . 

The summary is redisplayed using the string you specified. 

   

Figure 17-2. Null values represented by *.  

4. Return the previous null value before moving forward with the lesson.  

FREEZING PANES 

When you spread key values across the top of the summary matrix, the summary often 

becomes wider than the display width, especially if you are using a 640 x 480 display. 
Scrolling right to view more information often removes the most important information from 
the display, i.e., the highest level key fields, in this case the Customer field. To prevent 
columns from scrolling off screen, you can use Monarch’s Freeze Panes command. Let’s freeze 

the Customer column, then scroll right to view the rest of the summary columns. 

Steps: 

1. Click on the column heading BLU so the entire column is highlighted.  

2. Select Freeze Panes  from the Summary view ribbon.  

The Freeze Panes command acts just like the same named command in Microsoft Excel: it 
locks all rows above the cell pointer and all columns to the left of the cell pointer so that 
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they remain on screen when you scroll the rest of the summary. This command also works 
in the Table view, and is retained in Excel file exports. 

3. Click on the arrow on the right side of the horizontal scroll bar to scroll right. 

Note that the Customer column remains visible while you scroll. 

4. Use the arrow at the left edge of the scroll bar to scroll back to the left. 

5. Select the drop-down button of the Freeze Panes tool and then select Unfreeze Panes 

 to unfreeze the Customer column. 

ADJUSTING COLUMN WIDTHS 

Sometimes, you can avoid scrolling altogether by reducing the column widths in a summary so 
that all of the information fits on screen. When Monarch builds a summary, it sets the column 
widths wide enough to handle large numbers, such as 1,000,000.00. If the resulting columns 

are wider than you need to display your summary data, you can adjust them to fit more 
columns on screen.  

 

 

NOTE 

Column Widths for Across Keys 

All of the columns generated from an across key field (in this case 

the CD, BLU, LP, DVD, and SACD) columns are based on the 
column width of the measure. To set the column widths, either use 
the mouse as described below or double-click on the measure (the 
last column of the summary) and use the Measure window to 
change the width of the measure. All columns related to the key 
field will snap to the width assigned to the measure.   

You can use the mouse to set column widths. Using the mouse is 
less precise than using the window, however, requiring you to 

estimate the column width. To use the mouse to set a column 
width, position the mouse cursor at the right edge of the column 
title. The mouse cursor changes to a resizing handle. Click down 
and drag left or right until the column title is the desired width.   

 

 

VIEWING OTHER MEASURES 

You may have noticed that our summary displays only a single measure calculation, even 
though it displayed two measures when we started this lesson. 

When you elect to display values for a key field across the top of the summary, Monarch forms 
a two-dimensional matrix that displays a single measure at a time by default. To display 
results for a different measure, you can select it from the Active Measure drop-down list on 
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the Summary window. This list displays the names for all measures included in the summary 
definition. When you select a measure from this list, the summary is redisplayed to show the 
results calculated for that field. 

Steps: 

1. On the Summary view ribbon, click the drop-down arrow of the Active Measure list box. 
This box currently displays “Amount.” 

   

Figure 17-3. The Active Measure drop-down list in the Summary tab.  

2. Select %Amount from the list of available measures. 

The summary is re-displayed to show media sales as a percent of total sales. Note that the 
Summary line at the bottom of the summary displays the percentages represented by 
each media type across all customers and the rightmost column represents percentages 
for by each customer across all media types. 

   

Figure 17-4. Viewing the %Amount measure.  

DISPLAYING MULTIPLE MEASURES IN ACROSS KEY SUMMARIES 

Monarch allows you to display multiple measures in across key summaries. Let’s try doing this. 

Steps: 

1. Click the drop-down arrow on the Active Measure drop-down list and select All, by Key. 

Monarch displays both of the measures grouped by key.  
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NOTE 

Choose a smaller font size and auto-size the column widths in 
order to display all of the data in the summary window.   

 

 

   

Figure 17-5. Displaying both measures grouped by key.  

You may have to adjust the font size to 10 to reasonably view all the columns.  

We can also choose to view all of the measures grouped by measure.  

2. Click the drop-down arrow on the Summary tab’s Active Measure list box and select All, 
by Measure. 

Monarch displays both measures grouped by measure.  

   

Figure 17-6. Displaying both measures grouped by measure.  
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Let’s return to our across key summary with only one measure. 

3. Click the drop-down arrow on the Active Measure list box and select %Amount and 
restore the font size to 12. 

Sorting a Summary 
When you define a summary, Monarch initially displays the key field values in ascending 
alphabetical order. You can see this in the summary in Figure 17-1. Here, the Customer values 
are displayed starting with Betty’s Music Store, proceeding to The Record Store. The same 
holds true for the values of the Media field (BLU, CD, DVD, LP, SACD). 

If the initial display order is not what you want, you can modify the order for any key field 

using the Keys window. Let’s change the sort order for the Customer key field to sort the 
customer field values in descending order. 

Steps: 

1. Double-click on the Customer column to display the properties of this field. The Keys 
screen is focused.  

2. Click on the Sorting subtab. 

3. Under the Direction heading, select the Descending radio button, and then choose 
Accept . 

The summary is redisplayed sorted in descending order by customer. 

   

Figure 17-7. Sorting a key field.  

Sorting by Measure Values 
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Monarch can also sort a summary based on the values of a measure. Let’s use this feature to 
sort our customers from largest to smallest. First, we’ll select the SUM(Amount) measure 
calculation to show sales totals for each customer. 

Steps: 

1. Select Amount from the Active Measure drop-down list located on the Summary view 
ribbon.  

Now we’ll sort the Customer key field values based on the values of the SUM(Amount) 
field. This has the effect of ranking customers by sales totals. We’ll sort in descending 
order to rank customer sales from largest to smallest. 

2. Double-click on the Customer column to display the properties of this field.  

3. Click on the Sorting subtab of the Customer field. 

4. Under the Sort By heading, select the Measure radio button. 

The SUM(Amount) field is already selected as the measure to sort on. 

5. Ensure that the Descending option is selected. 

6. Choose Accept . 

The summary is redisplayed with customers sorted in descending order by sales totals. 
Note that Hope’s Sweet Notes appears first because it has the largest total sales amount 

of any customer (661.97), followed by Musique Royale with a sales total of 595.43, and so 
on. 

    

Figure 17-8. Sorting a key field based on the values of a measure.  

Let’s also sort the Media field values in the same manner. The result should show the 

media type with the largest overall sales first, followed by the second largest in terms of 
sales, etc. 

7. Double click on any cell in the Customer column once more.  

8. Select the Media field and then click on the Sorting subtab. 

9. Select the Measure radio button under the Sort By heading. 



 

 

326    Monarch 14.2 Learning Guide 

 

The SUM(Amount) field is already selected as the measure to sort on, but the sort order is 
set to Ascending. We’ll change this to Descending in order to display the media type with 
the largest sales first. 

10. Select the Descending radio button under the Direction heading, and then choose Accept 

. 

The summary is redisplayed with customers sorted in descending order by sales totals and 
Media types also sorted in descending order by sales totals. 

   

Figure 17-9. Sorting both Customers and Media types by sales totals.  

Note that CD appears first because it has the largest total sales amount across all 
customers (5403.11), followed by DVD with a sales total of 612.01, and so on. The sales 

totals appear in the Summary row at the bottom of the summary report. 

Restoring the Key Field Direction 
So far, we’ve shown how to create a crosstab summary that displays the values for a single 
key field across the top row, forming a two-dimensional matrix. This format is useful for 
displaying a lot of information, but it may not be ideal for all summary reports. With Monarch, 
you can switch between this format and a more traditional report format, choosing the 
appropriate format for your data and viewing requirements. Let’s reset the Media field to 
display its values down rather than across. 

Steps: 

1. Double-click anywhere on the Customer column to display the properties of the Key 
fields.  

2. Click on the Media field and then select the Layout subtab. 

3. Under the Orientation heading, select the Down radio button. 

Now, let’s suppress duplicate values in the Customer column to give a summary report a 
nicer look. 

4. Select the Customer field and then click on the Layout subtab. 
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5. From the Key values drop-down box, select Suppress Duplicates and then select Accept 
. 

The summary is redisplayed suppressing duplicate customer names. 

  

Figure 17-10. Restoring the summary to a more traditional display format.  

Notice that the summary is still sorted in the same manner, with customer groups sorted 

in descending order by sales amounts (entire summary groups are sorted based on the 

subtotal values for each group). Within each customer, the media types are also sorted in 
descending order by sales. In this format (with no key field displayed across), the 
summary can display both the SUM(Amount) and %(Amount) measure calculations at the 
same time. 

Top n Analysis 
Top n analysis, typically referred to as Top 10 Analysis, is a common tool provided by data 
analysis applications. You can create a top n analysis or bottom n analysis of your summary 
data by first sorting the data in the appropriate order and then by selecting the first n values, 
whether n is 10, 3 or some other number. These values then represent either the top n or the 

bottom n analysis. Let’s see how this works. 

We’ll create a top 3 analysis from our sales summary that shows the top three customers in 
terms of sales. All other customers will be represented using a single summary label, “All 
Others.” To create our top 3 analysis, we start by sorting the customers in descending order 
by sales totals. This places the top performing customers at the top of the summary display. 
We’ve already applied this sort in our previous discussion on sorting. Next, we need to indicate 
that we want to see only the first three customers (the three customers with the largest sales 

totals). 

Steps: 
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1. Double-click on the Customer field to display the properties of the Key fields.   

2. Select the Matching subtab for the Customer field. 

3. Select the First N Values option and enter  in the box (this is the box labeled Count of 

distinct values as sorted). 

4. Under the Accumulator for values after the First N heading, ensure that All Others is 
entered into the Label field.  

5. Select the Media field. 

6. In the Layout subtab, select the Across orientation and then click Accept .  

The summary is rebuilt to show only the top three customers. All other customers are 
grouped together and represented by the “All Others” label. 

  

Figure 17-11. A Top 3 analysis showing the top performing customers in terms of total 
sales.  

You can easily modify this summary to show the bottom 3 customers in terms of sales totals 
by sorting the customer key field in ascending order. Likewise, you can increase or decrease 
the number of customers that you explicitly break down for analysis by increasing or 

decreasing the value in the Customer field’s First n Values option. 

A top n analysis can be defined at any level in the summary. Within each customer, you can 

define a top 3 analysis of each media type by sorting the media type in descending order and 
then selecting the First n Values option for the Media key field and entering the desired 
number in its spin box. 

Specifying Key Field Values 
While performing a top n analysis is useful when you want to determine which items 
(customers, salespeople, etc.) are the top performers, sometimes you already know which 
items you want to look at, whether they are the top performers or otherwise. For example, 
suppose you want to focus on just the digital media types (compact discs, digital versatile 
discs, and LPs). You could do this by creating a filter in the Table view with the filter 

expression: 

Media="CD".Or.Media="DVD".Or.Media="LP" 

You could also write this expression as:  

Media.In.(“CD”, “DVD”, “LP”) 

By applying the filter to the summary definition, the summary would display information about 
only the digital media types. However, Monarch provides an easier and, in some cases, more 
powerful method of achieving this result. For each key field, you can define a list of all values 
you want to use when building the summary. Further, you can accumulate all values not in 
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your list as a single key value (a feature not available if you use a filter). To demonstrate how 
this works, let’s create a list of values to use for the Media field. 

Steps: 

1. Double-click on the Customer field to display the properties of the Key fields.  

2. Select the Media field and then navigate to the Matching subtab. 

  

Figure 17-12. Displaying the Matching subtab of the Media tab.  

3. Check the Values from table option. 

4. Click the Add button. 

All unique values found within the Media field (BLU, CD, DVD, LP, and SACD) are 
displayed. 

  

Figure 17-13. Specifying sorting values. 

5. Select CD from the Key Values list, and then click the Add button to add this value to the 
Specified or Upper Limit Values list. 

6. Repeat Step 5 to add the DVD and LP values to the Specified or Upper Limit Values list.  

The selected values appear in the subtab’s Click to sort values list. 
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7. Click the Finish button to close the Key Values list. 

Let’s accumulate the old media types (BLU and SACD) under a separate heading. 

8. Ensure that the Display box under the Accumulator for unmapped values heading is 
selected. 

9. Type All Others in the Label box, and then choose Accept . 

Monarch rebuilds the summary using only the selected media types. The two media types 
not specified (BLU and SACD) are combined under the label All Others.  

  

Figure 17-14. Using specified values to break down specific digital media types versus all 
other media types.  

Sorting by Key Field Values 
Once you have specified key field values, you can sort the summary data by either the 
specified values themselves (i.e., their names) or by their order in the Specified or Upper Limit 
Values list on the Matching subtab. To do so, select the Key Field radio button on the 
Sorting tab, and then choose either the Field Value option (to order the data by the field 

value names) or the Position in values table option (to order the data by their position in the 
Specified or Upper Limit Values list).  

 

 

NOTE 

The Position in values table option is not available if the Values 
from table option on the Matching tab has not been chosen. 

 

Upper Limit Values 
While the Values from table option lets you select the exact values you want to use in your 
summary, sometimes you want to group values into ranges, such as weekly or monthly 
periods. This capability is provided via the Upper Limit Values option. This option lets you 
define an upper limit for each range of values. An example of this can be seen in the Sales by 

Ship Date summary. 

Steps: 

1. Click on the Sales By Ship Date summary in the Summary Selector. 

2. Select Autosize Columns  from the Summary tab to view all the fields properly. 
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The Sales by Ship Date summary displays. This summary breaks out sales for all 
customers across four weekly periods during the month of April 2010. We created this 
summary by using the dates 04/07/2010, 04/14/2010, 04/21/2010, and 04/28/2010 to 
define the ending dates for each weekly period. 

  

Figure 17-15. Using upper limit values to break down ship dates into weekly periods.  

Summary Limit Values 
Another way to analyze summary data is to set a limit against a measure. This feature works 

somewhat like a filter that is applied after the summary is built. For example, the Sales >=400 
summary displays only those customers for which totals sales exceed 399.00. 

Steps: 

1. Click on the Sales >=400 summary in the Summary selector. 

The Sales >= 400 summary displays. This summary breaks out only those customers for 
which total sales are at least 400.00 (There are seven such customers). All other 
customers are grouped together under an “All Others” label. 

To create this summary, simply double-click on the Customer field, and then select the 

Matching subtab of the Customer field. Select the Measure Limit radio button. Choose 
the SUM(Amount) field, the “>=” operator, and enter 400 in the adjacent field.  
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Figure 17-16. Specifying summary limits.  

  

Figure 17-17. Using Summary Limit Values to break down large customers.  

At this point, you can either save your work or simply close the report and model files you 
opened for this lesson.  
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[18] Exporting Operations 

One of the key features of Monarch is that you can export input files as well as extracted data 
into a number of file formats.  

This lesson will discuss how to export: 

 Reports 

 Tables 

 Summaries 

Reports may be exported as .txt and .pdf files, while tables and summaries may be exported 
to a wider variety of formats, including .csv, .xls, .xlsx, .mdb, .dbase, .accdb, .htm, and .xml, 
among others.  

Note that if your Monarch license is for Monarch Complete or Monarch Complete with Table 
Extractor, you can export tables and summaries to the Tableau data extract (.tde/.csv) and 
QlikView QVX (.qvx) formats. Tables may also be exported as a SAPExport, SAP Transport, or 
Datawatch Designer Data Source file.  

Note also that these features are NOT available in Monarch for IBM Analytics. Consider 
contacting sales@datawatch.com to obtain a copy of Monarch Complete and gain access to 
these additional functions in Monarch. 

We’ll begin by loading the Classic.prn report file and the Lesson8.dmod model file. 

Exporting Reports 
Monarch allows you to export data from the Report window specifically into a TXT or PDF file. 
When exporting to a PDF file, if you have configured the Report Index, the tree definition will 

provide the bookmarks in the PDF file. 

Let’s try exporting the Classic.prn file to a PDF file.  

  

mailto:sales@datawatch.com
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Steps: 

1. Select the Export tab to display Export view. 

  

Figure 18-1. The Export view interface.  

The Export interface is divided into several panels. To the left of the interface is an Export 
Selector. The right-hand side shows to smaller panels arranged one on top of another. 
The top panel shows the Export Job List. Any export selected from the Export Selector 
and added to this panel becomes a job. The bottom panel shows the Export Results. 

Each time you run an export/job, the results of the export process are added to this panel  

The following table summarizes the functions of each of the buttons in Export view.  

USE THIS BUTTON… TO… 

 Export Design 
Launch the Export Design interface 

 Select All Exports 
Select all defined exports 

 Clear Selected Jobs 
Clear all selected jobs 

 Clear Job List 
Clear the job list 

 Create Export 
Create a new export 

 Run Export Run the export 

 

2. Select Create Export to begin defining your export. The Create Export dialog displays.  



 

 

Monarch 14.2 Learning Guide   335 

 

 

Figure 18-2. The Create Export dialog.  

Let’s take a look at this dialog. The File Name field allows you to specify the file name to 
which the export should be saved. Most of the dialog is divided into two panels, the 
Source View panel and the Export File Type panel. The Source View panel allows you 
to select a view or parts of views (in the case of summaries) to export, and the Export File 

Type panel allows you to select a file type in which to save the export.  

3. Enter the file name Export1 in the File Name field. 

4. From the Source View panel, select Report.  

Note that the entries in the Export File Type panel change to reflect the different file types 
to which you can save the export.  
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Figure 18-3. The options in the Export File Type panel show the file types to which you can 

save the report when exported.  

5. Select Adobe PDF (*.pdf) from the Export File Type panel.  

For this exercise, let’s choose to password-protect the PDF file.  

6. Click on the button Edit Advanced Options. 

Note that the dialog closes and the Export Design view displays. A PDF Output panel 
displays on the right side of the view.  

You can add a password to your PDF file by checking the box for Require a password to 
open the document and then clicking the Open Password button.  

If you would like to restrict access to the content of the exported report, you may do so by 
checking the Restrict access to document contents box and then selecting which 
actions you want to permit. You can even specify a password to allow these actions to be 
executed by clicking the Permissions Password button.  

7. We’re not adding any advanced option to our export at this stage so simply select Accept 
to save the export.  

The Export Design view closes and you are brought to Export view. 

Let’s try running our export now. 

8. Double-click on Export1 in the Exports Selector panel so that it is added to the Export Job 
List.  

9. Select the Run Exports  button from the Export ribbon.  

The export runs and the results are displayed on the Export Results panel. 
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Figure 18-4. The Export Results panel shows the results of each export run. This export 

was successfully completed.  

To view the file to which your report was exported, simply navigate to the default exports 
file folder specified earlier in the Options window (typically in 
C:\Users\Public\Documents\Datawatch Monarch\Export). The filename you indicated in the 
Create Export dialog should be found there. Select the file to open it.  

 

Figure 18-5. The PDF file includes all 20 records of Classic.prn.  

Before proceeding with the rest of the lesson, return to Export view and then select Clear 

Job List. All of the jobs added to the job list are run every time you select the Run 

Exports button. Since we are only interested in showing the results of individual exports 
at this time, we’ll need to clear the Export Job List so that previous jobs are not run 
together with new jobs. 

While it is not required that you do so, you may also clear the Export Results panel by 
selecting the Clear Results button. 
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Exporting Tables 
This time, we’ll try exporting the table we extracted using the templates defined in the 
Lesson8.dmod model file. 

Steps: 

1. Select Create Export from the Export ribbon. 

2. Enter Export2 in the File Name field of the Create Export dialog that displays. 

 

 

NOTE 

The export file name (the name of the file to which you will export 
data) and the export name that displays in the Export Selector 
have no relation. You can choose to export to any file name you 

wish. The Export Selector will create export names in the order in 
which the export was created beginning from Export1.   

 

 

3. Ensure that Table is selected in the Source View panel and then select Microsoft Excel 
XLSX (*.xlsx) from the Export File Type panel.  

4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the 
name Table1 here.  

 

 

NOTE 

For Excel files, “Table Name” corresponds to a Worksheet name or 
Named Range, and Named Ranges must begin with a letter or 
underscore, must not be ”C”/“c” or “R”/“r”, cannot contain spaces, 
and must not be the same as a cell reference, e.g., R1C1, A1, 

Z$100, etc., or any other Excel built-in names or objects in the 
workbook. 

 

 

5. Select the Edit Advanced Options button located on the upper right-hand corner of the 

dialog. 

The Export Design interface is activated. 
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Figure 18-6. The Export Design interface showing the properties of the table to be 
exported.  

The Export Design interface allows you to select filters or sorts to include with the export. 
For now, let’s simply save the export using default settings. 

6. Click the Accept button to save the export you’ve just defined. 

You will be returned to the Export interface when you do so. Note that Export2 has been 

added to the Export Selector.  

Let’s run this export and check our results. 

7. Double-click on Export2 from the Export Selector so that it is added to the Export Job 
List. 

8. Select Export2 from the job list and then click the Run Exports button on the Export 
ribbon.  

 

Figure 18-7. The Export Results panel indicates that the export was successfully run. 

To view the file to which your table was exported, as in the previous lesson, simply 
navigate to the default exports file folder specified earlier in the Options window (typically 
in C:\Users\Public\Documents\Datawatch Monarch\Export). The filename you indicated in 
the Create Export dialog should be found there. Select the file to open it. You can also 
simply click on the link provided in the Export Results panel to open the file.  



 

 

340    Monarch 14.2 Learning Guide 

 

 

Figure 18-8. The exported table. Note that the table is named Table1, as specified in the 
Create Export dialog. 

As usual, clear the job list before proceeding to the next lesson.  

 

 

NOTE 

If your Monarch license is for Monarch Complete, your table data 
may also be exported to the Tableau data extract (.tde) and 
QlikView QVX (.qvx) formats.  

 

 

Exporting Summaries 
The Lesson8.dmod model includes three summaries. Since we can create more than one 
summary in a single Monarch session, aside from specifying an export name and export file 
type, we’ll also have to specify which of these summaries to export. You can only export one 
summary at a time. If you wish to export another summary to the same file name, you’ll have 
to add this summary as a new table to the file. Let’s look at how we do this in the following 
example. 
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EXPORTING A SINGLE SUMMARY 

Steps: 

1. Select Create Export from the Export ribbon. 

2. Enter Export3 in the File Name field of the Create Export dialog that displays. 

3. Ensure that the summary Sales by Media is selected in the Source View panel and then 
select Microsoft Excel XLS (*.xls) from the Export File Type panel.  

4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the 
name SalesbyMedia here. Note that table names cannot contain spaces.   

5. Select the Edit Advanced Options button located on the upper right-hand corner of the 
dialog. 

The Export Design interface is activated. 

6. In the Export Options section of the Export Design view, ensure that Overwrite file is 
selected as a When output files exist option.  

7. Click the Accept button to save the export you’ve just defined. 

You will be returned to the Export interface when you do so. Note that Export3 has been 
added to the Export Selector.  

Let’s run this export and check our results. 

8. Double-click on Export3 from the Export Selector so that it is added to the Export Job 
List. 

9. Select Export3 from the job list and then click the Run Exports button on the Export 

ribbon.  

 

Figure 18-9. The Export Results panel indicates that the export was successfully run. 

Navigate to the default exports file folder specified earlier in the Options window (typically 
in C:\Users\Public\Documents\Datawatch Monarch\Export). The filename you indicated in 

the Create Export dialog should be found there. Select the file to open it. You can also 
simply click on the link provided in the Export Results panel to open the file. 
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Figure 18-10. The exported summary. Note that the table is named SalesByMedia, as 
specified in the Create Export dialog. 

Clear the job list before proceeding to the next lesson.  

ADDING A SUMMARY TO AN EXPORT FILE 

Now we’ll add another summary to the Export3.xls export file.  

Steps: 

1. Select Create Export from the Export ribbon. 

2. Enter Export3 in the File Name field of the Create Export dialog that displays. 

3. This time, select Sales >=400 from the Source View panel and then select Microsoft 
Excel XLS (*.xls) from the Export File Type panel.  

4. The Table Name field is activated at the lower right-hand corner of the dialog. Enter the 
name SalesOf400Above here. Note that table names cannot contain spaces.  

5. In the Export Options section located at the lower left-hand corner of the dialog, expand 

the When output files exist options and then select Add data to file. 

6. A drop-down box for When output tables exist options appears. Select Add data to 
table. 

7. Select the Edit Advanced Options button located on the upper right-hand corner of the 

dialog. The Export Design interface is activated. 

8. In the Export Options section of the Export Design view, ensure that Add data to file is 
selected as a When output files exist option and that Add data to table is selected as a 
When output tables exist option.  
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Figure 18-11. Your Excel output options should look as above. 

9. Click the Accept button to save the export you’ve just defined. 

You will be returned to the Export interface when you do so. Note that the export you’ve 
just defined displays as Export 4 in the Export Selector because it is the fourth export you 

defined.   

10. Double-click on Export4 from the Export Selector so that it is added to the Export Job 

List. 

11. Select Export3 from the job list and then click the Run Exports button on the Export 
ribbon.  

 

Figure 18-12. The Export Results panel indicates that the export was successfully run. 

Navigate to the default exports file folder specified earlier in the Options window (typically 
in C:\Users\Public\Documents\Datawatch Monarch\Export). The filename you indicated in 
the Create Export dialog, Export3.xls, should be found there. Select the file to open it. 
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Figure 18-13. The exported file showing two tables. 

The table SalesByMedia displays as the first table of the file. Note, however, that a second 
table,SalesOf400Above, has also been added to the file. Select this table to view its 

results. 

 

Figure 18-14. The SalesOf400Above table displays the data in the Sales>=400 summary. 
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Exporting Data to Datawatch Designer 
Datawatch Designer (Designer) software provides a wide range of digital tools or visualizations 
that allow users to view, analyze, manipulate, and/or present complex information, such as 
historical, spatial, and statistical data. 

The dashboard presented below, for example, displays several charts (visualizations) that 
allow real-time analysis and monitoring of network traffic for a telecommunications service 
provider.  

 

Figure 18-15. A sample dashboard featuring several visualizations of network traffic data.  

Monarch allows the export of tables to Designer workbooks for information visualization.  

WHAT IS A DESIGNER WORKBOOK? 

A Designer workbook may be likened to a Monarch project file. If Monarch project files contain 
the paths (drive and folder information) and file names of both the data source(s) and the 

model to be used in a Monarch session, Designer workbooks contain the data sources and 
dashboards necessary to visualize your data completely and comprehensively, in real time if 
necessary. Both project files and workbooks save time: When a project file is saved and 
reopened, the input file(s) and model, as well all other definitions, are automatically called. 
When a Designer workbook is opened, all defined data tables and previously created 

dashboards are automatically called.  

To create a workbook, one must define a data source, also called a data table, and specify 
dashboard contents. Each item in a dashboard is called a visualization and you can include any 
number of visualizations in a single dashboard.  
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More information regarding Designer workbooks may be found in the Designer Help system, 
which may be accessed online at http://docs.datawatch.com/. 

For this lesson, we’ll use Classic.prn and Lesson8.dmod.  

USING TABLE DATA IN DATAWATCH DESIGNER 

Go to Table View. To launch Datawatch Designer and use your table data as Designer data, 

simply select the Datawatch Designer  button on the Table View ribbon. Datawatch 

Designer is launched and your data are added to the Designer session as a temporary data 
source (note in this case that no data source file is actually created). This step requires that 
you install Designer on your workstation prior to clicking the Datawatch Designer button. If 

Designer is not available, this button is deactivated and cannot be selected.  

To create a data source file that you can use repeatedly in later sessions, export the table data 

as usual and select Datawatch Designer Data Source (.dwx) as the export file type. When 
the export is run, a data source file is created and a link to this export file displays.  

 

 

NOTE 

When exporting tables to Datawatch Designer, clicking on the 
export link that displays after the export is run opens the exported 
file in Designer. Note that you must have Designer versions 13.4.1 
and newer to take advantage of this functionality. 

 

 

Exporting Redaction Alias Maps 
As Monarch processes a report/model which involves consistent alias replacement redactions, 

it generates a redaction alias map for each such redaction. The map expresses the relation 
between the un-redacted and the redacted values for that particular type of redaction (e.g., 
“Consistent alias text”), and for that particular build. Since the redacted values are generated 
based (at least partly) on random numbers, the specific aliases recorded in a map will change 
from build to build, even if Monarch is run against the exact same report and model. 

Monarch automatically discards its redaction alias maps when doing a Close All or when 

exiting. However, in some circumstances, it may be desirable to export a redaction alias map 
so that it may be archived or used by some downstream process. Monarch provides for 
exporting redaction alias maps as simple delimited text files. 

To export a redaction alias map, go to Export Design mode and then press Add Export. In the 
Add Export dialog select Redaction Alias Map under Source View. Notice that when this view 
is selected, the only option under Export File Type is Delimited Text. Press Add. 

http://docs.datawatch.com/
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Figure 18-16. Exporting a redaction alias map.  

After adding the alias map export, use the Export Editor to specify the desired output file 
name and the particular Redaction Map Type you wish to export, as shown below. 

 

Figure 18-17. Selecting a redaction map type.  

The Redaction Map Types listed in the dropdown box correspond directly to the five distinct 
types of consistent alias replacement redactions available. 

When you run this export, the redaction alias map of the selected type is exported to the 
specified output file as delimited text using the delimiter and string quoting mechanism 

common to all delimited text exports (see the “For Delimited Text Files” settings on the Text 

Files tab under Options > Export). The exported map file consists of just two columns: the 
first contains the un-redacted values, and the second contains the corresponding redacted 
values.  
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For example, the first few lines of an export of a “Consistent alias text” map might look like 
this: 

"1000-2000-3000-4000","5w7wiwowywkwzwxeg8o" 

"alpha","uuuuu" 

"beta","9999" 

"gamma","uuuuz" 

"delta","uuuuo" 

"epsilon","ooooooo" 

"The Quick Brown Fox Jumps Over The Lazy 

Dog","0h0h4h0hohvhphnj0amnbueevrjgphdmjm3fts86bgg" 

"7235-5311-6745-2225","zwiwiwswww5wo9kuooz" 

Exporting to Tableau Server 
Tableau Server, by Tableau Software®, is an online solution for sharing, distributing, and 

collaborating on content created in Tableau or exported to Tableau Data Extract form. 
Monarch offers a simple solution to allow data extracted in the application to be exported to 
Tableau Server quickly and seamlessly.  

Steps: 

1. Create an export and select Tableau Data Extracts (.tde) as an export file type. 

2. If you created your export via the Create Export dialog, select Edit Advanced Options. If 
you created your export via Export design, you will not need to perform this step. 

3. Check the box for Publish to Tableau Server. 

4. The information you entered to access Tableau Server in the Security tab of the Options 

window displays. If you did not provide the necessary information in this tab, you can do 
so now. 

 

Figure 18-18. Specifying Tableau Server connection settings.  

  



 

 

Monarch 14.2 Learning Guide   349 

 

 

NOTE 

You can skip this step if you have specified Tableau Server 
connection settings in the Security tab of the Options window. 

 

 

5. Enter a data source name into the field provided and select a publish type. 

 Overwrite Data Source - This option will erase the existing data source and replace it 
with a new one containing the newly exported data. 

 Replace Data - This option will erase all previous data in the data source and replace it 
with the newly exported data. 

 Append Data - This option will append the newly exported data to the data in the 

existing data source. 

6. Select Accept when you are finished to close Export Design view and add your newly 
defined export to the Export selector in Export view. 

7. Run the export as usual. 

Duplicating Exports 
You may want to create a new export that closely resembles an export you previously defined. 

An easy way to do this is by using the Duplicate  button. To duplicate an export, simply 

select the export you want to duplicate from the Export list and then select Duplicate  
from the Export Design ribbon. The duplicated export appears on the Export list; this export 
will have the name of the export you duplicated and a number appended to it. Select this 

export to display its properties in the Export Definition window and make further revisions to 
it. Select Accept when you are finished to accept and save your new export definition. 
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[19] Importing Data from HTML, 
Web Files, and External 
Databases 

This chapter, and the ones that follow, deal with advanced capabilities found in Monarch.  

For most of its history, Monarch has been the leading report mining tool available in the 
market, allowing access to data buried in computer generated reports. Monarch transforms 
static report data into live data that you can explore, analyze, and export to other 
applications. While its ability to re-deploy data locked inside reports has been the major factor 
distinguishing Monarch technology from other data access technologies, Monarch also includes 

powerful data manipulation, analysis, and transformation tools that potentially make it 
valuable for use with other data sources. 

Monarch reads report files and data from database files, spreadsheet files, delimited text files, 
HTML, ODBC databases, PDF and XPS files, and provides report extraction, data manipulation, 
analysis, and transformation capabilities. As well, data access from additional sources, 
including dBase, MS-Excel, and MS-Access files, OLE DB and ODBC compatible data sources, 

such as SQL Server, Oracle, DB2, MySQL, and others, is possible. 

In this chapter, you will learn how to import data from an external data source to begin a 
Monarch session. You will also learn how to import HTML and web files into Monarch. The 
lesson topics include: 

 Accessing database data with Monarch  

 Importing data from an external database 

 Adjusting fields 

 Storing import parameters in a model file 

 Storing import parameters in a project file 

 Importing data from an HTML file 

 Importing data from a Web file 
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Importing Data from an External 
Database 
To illustrate Monarch’s database import capability, we’ll import data from an MS-Access 
database file called Employ.mdb. This file contains information about the employees of a 
fictitious company. We’ll use Monarch to open the file and import data from its Employee 

Roster database table. 

Steps: 

1. Ensure that Monarch is up and running.  

2. Select File > Open > Database > Computer.  

The Open Database File dialog displays. This dialog allows you to select the data source, 
either a data file from a local or network drive or an OLE DB/ODBC data source, such as a 
SQL Server, Oracle, or other OLE DB/ODBC compatible database server. 

 

Figure 19-1. The Open Database File dialog.  

Monarch can import data from the following local file formats: 

FILE FORMAT VERSIONS EXTENSION 

MS-Access 2003 and earlier MDB 

MS-Access 2007, 2010, 2013 ACCDB 

MS-Excel 5.0, 8.0 XLS 

MS-Excel 2007, 2010, 2013 XLSX, XLSM 

dBASE III, IV, 5.0 DBF 
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FILE FORMAT VERSIONS EXTENSION 

Delimited text files  CSV, TAB, ASC 

HTML  HTM, HTML, ASP 

PDF files 1.0, 1.1, 1.2, 1.3, 1.4, 1.5, 
1.6 

PDF 

XPS 1.0 XPS 

 

If you wanted to import from an OLE DB-compatible database (and you have the driver 
installed), you would select the OLE DB option, instead of Computer, and then choose 
whether to import data via the Data Link Wizard or a Data Link File. Note that OLE DB 
is usually faster than ODBC, so if you have a choice of connections to your database, 

choose OLE DB. If you have existing projects and models that use ODBC, then you may 

want to change the connection method to benefit from enhanced performance. 

If you wanted to import data from an ODBC compatible database you would select the 
ODBC connection option, and then use the Select an ODBC Data Source dialog that 
displays to select the ODBC data source name (DSN) that connects to your ODBC data 
source. Monarch can import data from ODBC data sources for which you have established 
an ODBC Data Source Name definition (referred to as a DSN). Monarch does not create a 

DSN for you – you must create a DSN using the Windows Control Panel ODBC Data 
Sources applet or a similar utility. 

3. Open the Employ.mdb file from the Datawatch Monarch\Data folder. 

4. Click the Open button to open the data source. 

Monarch displays the path to the Employ.mdb file in the dialog’s Data Source box. 

5. Click the Select Table button to launch the Select Table dialog. 

The Select Table dialog displays all of the database tables and queries that are available 

within the selected database. This list does not include system tables or queries, which 
hold information about the database structure.  

  

Figure 19-2. The Select Table dialog.  
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Our sample Employ.mdb database file holds only a single database table, called 
Employee Roster. 

6. Check the box for Employee Roster. Expanding the node  beside the table name 

displays all of the fields associated with the selected table.  

 

Figure 19-3. Fields associated with the selected table.  

7. Click Select to close the dialog.  

 

 

NOTE 

If you wanted to apply a filter to the data, you could do so by 

selecting the Apply Filter  button located on the upper right-

hand corner of the dialog box to launch the Filters menu. 

 

 

The left side of the File screen reflects the selections you have made.  
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Figure 19-4. Reviewing table(s) to open from a database.  

The Model field allows you to specify a model file to apply to the database. Applying a 
model to a database is similar to applying a model to a report. The model holds 
parameters that indicate which fields to extract from the database, along with field 
properties for each field and filter, sort, calculated field, and summary definitions.  

8. Select Import Data to bring your data into Table view.   

 

Figure 19-5. The results of our Open Database operation.  

9. If you want to define how the fields of the table should be displayed in table view, in Step 
8, choose Define and Import Data instead of Import Data. 
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Figure 19-6. When you select Define and Import Data, the Edit Table Properties screen 

displays.  

In the Edit Table Properties screen that displays, two tabs may be observed: one to 
specify which database fields you want to import and another to specify a filter to apply. 
By default, all of the fields are selected for importation. Note also that import fields and 
filter definitions are only saved in project files. 

You can manually edit the way import column names will appear in Table view by clicking 

on the appropriate cells under the Table Window Name column in the Import Fields tab.  

You can also add a name prefix to one or more of the import column names. To do so, 
however, you must enter the prefix in the Name Prefix box before selecting any of the 
columns to import. After specifying the prefix, you can then either click the Select All 
button or select individual columns via their check boxes. The names for the columns you 
chose to import will then be displayed, preceded by the name prefix (e.g., if you specified 
a Name Prefix of “Test”, for example, the import column name for the “Department” 

source column would be “TestDepartment.” 

10. Since we want to import all fields, leave the default settings as they are and click Accept 
. 

Monarch launches Table view and populates it with data imported from the Employ.mdb 

file’s Employee Roster table. Select Autosize Columns  to display the fields properly.  
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Figure 19-7. Monarch’s Table view is populated with the data imported from Employ.mdb – 

Employee Roster.  

 

NOTE 

The Table view may be initially populated using data extracted 
from report files or using data imported from an external 

database. You cannot draw data from both sources at the same 
time to populate the table. If you start a Monarch session by 
opening a report file, you will not be allowed to import data from 
an external database in that Monarch session. Conversely, if you 
start a Monarch session by importing data from an external 
database, you will not be allowed to open any report files in that 
Monarch session. These two means of initially populating 

Monarch’s Table view are mutually exclusive. 
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Working with the Datawatch ODBC 
Drivers 
The Datawatch ODBC Drivers are very similar to the Datawatch Data Connectors in that both 
connector types allow you to access data from a number of database types. The Datawatch 
ODBC drivers support access to the following database types: 

 IBM Cloudant  Splunk 

 DB2  Monarch Server – Content 

 Hadoop Hive  Sybase IQ 

 Informix  MongoDB 

 MySQL  Teradata 

 Cloudera Impala  dBase 

 Oracle  OLEDB 

 PostgreSQL  ODBC 

 Salesforce  Business Objects Universe 

 SQL Server  Greenplum 

 Amazon Redshift  OData 

 

Despite their similarities, however, marked differences between these connector types may be 
observed. The ODBC Drivers are configured “outside” of Monarch through the ODBC Data 

Source Administrator, whereas the Data Connectors are configured within Data Prep Studio. 
Whereas the connection settings for the Data Connectors must be specified each time a new 
database table is to be added to Data Prep Studio, the ODBC drivers are configured only once 
and can be applied any number of times to a Monarch session thereafter.  

Because of these differences, you may want to think about what you aim to achieve when you 
access an Oracle database, for example. For instances where you only require quick and dirty 

data prep operations, working with the Data Connectors in Data Prep Studio may be a good 
choice. If you wish to establish continuous access to a database, however, setting up the 
ODBC Drivers may be a better strategy.  

Of course, if you have opened a table using a Data Connector in Data Prep Studio and wish to 
add filters and sorts to it, for example, you always can bring this table into Monarch by 

selecting Application Menu  > Open in Classic Mode.  

The Datawatch ODBC Drivers are only available in Monarch Complete.  
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SETTING UP THE DATAWATCH ODBC DRIVERS 

The Datawatch ODBC Drivers are stored in C:\Program Files\Common 
Files\Datawatch\Drivers. 

Similar to Data Prep Studio, connecting to any of the database types supported in Monarch 
requires some information, including host name, server name, user ID, password, and 
database name, among others. Which information you need will depend on the database to 

which you are attempting to connect. If you wish to use any of the data connectors, contact 
your database administrator to obtain the necessary connection details.  

This section describes how to set up the Datawatch ODBC Drivers. As a typical example, this 
guide will demonstrate how to set up the ODBC Driver for Cloudera Impala.  

Steps: 

1. Select Start > Control Panel > Administrative Tools > Data Sources (ODBC). 

The ODBC Data Source Administrator dialog displays.  

 

Figure 19-8. The ODBC Data Source Administrator dialog. 

2. Select Add.  

3. From the Create New Data Source dialog that displays, select Datawatch 7.1 Impala 
Wire Protocol.  

The ODBC Impala Wire Protocol Driver Setup dialog displays. 
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Figure 19-9. The ODBC Impala Wire Protocol Driver Setup dialog. 

4. Provide a data source name so that you can easily identify this driver from a list. 

5. Type in the host name and the database name you wish to gain access to. 

6. Select Test Connect to check whether or not you have the credentials necessary to 
access the database you named in Step 4. 

 

Figure 19-10. Testing a Cloudera Impala database connection. 

7. Enter your user name and password into the appropriate fields.  



 

 

360    Monarch 14.2 Learning Guide 

 

8. Click OK. 

A message box displays to inform you of the status of your connection. 

Select OK on the ODBC Impala Wire Protocol Driver Setup dialog if you are satisfied with 
the test connection results.  

 

Figure 19-11. The ODBC driver you have just set up is added to the list of allows user data 

sources in the ODBC Data Source Administrator dialog. 

 

Figure 19-12. Setting up a number of the Datawatch ODBC drivers. 
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CONNECTING TO A DATABASE USING THE ODBC DRIVERS 

Assuming that you have set up all of the ODBC drivers you need, you can now begin importing 
data into Monarch. 

Steps: 

1. Select File > Open > Database > ODBC. 

The Select an ODBC Data Source dialog displays.  

 

Figure 19-14. The Select an ODBC Data Source dialog.  

2. Select Cloudera Impala from the list of data source names that displays and then enter 
an appropriate Login ID and password to connect to this database type.  

If connection to the database is successful, the Open Database dialog displays and you can 

select tables as described in Importing Data from an External Database. 

 

Figure 19-15. The Open Database dialog confirms successful Cloudera Impala connection.  
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For more information and updates on the Datawatch ODBC Drivers and Monarch 
documentation, visit docs.datawatch.com.  

NOTES ON THE SALESFORCE DATABASE CONNECTION 

When setting up the Salesforce driver, the ODBC Salesforce Driver Setup dialog displays. After 
confirming a connection to the database you desire, select the Web Service tab of the setup 
dialog.  

 

Figure 19-16. Changing the Statement Call Limit of a Salesforce connection.  

The Statement Call Limit field has a default value of 20 – this limit results in a maximum 
number of 40,000 rows returned when the database is accessed. To remove this limit, set the 
Statement Call Limit value to 0.  

Note also that the number of rows returned is generally limited by the type of Salesforce 
license you have purchased. For more information regarding data limitations, consult your 
Salesforce sales representative. 

Working with Database Data 
Once you have imported data into the Table view, you can sort, filter, and export the data, 
create new calculated fields, and use the data in the Summary window where you can create 

summary reports that perform analyses on the data. In short, you can do anything with 
imported data that you can do with data extracted from a report file. 

Typically, the first thing that you’ll want to do when importing data is to inspect each field to 
ensure that its column width, type and other properties are set correctly. After adjusting the 
column widths, you should briefly inspect each field to ensure that Monarch has established 

the appropriate field type, whether character, numeric, date, or memo. When importing data, 
Monarch sets the type for each field according to its type in the source database. However, 
only a subset of the field types available in many database applications is supported, so it 
maps subtypes to the corresponding base type. 

http://docs.datawatch.com/
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For example, MS Access supports several numeric field types, including Byte, Integer, Long 
Integer, Single, Double, etc. Monarch supports only Numeric, with General, Thousands, 
Currency, Percentage, and Time Span formats that determine how a number is represented on 
screen. When you import a numeric field from an MDB file, Monarch will always set the field 

type to Numeric and will assign to it a format type of General. 

You should inspect each numeric field to ensure that its type and other properties are set 
appropriately. The Net Income field is the only numeric field in our imported data set. Let’s 
inspect this field’s properties. 

SETTING FIELD PROPERTIES 

Steps: 

1. Double-click on the Net Income field to display its properties via the Field Properties 
window. 

  

Figure 19-17. Field properties for the Net Income field.  

Note that the decimal setting of this field is set to 0 (zero) and that its format setting is 
set to General. Let’s change the field format to Thousands and the decimals to 2. While 
we’re here, let’s change the name of this field to something more intuitive. 

2. Change the field name to Salary and then click the  button adjacent to this field. 

3. Click the drop-down button on the Format list to display the available field formats. 

Note that Monarch displays only numeric field formats. For fields imported from a 

database, Monarch does not allow you to change the base field type (from Numeric to 
Character for example). 

4. Select Thousands as the new field format. 

5. Change the Decimals setting to . 

6. Click the Accept button to accept the changes to the field properties. 
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The Table is updated to reflect the changes. 

 

Figure 19-18. Salary field adjusted.  

SETTING DELIMITED TEXT PROPERTIES 

The following settings may be modified when working with delimited text files imported as 
databases. 

 First row contains column names – Check this box to indicate that the first row of the 
file contains column names 

 Delimiter character – Specifies the delimiter (i.e., comma, tab, semicolon, pipe, space, 

other) used in the file to separate values 

 Quoted values may contain embedded line breaks – Check this box if values may run 
beyond one line (i.e., the value includes a line break) 

 Text qualifier – Specifies what character is used (i.e., double quote, single quote, none) 
to enclose values. When Monarch encounters this qualifier in a line, all of the text following 
this character and preceding its next instance is imported as one value, regardless of the 

delimiter used (see Note below).  

 Character set – Specifies the type of encoding to use when interpreting data 

 Lines to skip at start – The number indicated in this box instructs Monarch to skip n 
lines before beginning data import 
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NOTE 

Delimiter vs. Qualifier Example: If the delimiter is a comma (,) 
and the text qualifier is a double quotation mark ("), "Boston, 
Massachusetts" is imported into one cell as “Boston, 
Massachusetts.” By contrast, if no character or the single quotation 
mark (') is specified as the text qualifier, "Boston, Massachusetts" 
is imported into two adjacent cells as "Boston" and 

"Massachusetts."  

 

STORING IMPORT PARAMETERS IN PROJECT FILES 

After making adjustments to the imported fields, it’s a good idea to save your changes to a 
Monarch project file. Project files store both the input file(s) and the model file, including the 
original names of each imported field, as well as the Monarch field name and properties you 
assigned. By opening project files, Monarch preserves the work you did in this session. Let’s 
save our work to a project file and then reload the session. 

Steps: 

1. Select File and then click on the arrow of the Save As  menu. 

2. Select Project, and then type Import in the File name box of the Save Project dialog that 
displays. Leave the Save as type field as is.  

3. Click the Save button to save the model file. 

4. Select File and then click Exit Monarch to exit the Monarch session.  

OPENING THE PROJECT FILE 

Now let’s restart Monarch and import the data along with the model file. 

Steps: 

1. Select the Monarch item from the Windows Start menu. 

2. Select File > Open > Project. 

3. In the Open Project dialog that displays, select Import.dprj. 

Monarch displays the imported data and model files in Table view. Note that the table 
presents as in Figure 19-18, which indicates that the field definitions we specified in the 
saved model have been applied to the open database. 

4. Select File and then click Close All. Select No when asked if you would like to save 
changes made to the model file.  
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Importing Data from an HTML File 
One of the features that distinguishes Monarch from other is its ability to utilize HTML files. 
With Monarch, you can import an HTML file and then create templates to extract data from it 
just as you would with a typical report. 

When you import an HTML file, Monarch parses it into a “Monarch-friendly” format and adds 
markup you may find helpful when trapping fields. 

 

 

NOTE 

Monarch is best suited to work with dynamically generated HTML 
pages, such as those resulting from database queries.  

 

 

Let’s explore Monarch’s HTML capabilities. 

Steps: 

1. Select File, click on the arrow of the Open menu, and then select Report to display the 

Open Report dialog. 

2. From the Files of type drop-down list, select HTML files (*.htm;*.html;*.asp; *.aspx). 

3. Select the Airlines.htm file, and then click the Open button. 

Monarch parses the HTML file and displays it in the Report view. Note the markup that 
Monarch has added (e.g., "<Table–00…"). This markup can be used when trapping fields. 

 

Figure 19-19. Viewing the Airlines.htm file.  
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Airlines.htm is a list of flights from Boston, MA to Manchester, England. It contains 
information such as the price of the flights, the airline providing them, and their earliest 
and latest travel and return dates. 

Let’s scroll down the report and look for an appropriate line with which to create a detail 

template. Remember, a detail template is used for extracting information from the lowest 
report level. 

Notice that for each flight listed, the Latest Return information is the last given. This 
should do for our detail template, so let’s begin by trapping the Latest Return information. 

4. Select the Report Design  button to launch the Report Design interface. 

5. Locate one of the Latest Return lines in the report. In the line selection area to the left of 
it, click and drag so that the Latest Return line and the two lines below it are highlighted. 

 

 

NOTE 

You can easily locate the Latest Return information via the Search 
function of Monarch. 

 

 

  

Figure 19-20. Highlighting the Latest Return information.  

6. Select New Template > Detail to activate the Template Editor. 

7. Rename this template Latest Return. 

8. In the Trap line, type Latest Return: directly above its occurrence in the Sample Text 
box, then highlight the latest return information (e.g., "1 months") in the Sample Text 
box. Extend the highlight by one more character to include instances of two-digit months.  
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Figure 19-21. Specifying trap characters and highlighting a field.  

9. The newly defined field’s properties (i.e., those of eg_1 months) display in the Field 
Properties panel.  

  

Figure 19-22. The Field Properties panel of the field eg_1 months. 

10. Type Latest Return in the Name field of this panel and then click the  button below 
the field to accept your changes. Click the Accept  button to save your changes.  

The Template Editor closes and the Report view displays. Scroll down the report and note 
that all instances of the Latest Return information are now highlighted. 

Now that we’ve defined our detail template, let’s define some append templates to capture 
additional information from the HTML file. 

11. Click Report Design  once more.  

12. Scroll down the report until you come to one of the price lines (e.g., USD 276.00), and 
then click in the line selection area to highlight it. 

13. Select New Templates > Append to activate the Template Editor.  

14. Replace Append 1 with Price in the Template Name field of the Template Editor.  

15. In the Trap line, type USD directly above its occurrence in the Sample Text box, and then 
highlight the price in the Sample Text box. 
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Figure 19-23. Trapping the Price field.  

The properties of this newly defined field display in the Field Properties panel. 

16. Type Price in the Name field, and then click  to accept your changes. 

17. Click Accept . 

The Template Editor closes and the Report view displays. Scroll down the report and note 

that all instances of the flight price information are highlighted. 

Let’s see how the information we’ve trapped will look in Table view. 

18. Select the Table tab and then click Autosize Columns  to view all of the fields 

properly.  

Monarch displays the two fields we’ve trapped as columns in the Table view.  

 

Figure 19-24. Viewing the fields in the Table view.  

19. Return to Report view. 

Using the same techniques that we used to trap the Latest Return and Price fields, try 
trapping some of the other fields in the HTML file (e.g., Earliest Return, Earliest Travel, 
Latest Travel, etc.).  

When you’ve finished trapping as many fields as you want to, view them in the Table view 

to see how successful you are.  
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Importing Data from a Web File 
Importing web files on an FTP site of Amazon S3 is possible in Monarch. To do so, simply 
select File > Open > Web File to launch the Open Web File dialog. 

 

Figure 19-25. Opening a web file in Monarch.  

The Open Web File dialog allows you to select a file protocol (e.g., http://, https://, ftp://, 
etc.) from a drop-down menu and enter the name of the file to open in the adjacent text box. 
Tooltips are provided for each protocol as a guide. The drop-down button located to the right 
of the filename text box enables you to access recently opened web files.  
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[20] Creating External Lookups 

In this chapter, we’ll discuss external lookups, which allow you to add columns from an 
external database to the Monarch table. The lesson topics include: 

 A discussion of what an external lookup is 

 Creating an external lookup from a report 

 Storing lookup parameters in a model file 

 Creating a lookup from two different reports 

 Creating a lookup from two external databases 

What is an External Lookup? 
An external lookup (in technical terms, a left outer join) combines information from two or 
more tables into a single table. External lookups are both powerful and easy to use. In 
Monarch, a lookup can be used to link two or more database sources together or to link a 
report to one or more database sources.  

As an example, consider the tables on the following page. The first table lists employees in the 

Marketing department of a fictional company. This table includes each employee’s name and 
the city where he or she lives. The second table lists employee compensation. Both tables 
share a common column, called Emp_ID, designating a unique ID assigned to each employee. 
From the Marketing table, you could create a lookup, based on the Emp_ID column, to the 
Compensation table to find the salary and bonus for each employee in the Marketing 
department. 

Marketing Table 

Emp_ID Dept Lastname Firstname City 

1597429 Marketing April Anne Worcester 

1607768 Marketing Banning David Burlington 

1593642 Marketing Bartholemew Anne Brookfield 

1605798 Marketing Bradford Eugene Brookline 

1588509 Marketing Carlson Stephen Boston 
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Compensation Table 

Emp_ID Salary Bonus 

1587390 38,480.00 200.00 

1588509 49,452.00 5,000.00 

1593642 42,640.00 4,000.00 

1596792 38,480.00 200.00 

1597429 55,900.00 5,000.00 

1604375 48,620.00 500.00 

1605798 67,990.00 8,500.00 

1607768 72,150.00 10,000.00 

Figure 20-1. Marketing and Compensation tables with a common Emp_ID column.  

To link data from two tables, you start by defining a lookup between the tables. A lookup 
connects the tables based on one or more columns that appear in both tables. These columns, 
referred to as link columns, must include at least some values that are common to both 

tables. In our example, the Emp_ID column would be suitable as a link column, as it contains 
values that are common to both the Marketing and Compensation tables. 

To link these two tables, you would start with the Marketing table, and then create a lookup to 
the Compensation table on the Emp_ID column. Then you select the Salary and Bonus 
columns to add to the Marketing table. The resulting table is shown in Figure 20-2. 

 

Marketing Table 

Emp_ID Dept Lastname Firstname City Salary Bonus 

1597429 Marketing April Anne Worcester 55,900.00 5,000.00 

1607768 Marketing Banning David Burlington 72,150.00 10,000.00 

1593642 Marketing Bartholemew Anne Brookfield 42,640.00 4,000.00 

1605798 Marketing Bradford Eugene Brookline 67,990.00 8,500.00 

1588509 Marketing Carlson Stephen Boston 49,452.00 5,000.00 

Figure 20-2. Marketing Employees table with Salary and Bonus columns linked from 

Compensation table.  

Note that only those records from the Compensation table that have corresponding Emp_ID 
values in the Marketing table are included in the resulting table. Since the lookup was initiated 

from the Marketing table, only the records that appear in the Marketing table are included. 
Records in the Compensation table that have no corresponding Emp_ID values in the 
Marketing table are ignored. 

This behavior is unique to a lookup. In other types of joins, records from both tables are 
combined, with the resulting table having at least one record for each record in the 

contributing tables. Monarch doesn’t support these types of joins, so no new records are 
added when joining data in Monarch. 

To begin this lesson, open the Orders.prn report file and load the Lesson9.dmod model file. 
Go on and view the table of extracted data.  
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Creating an External Lookup from a 
Report 
To illustrate Monarch’s database linking capability, we’ll provide a simple example that starts 
with a slightly modified version of our familiar Classic report file; this report is called 
Orders.prn. We’ll apply a model file to extract data from the report into the Table view, and 

then we’ll create a lookup to an external database to add several columns to the table. 

  

Figure 20-3. The Orders.prn report does not include customer address information.  

Orders.prn is a modified version of Classic.prn. Since you’re familiar with Classic.prn, you’ll 
notice that we’ve removed the address information below each customer name. For the sake 

of this lesson, let’s imagine that the report is always produced using only the customer name 
and that the customer addresses reside in a corporate database. After extracting data from 
the report using a standard Monarch model file, we’ll use a lookup to retrieve the customer 
addresses from the database. 

The Table view includes all of the columns that we’ve extracted from the report, including each 
customer’s name and account number. We’ll use the Account Number column to link to the 
Customer.mdb database, which holds the customer addresses.  
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Steps: 

1. Select Table Design from the Table ribbon and then click Add > External Lookup . 

The Open Database dialog displays. This dialog is similar to the Open Database dialog we 
used in Chapter 18. 

 

Figure 20-4. The Open Database dialog.  

2. Click Computer. 

The Open Database File dialog appears. 

3. Select the Customer.mdb file.  

4. Click the Open button to select the data source. 

Monarch displays the path to the Customer.mdb file in the Data Source box. 

5. Click the Select Table button to display the Select Table dialog box. 

This dialog shows all of the database tables and queries that are available within the 
selected database. The list does not include system tables or queries that hold information 
about the database structure. 
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Figure 20-5. The Select Table dialog displays the Customer screen.  

Our sample Customer.mdb database file holds only a single database table, called 
Customer.  

6. Ensure that the box for Customer is checked. If you wish, you can also expand the  
node beside the table name to see all of the fields that make up the table. Click Select 
when you are done to apply your selection and close the Select Table dialog.  

7. Click the Import Data button on the Open Database dialog. 

The dialog closes and you are transferred to the External Lookup Field Definition 

window.  

    

Figure 20-6. The Row Definition screen.  

The External Lookup Field Definition window displays a Linking Columns Assignment 
screen. We’ll use this screen to establish an external lookup between the external 

database and Monarch.  
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8. Check the Linking Column box for Acct_Num. 

The Acct_Num column in Customer.mdb and Account Number column in your extracted 
table are actually the same column. Each column holds the unique account number 
assigned to each customer. The column names are not required to be the same, but they 

must be of the same type (character, numeric, or date), and they must contain matching 
values that can be used to create a relationship between the two tables. 

9. In the first row of the Table Window Name column, ensure that Account Number is 
selected.  

The Select column allows you to choose with columns from the database to import into 
Monarch (i.e., the linked columns). This screen lists the names of all columns that are 
available in the selected database table or view. Since we want to import the entire 

address for each customer, we’ll leave all of the available columns selected. 

Default names, taken from the source columns, are assigned to the import columns and 
are displayed under the Table Window Name heading. These are the names that will be 
assigned to the columns when you import them into Monarch. 

If you wish to change the way the name of any of the fields in Customer.mdb displays in 
Table view, you may do so in the Table Window name column. If you want to apply an 

import filter to the data, you may also do so by clicking on the External Lookup Filter 
tab and then specifying a filter expression in the screen that displays. 

For now, we’ll simply link the appropriate columns in our table and database. 

10. Name this lookup Lookup1. 

11. Click the Accept  button to close the window. 

Your table is rebuilt and new address columns are added to it. Monarch links the external 
database table to the Monarch table, adding the selected columns to the Table view as 

linked columns. 

  

Figure 20-7. The table is rebuilt to include fields from the Customer.mdb database.  
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NOTE 

You can manually edit the import column names by double-clicking 
on them. You can also add a name prefix to one or more of the 
import column names. To do so, however, you must enter the 
prefix in the Name Prefix box of the External Lookup Field 
Definition window before selecting any of the columns to import. 
After specifying the prefix, you can then either click the Select All 

button or select individual columns via their check boxes. The 
names for the columns you chose to import will then be displayed, 
preceded by the name prefix (e.g., if you specified a Name Prefix 
of “Test”, for example, the import column name for the “Address 
1” source column would be “TestAddress 1.” 

 

 

10. Scroll right to view the linked columns. 

  

Figure 20-8. The customer address columns are added to each record in the Monarch table. 

You can use linked fields just like any other fields in Monarch. Linked fields can be used in 
filter, sort, calculated field, and summary definitions and can be printed or exported along 
with fields that you extract from a report. 

Note that in this example, the External Lookup table displays below the Main database 

table and that Data Prep Studio can only open the Main table.  
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Storing Lookup Parameters in a Model 
File 
Lookup parameters can be saved in a Monarch model file along with other information about 
your Monarch session. When you load the model file, the lookup parameters are used to re-
establish the lookup with the external database. 

Storing lookup parameters in a model file is easy. You simply save the model file. That’s all 
there is to it. The model file records the name of the lookup database along with the fields 
used to establish the lookup and the fields you linked to the Monarch table. By applying the 

model in a future Monarch session, Monarch preserves the work you did in this session. Let’s 
save a model file and then reload the session using the model.  

Steps: 

1. Select File, click on the arrow of the Save As  menu, and then select Model.  

The Save Model dialog appears. 

2. Type  in the File name box of the dialog (the .dmod extension is automatically 

added) and then click the Save button to save the model file. 

3. Select File and then click Close All to end the current Monarch session. 

 

Creating a Lookup from Two Different 
Reports 
While Monarch’s linking capability is very useful if you happen to have access to a database 
that includes the information you need, what if your data resides in two different reports? You 
may have already guessed the answer: Using Monarch’s export capability, you can create a 

database file from one report, start a new Monarch session to extract data from the second 
report, and then create a lookup to the exported database file. While this involves a two-pass 
approach, it’s relatively easy to do. 

Let’s imagine that we don’t have access to the database of customer address information that 
we used in the previous example. Instead, we have the Orders.prn report and another report 
called Customer.prn that lists all of our customers. Let’s use Monarch to link information from 
these two reports. 
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USING A REPORT TO CREATE A LOOKUP FILE 

We’ll start by opening the Customer report, applying a model to extract the customer address 
and account number fields, and then exporting these fields to a database file. We’ll use this 
file as a lookup file, which we’ll link to the Orders.prn report. 

Steps: 

1. Open the Customer.prn report file as well as the Customer.dmod model file.  

2. Select the Table tab and then click Autosize Columns  to view all the columns in the 
table properly.  

  

Figure 20-9. Customer address fields extracted from report.  

The Table view includes all of the columns that we’ve extracted from the report, including 
each customer’s name, account number, and address. Now we’ll export the table to a 

database file. 

3. Select the Export tab and then click Create Export  to launch the Create Export 
dialog. 

4. Specify a filename of LookupSource. 

5. Ensure that Table is selected in the Source View panel and then select Microsoft Access 
MDB (*.mdb) as the Export File Type.  

6. Type CustomerAddresses in the Table Name field and then click the Run this export 
button located on the upper left-hand corner of the dialog. 

A progress dialog displays. Monarch displays the following message box when the export is 
finished. 
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Figure 20-10. The message box that displays after successfully completing the export.  

7. Click Close to exit the progress dialog. 

8. Click Close to exit the Create Export dialog.  

LINKING TO THE LOOKUP FILE 

Now that the first report has been exported to a database file, it’s time to load the second 
report and link to it. 

Steps: 

1. Close all of the open files in Monarch and then open the Orders.prn report and the 
Lesson9.dmod model file. Select No when asked if changes to Customer.dmod should be 

saved. 

2. Select the Table tab and then click Autosize Columns  to view all the data in the 
table properly.  
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Figure 20-11. Data extracted from the Orders.prn report.  

Now we’re ready to link to the database file we created and pull in the address information 
for each customer. 

3. Select Table Design > Add > External Lookup > Database.  

4. Click the Browse button beside the Data Source field and select the Local or network 

file option to display the Open Database File dialog. 

5. Select the LookupSource.mdb file from the Datawatch Monarch\Export folder then click 
the Open button. 

Monarch displays the path to the LookupSource.mdb file in the Data Source box. 

6. Click the Select Table button and check the box for CustomerAddresses from the 
dialog that displays. Click Select when you are done.  

7. Select OK to close the Open Database dialog and launch the External Lookup Field 
Definition window. 

8. Name this lookup Lookup2. 

9. Check the Linking Column box for Acct_Num.  

10. In the first row of the Table Window Name column, ensure that Account Number is 
selected.  

Let’s leave all other default settings as is for now.  

11. Select Accept  to apply your changes and close the window. 

Monarch links the CustomerAddresses table to the Monarch table, adding the address 
columns to the Table view as linked columns. You may need to scroll to the right to view 
the address columns.  
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Figure 20-12. Customer addresses linked to Orders.prn report data (column widths 
autosized).  

We started with two disparate reports and ended with data from both reports linked 
together in the Table view.  

12. Select File, and then click Close All to reset the Monarch session. Select No when 

prompted to save changes to the model. 

Creating a Lookup from Two External 
Databases 
In the previous sections, we demonstrated how you can link data from an external database to 
data extracted from a report. This is useful when a single report doesn’t include all of the data 
you need, but you can also use Monarch to combine data from two databases, without ever 
loading a report file. 

To see how this process works, let’s return to the example from the beginning of this lesson. 

In that example, we showed how you could link fields from an employee compensation table 
to an employee roster table. 

The employee roster table is called Marketing since it stores information only about employees 
in the Marketing department. The employee compensation table is called Compensation. This 
table stores salary and bonus information for all employees for the entire company. 
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IMPORTING DATABASE DATA 

We’ll start by importing data from the Marketing table. This table resides in the Beantown.mdb 
file (the name of our fictional company is Bean Town Investments). The compensation table 
resides in a file called Payroll.mdb. We’ll create a lookup to this table in order to add the 
Salary and Bonus field for each employee.  

Steps: 

1. Select File, click on the arrow of the Open menu, and then select Database. 

The Open Database dialog displays.  

2. Click the Data Source Browse button and select the Local or network file option. 

The Open Database File dialog appears. 

3. Select the Beantown.mdb file from the Datawatch Monarch\Data folder and then click 
Open. 

Monarch displays the path to the Beantown.mdb file in the Data Source box. 

4. Click the Select Table button and, in the Select Table dialog that displays, choose 
Marketing. Click Select when you are done to close the dialog.  

5. Select OK in the Open Database dialog.  

The Import Field Definition window displays. 

6. Ensure that all fields are selected (click Select All if not) and then click Accept . 

Monarch opens Table view and populates it with data imported from the Beantown.mdb 
file’s Marketing table. 

7. Select Autosize Columns  to display all fields properly. 

 

Figure 20-13. Monarch’s Table view is populated with the data imported from 

Beantown.mdb, Marketing table.  
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LINKING DATABASE DATA 

Now we’ll link to the Compensation table to add the salary and bonus information for each 
employee. 

Steps: 

1. Select Table Design > Add > External Lookup > Database.  

2. In the Open Database dialog, click the Browse button next to the Data Source field and 

then select the Local or Network File option. 

The Open Database File dialog appears. 

3. Select the Payroll.mdb file from the Datawatch Monarch\Data folder, and then click the 
Open button. 

Monarch displays the path to the Payroll.mdb file in the dialog’s Data Source box. 

4. Click the Select Table button. 

The resulting dialog displays all of the database tables and queries that are available 

within the selected database. Check the Compensation table box and then click Select. 

5. Click OK to close the Open Database dialog and launch the External Lookup Field 
Definition window. 

6. Name this lookup Lookup3.  

7. In the Linking Columns Assignment screen, check the Linking Column box for Emp_ID.  

8. In the first row of the Table Window Name column, ensure that Emp_ID is selected.  

This setting indicates that Emp_ID in the Payroll table should match Emp_ID in the 

Marketing table.  

9. Ensure that both the Salary and Bonus fields are selected in the Select column. 

10. Click the Accept  button to apply your settings and close the External Lookup Field 
Definition window. 

Monarch links the external database table to the Monarch table, adding the selected 
columns to the Table view as linked columns. 
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Figure 20-14. Salary and Bonus information are added to each record in the Monarch table.  

11. Select File, click on the arrow of the Save As  menu, and then select Model.  

12. Type Compensation in the File name box of the Save Model As dialog box that displays, 

and then click the Save button to save the model file. 

13. Select File and then click Exit Monarch.  

 

 

NOTE 

If prompted to save changes to the project file, select No.  

 

 

The model file stores the lookup parameters along with the import parameters. However, 

the model file does not store the name of the import database. To restore the session, use 
the Open Database dialog to select the Beantown.mdb file and the Compensation 
model. 

Note that on the Dataset selection screen, you may select any of the three employee 

roster tables (Accounting, Data Processing, or Marketing). The model will work 
equally well regardless of which table you select. That’s why the data source is not stored 

in the model file -- the model can be used with any compatible data source. This is similar 
to how models store information about a report. The report name is not stored in the 
model so that the model can be used with multiple reports as long as the reports all have 
a compatible format. 
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[21] Using Digital Signatures 

This chapter introduces a Monarch feature designed to authenticate files, thereby enhancing 
security. Here, you will learn about digital signatures. The chapter assumes you are familiar 

with exporting Table or Summary data into XLSX or XLSM formats.  

Note that this feature is only available in Monarch Classic and Monarch Complete.  

What are Digital Signatures? 
Digital signatures are used to authenticate files (i.e., the Excel files that are produced via 

Monarch Export) by using computer cryptography. Digital signatures help to establish the 
following assurances: 

 Authenticity 

The digital signature helps to assure that the signer is who he or she claims to be. 

 Integrity 

The digital signature helps to assure that the content has not been changed or tampered 
with since it was digitally signed. 

 Non-repudiation 

The digital signature helps to prove to all parties the origin of the signed content. 
"Repudiation" refers to the act of a signer's denying any association with the signed 
content. 

To make these assurances, the content creator must digitally sign the content by using a 
signature that satisfies the following criteria: 

 The digital signature is valid.  

 The certificate associated with the digital signature is current (not expired). 

 The signing person or organization, known as the publisher, is trusted. 

 The certificate associated with the digital signature is issued to the signing publisher by a 

reputable certificate authority (CA). 

 

To start, let’s open the Classic.prn report and Lesson8.dmod model.  
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Figure 21-1. Loading the Classic.prn report and Lesson8.dmod model. 

Adding Digital Signatures to an Excel File 
Steps: 

1. Select the Table tab.  

The Table view for the report displays. Select Autosize Columns  from the Table tab 

to view all the data properly.  

   

Figure 21-2. The Table view for Classic.prn report and Lesson8.dmod model. 

2. Select the Export tab and then click the Create Export button. 
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The Create Export dialog displays.  

3. In the File name box, enter Digital1. 

4. Ensure that Table is selected in the Source View box and then select Microsoft Excel 
XLSX (*.xlsx) from the Export File Type box.  

5. Name the table DigiCert in the Table Name box.  

6. Click the Edit Advanced Options button to launch the Export Design view. 

7. Click the Advanced tab of the Excel Output panel. 

The Excel Advanced Features options of the view display. 

  

Figure 21-3. The Excel Advanced features panel in Export Design view.  

8. Check the Digital Signature box. 

When you do this, the Certificate drop-down list is activated. This list contains options that 
allow you to select where the digital certificate you are applying is located. Let’s say that 
your digital certificate is stored in the same machine in which Monarch is installed. 

9. Select Change to Certificate from File from the Certificate drop-down list. 

10. Select the digital certificate you wish to apply to the export, and then click OK. 

Depending on the settings of your digital signature, you may or may not be asked to set a 
password for the certificate. If prompted to do so, simply provide one. 

11. Click Accept  when you are finished to close the Export Design view and return to 
Export view. 

12. Run the export you have just defined. Refer to Chapter 17 – Exporting Operations of this 
learning guide if necessary.  
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13. Select File, and then click Exit Monarch. Select No when prompted to save changes to 
the model and the project. 

Viewing Digital Signatures 
Digital signatures display when you open the spreadsheet containing the certificate. Let’s do 
this. 

Steps: 

1. Launch your spreadsheet. If you don’t have a spreadsheet, just follow along. 

2. Select File, and then click Open. 

3. Navigate to your Monarch Exports folder (typically in 
C:\Users\Public\Documents\Datawatch Monarch\Export), and then open the Digital1.xlsx 
worksheet. 

The worksheet displays in your screen. 

 

Figure 21-4. The exported table with a digital signature.  

Note the following features of the file that are not present in ordinary worksheets or 
workbooks: An alert with an Edit Anyway button displays on the upper portion of the 
table to warn you that the workbook has been marked final to discourage editing.  

Should you choose to click Edit Anyway to continue editing the workbook, the following 
dialog displays: 
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Figure 21-5. Selecting Yes removes any digital signatures applied to the workbook.  

Selecting Yes on the dialog removes any digital signature applied to the workbook. 

As well, on the lower left-hand corner of the workbook, you will find a certificate icon. 
Hovering on this icon with your mouse yields a callout that informs you that a digital 
signature has been applied to the workbook. 

 

Figure 21-6. The digital signature callout.  

If you click on this icon, a list of all digital signatures applied to the workbook display on 
the right-hand side of the workbook. You can hover on any of these signatures to display a 
drop-down button that, upon clicking, will allow you to view the properties of that 
signature.  

 

Figure 21-7. A list of digital signatures displayed on the right-hand side of the workbook.  

4. Close the spreadsheet. 
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[22] Using Pivot Tables 

In the previous chapter, you learned about a special Monarch feature you can use to increase 
the security and authenticity of your report: digital signatures. 

In this chapter, you will learn about another special Monarch feature: pivot tables. Pivot tables 
are interactive tables within Monarch that allow you to further manipulate and view data. They 
can only be created for XLSX files; they cannot be created for XLS files. If you are using a 
version of Excel earlier than 2007, you can download the Microsoft Office Compatibility Pack 
from Microsoft, which will allow Excel 2000 and higher to open XLSX files.  

The option to create a Pivot Table is not available for a Summary export, since pivot Tables 
use tabular “raw” data as a source, not summarized data. Monarch will export the table data 

as a worksheet and the pivot table as a separate worksheet, which refers to the exported 
data. 

Let’s again start by loading the Classic.prn report and the Lesson8.dmod model files.  

   

Figure 22-1. Loading the Classic.prn report and Lesson8.dmod model. 
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Adding Pivot Tables to an Excel File 
Steps: 

1. Select the Table tab.  

The Table view for the report displays. Select Autosize Columns  from the Table tab 

to view all the data properly.  

  

Figure 22-2. The Table view for Classic.prn report and Lesson8.dmod model. 

2. Select the Export tab and then click the Create Export button. 

The Create Export dialog displays.  

3. In the File name box, enter Pivot1. 

4. Ensure that Table is selected in the Source View box and then select Microsoft Excel 
XLSX (*.xlsx) from the Export File Type box.  

5. Name the table PivoTable in the Table Name box.  

6. Click the Edit Advanced Options button to launch the Export Design view. 

7. Click the Advanced tab of the Excel Output panel. 
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The Excel Advanced Features options of the view display. 

8. Check the Include Pivot Table sheet box to activate the pivot table definition options.  

  

Figure 22-3. The Excel Advanced features panel in Export Design view.  

9. Select Overwrite table from the When sheet with pivot table exists drop-down. 

10. Click on the Options tab that displays and then enter PivotTable into the Pivot Table 

name field. You may leave the other settings in this tab as they are for now. Note that 
pivot table names must conform to the table-naming guidelines described earlier in this 
guide.  

11. Click the Fields tab, click on the New drop-down list of the Row Labels field and then 
select (double-click) Customer. 

12. In the Column Labels field, select the New drop-down button, and then select (double-

click) Media from the list that displays.  

13. In the Values field, select the New drop-down button, and then select the values Amount 
and Unit Price from the list that displays.  

Note that when you do so, an additional entry (e.g., _VALUES_HEADER_) is added to the 
Values field. This additional entry simply indicates that the separate fields of Amount and 
Unit Price will have their own headings in the resulting worksheet.  

Use the sorting button that displays beside each pivot field or value to specify a display 

order (i.e., ascending or descending).   

14. Select Accept  when you are finished to close Export Design view and return to Export 
view.  

15. Run the export you have just defined. Refer to Chapter 17 – Exporting Operations of this 
learning guide if necessary.  

16. Select File, and then click Exit Monarch. Select No when prompted to save the changes 
in the model and the project. 
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Viewing a Pivot Table 
Steps: 

1. Launch your spreadsheet. If you don’t have a spreadsheet, simply follow along. 

2. Select File, and then click Open. 

3. Navigate to your Monarch Exports folder (typically in 
C:\Users\Public\Documents\Datawatch Monarch\Export) and then open the Pivot1.xlsx 
worksheet. 

The worksheet displays in your screen. 

 

Figure 22-4. The exported Pivot1 worksheet.  

The PivoTable tab shows an Excel file version of the Classic.prn table. 

4. Click on the PivotTable1 tab. 

The pivot table displays on your spreadsheet.  
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Figure 22-5. The exported Pivot1 worksheet.  

For more information regarding pivot tables, you may access the Monarch Help file by 

selecting File, clicking on the drop-down button of the Help  menu, and then select 
Help Topics from the options that display. 

Working with Pivot Tables 
When we selected pivot table fields in the earlier part of this chapter, we were specifying 
settings similar to those used when creating a summary. For example, the Row Labels specify 
down keys, the Column Labels specify across keys, and the Values specify measures.  

Clicking on the drop-down buttons on either the Row Labels or Column Labels fields displays a 
set of options that allow you to sort and filter your data. 
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Figure 22-6. Options for sorting and filtering pivot table data.  

To display the unit prices and amounts for only the media types DVD and BLU, for example, 
simply click on the drop-down button of Column Labels, deselect the boxes for CD, LP, and 
SACD, and then click OK. When you do this, the Select All checkbox is automatically 
deselected.  

A new table is rebuilt and displayed in your spreadsheet. 

 

Figure 22-7. The new pivot table showing only unit prices and amounts for the media types 

DVD and BLU.  
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[23] Working with Asian (CJK) 
Character Sets 

Displaying fullwidth characters (e.g., Chinese/Japanese/Korean, or CJK, characters) is more 

complex than displaying standard fixed-width single byte character set (SBCS) characters. 
This stems from the fact that fullwidth characters usually take up nearly twice as much 
horizontal space in pixels to display. Due to the grid-like nature of Monarch’s unique trapping 

process, Monarch requires that all characters are rendered with the same amount of screen 
space in order for characters to align vertically. This requirement causes issues when SBCS 
and fullwidth characters are present on the same report.  

Notice the indeterminate alignment of these lines: 

 

Now observe the grid-like alignment of these lines: 

 

As you can see in the first example, the characters do not line up in any meaningful way. 
Thus, it is impossible to create a template that traps consistently in this situation.  By 
contrast, in the second example, each character takes up the same amount of space, thereby 
giving us a grid-like 1-to-1 alignment and making it possible to trap data with predictable 
results. This is the fundamental challenge that Fullwidth Character Mode addresses. 

Working with Asian Character sets may be easily accomplished by specifying four settings: 

 Fullwidth Character Mode 

 Fallback Asian fonts 

 Date/Time format 

 Ignore Character Width 
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Setting Fullwidth Character Mode 
The Fullwidth Character Mode setting toggles Fullwidth Character Mode on and off. While on, 
all characters will be rendered in the same horizontal space as a Kanji glyph. 

Most fonts do not contain glyphs for every character from every language.  This issue is 
addressed by a fallback architecture that renders unknown characters in standard fonts known 
to contain those characters.  The result is text that is drawn in multiple fonts as needed on a 
per-character basis. 

 

Figure 23-1. Setting Fullwidth Character Mode on via the Options window.  

To set Fullwidth Character Mode on, simply select Options > Input from the Home screen 

that displays when Monarch is launched. Select Accept  to save your settings when you 

are finished.  

 

 

NOTE 

All other settings for dealing with Japanese input files are 

applicable only when this setting is enabled. 
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Setting Fallback Asian Fonts 
The Fallback Asian Fonts setting allows the user to select which fonts will be used to render 
unknown characters in the event of a fallback. Japanese, Simplified Chinese, and Traditional 
Chinese options are available. 

 

Figure 23-2. Recommended fallback Asian fonts.  

Language options are also available in the Input tab of the Options window.  

Setting the Date/Time Format 
The most commonly used date format in Japan is yyyy/mm/dd, and the Japanese characters 

for “year,” “month,” and “day” are inserted usually between numerals. Thus, in the Japanese 
format, the date December 21, 2013 is presented as: 

 

Users trapping the fields of Japanese input files can compel Monarch to convert dates/times 
into one of two Japanese formats by selecting the appropriate format from the Field Properties 
panel that displays when a field is defined.  
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Figure 23-3. Specifying the Japanese date format via the Field Properties panel.  

Dates and times may be converted to: 

 Japanese date – This setting converts dates/times into the standard Japanese format.  

 Japanese Era date – This setting converts dates/times into the standard Japanese 
format but also inserts the current era prior to the actual date.  

Setting the Ignore Character Width 
Option 
Asian reports sometimes use “fullwidth” or “wide” Latin characters. Monarch allows users to 
ignore the distinction between standard (or “narrow”) and wide Latin characters while 
searching a report, table, or summary. This option in enabled via the Ignore Character Width 
setting.  

When users opt to ignore character widths, the string “ ” would return search hits for 

both “ ” and “ .” 

Likewise, the string “ ” would return search hits for both “ ” and “ .” 

Note that in the above example, “ ” is using the wide characters for t, e, and s.  This 
distinction is made to clarify that the text is not simply a string with spaces between 
characters. 
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To set this option, assuming you have an open report in Report View, select the Search  

button in the Report ribbon and then tick the checkbox for Ignore Character Width that 
appears on the Search panel that displays.  

 

Figure 23-4. Setting the Ignore Character Width option.  
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[24] Using Monarch Utility 

Monarch Utility enables users of Monarch to quickly and easily perform tasks that might 
otherwise be very time consuming. With Monarch Utility, you can: 

 Copy models and projects to new locations 

 Convert text/XML models or projects into binary ones 

 Manage external references in XML models or projects 

 Manage authors and descriptions in XML models or projects 

 Purge audit trails in XML models or projects 

 Prepare files for use with Monarch 

The following sections describe how to use Monarch Utility to perform each of the functions 

listed above.  

Copying Models or Projects  
Monarch Utility allows users to quickly and seamlessly copy models or projects from one folder 

or another, provided that the destination folder has proper write permissions.  

Steps: 

1. Launch the Monarch Utility by selecting Start > All Programs > Datawatch Monarch > 
Monarch Utility. 

2. Select the button Copy models or projects from one location to another from the 
Monarch Utility wizard that displays. Click Next.  



 

 

Monarch 14.2 Learning Guide   403 

 

 

Figure 24-1. Monarch Utility allows users to copy models and projects from a source folder 

to a destination folder.  

3. In the next screen that displays, enter the path to the source folder containing the files 
you want moved to a destination folder in the Source Folder screen. You can use the 

Browse  button located beside this field to search for the appropriate folder.   

4. Check the box for Include subfolders if you wish to copy all subfolders as well.  

5. Enter the path to the destination folder to which you want files copied in the Destination 

Folder screen. You can use the Browse  button located beside this field to search for 

the appropriate folder.   
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Figure 24-2. Specifying source and destination folders. 

6. Click Next when you are finished.  

 

Figure 24-3. Instructions for the copy operation. 
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The next screen reiterates your instructions for the copy operation. Select Finish to 
proceed with copying if the indicated operation is correct. If you wish to make changes to 
the operation, select Back.  

A process log showing the status of the copy operation displays.  

Converting Text/XML Models or 
Projects to the Binary Format 
Previous Monarch builds saved models in the text and XML formats (e.g., .mod, .prj, .xmod, 

.xprj). Monarch introduces a change from the old XML formats for models and projects, and 
replaces these with binary DMOD and DPRJ formats. Monarch cannot save back down to the 
old XMOD and XPRJ formats but it can read them.  

Monarch Utility provides a means of converting previous model and project formats into the 
.dmod and .dprj formats without requiring that each model and project be opened in Monarch 

for faster data processing.  

Steps: 

1. Launch the Monarch Utility wizard and ensure that the button for Convert text/XML 
models or projects to Binary is selected. Press Next when you are finished.  

 

Figure 24-4. Monarch Utility allows users to convert text/XML models or projects to binary 

form.  
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2. In the next screen that displays, enter the path to the source folder containing the model 
and project files you want converted in the Source Folder screen. You can use the 

Browse  button located beside this field to search for the appropriate folder.  

3. Check the box for Include subfolders if you wish to convert the contents of all subfolders 
as well.  

4. Enter the path to the destination folder to which you want converted files to be placed in 

the Destination Folder screen. You can use the Browse  button located beside this 
field to search for the appropriate folder. 

 

Figure 24-5. Specifying destination folder for converted models. 

5. Select Next when you are finished.  
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Figure 24-6. Instructions for the conversion operation.  

The next screen reiterates your instructions for the conversion operation. Select Finish to 
proceed with conversion if the indicated operation is correct. If you wish to make changes 
to the operation, select Back.  

A process log showing the status of the conversion operation displays.  

Managing External References in Binary 
Models or Projects 
Monarch Utility enables you to manage external references in XML models or projects. For 
example, if a particular model contains a reference to an Access database, and the location of 

that database has changed, you can use Monarch Utility to update the reference to it in the 

model. 

Steps: 

1. Launch the Monarch Utility wizard and ensure that the button for Manage external 
references in binary models or projects is selected. Press Next when you are finished.  
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Figure 24-7. Monarch Utility allows users to manage external references to models or 

projects. 

The Specify Source Files screen displays. 

 

Figure 24-8. The Specify Source Files screen.  
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2. Under the Source heading, enter the path to the location of the XML models or projects 
you want to manage the external references of in the Folder field or click the adjacent 

Browse  icon and use the Browse for Folder dialog to locate it. 

3. Select the Include Subfolders check box to include all XML models or projects contained 
within any subfolders of the specified folder location. 

4. In the Filename field, enter the name of the model or project you want to manage external 
references in or enter a wildcard to include multiple models. Select Next when you are 
finished. 

The Examine and Modify External References screen displays. 

 

Figure 24-9. The Examine and Modify External References screen. 

5. Under the Show References To heading, select the check boxes for the items you want to 
modify the external references in (e.g., models, reports, etc.). The contents of the grid 
change to reflect the check boxes you have chosen. 

6. Make changes if necessary to the current references via the New References cells in the 

grid.  

7. Click the Next button to display the Task Summary screen. 
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Figure 24-10. Summary of the manage external references operation.  

8. Check the task summarized on the Task Summary screen and, if it is correct, click the 
Finish button. 

Managing Authors and Descriptions in 
Binary Models or Projects 
Monarch saves relevant information each time a Model or Project file is created. 

This information includes the author of the model as well as its description, all defined 
templates, fields, filters, sorts, and summaries, and general input settings, among others.  

In most cases, model/project information cannot be edited by design. However, Monarch 

Utility provides an easy way to change such information.  
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Figure 24-11. Viewing model information in Datawatch Monarch.  

Steps: 

1. Launch the Monarch Utility wizard and ensure that the button for Manage authors and 
descriptions in binary models or projects is selected. Press Next when you are 
finished.  

 

Figure 24-12. Managing authors and model/project descriptions in Monarch Utility. 
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2. In the next screen that displays, enter the path to the source folder containing the model 
and project files you want to edit in the Source Folder screen. You can use the Browse 

 button located beside this field to search for the appropriate folder.   

3. Check the box for Include subfolders if you wish to modify the authors and description 
of models and projects in all subfolders as well.  

 

Figure 24-13. Specifying a source folder for revised models or projects.  

4. Select Next when you are finished. 

The next screen displays all of the models and projects for which you can edit authors and 
descriptions. 
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Figure 24-14. A list of models or projects for which you may manage authors and 
descriptions displays.  

5. To find keyword(s) in any of the fields in this list, select the Find button, enter the 
keyword you wish to search for in the Find what field of the dialog that displays and then 

select Find Next. Continue selecting Find Next to see all instances in which your 
keyword(s) appears.  

 

Figure 24-15. The Find dialog.  

6. To replace an author name, select the Replace button. Enter the author name to be 
replaced in the Find what field of the dialog that displays and then enter the name of the 

name to be used as a replacement in the Replace with field. Select Replace to replace 

only the next instance of the name indicated in the Find what field or Replace all to 
replace all instances of this name.  
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Figure 24-16. The Replace dialog.  

7. Selecting the Replace all button yields the screen below. 

 

Figure 24-17. Summary of instructions for managing model/project authors and 
descriptions. 

You can also select the author name you wish to replace by highlighting it in the Author 
column of the model/project list and then typing in your replacement name. Select Next 

when you are finished.  

8. Press Finish to execute the replace all operation. 

To replace model/project descriptions, highlight the description of the model/project you 
wish to replace in the model/project list, type in your desired description and then select 
Next. You will need to select Finish in the next screen that appears to perform the 
replacement operation.  
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Purging Audit Trails in Binary Models or 
Projects 
Monarch keeps an audit trail of events for Model and Project files. 

The audit trail records the Author and the time, as well as changes to any model/project 
object, including templates, fields, filters, sorts, summaries etc. The audit trail also shows you 

changes made in the current Monarch session, which will be saved when you save the Model 
or Project. 

Without Monarch Utility, Monarch’s audit trail cannot be disabled or edited. 

Steps: 

1. Launch the Monarch Utility wizard and ensure that the button for Purge audit trail in 
binary models or projects is selected. Press Next when you are finished.  

 

Figure 24-18. Purging audit trails in binary models or projects with Monarch Utility.  

2. In the next screen that displays, enter the path to the source folder containing the model 
and project files you want to edit in the Source Folder screen. You can use the Browse 

 button located beside this field to search for the appropriate folder.   

3. Check the box for Include subfolders if you wish to modify the authors and description 
of models and projects in all subfolders as well.  
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4. Indicate a date to which the audit trail must be purged in the Purge All Entries Before 
Specified Date field. IMPORTANT: The audit trail will be purged up to the date you 
indicate. All activities from this date and later will not be purged.  

5. Select Next when you are finished.  

 

Figure 24-19. Specifying a date from which to start the purge operation.  

6. The next screen reiterates your instructions for the purge operation. Select Finish to 
proceed with purging if the indicated operation is correct. If you wish to make changes to 
the operation, select Back.  
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Figure 24-20. Instructions for the purge operation.  

Preparing Files for Monarch 
Monarch Utility enables you to prepare files for use with Monarch. The following file 
preparation methods are available: 

 Replace a string with another string or an empty one 

 Insert line breaks into continuous stream files 

 Insert line breaks into files with a long line length (e.g., more than 4000 characters) 

 Format EDI files to enable their easier processing via Monarch 

Steps: 

1. Launch the Monarch Utility wizard and ensure that the button for Prepare files for 
Monarch (Replace, Insert line breaks, EDI) is selected. Press Next when you are 

finished.  



 

 

418    Monarch 14.2 Learning Guide 

 

 

Figure 24-21. Preparing files for Monarch via Monarch Utility. 

The Specify Source and Destination Files screen displays. 

 

Figure 24-22. Specifying source and destination folders for prepared files. 
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2. In the Source Folder field, enter the path to the folder that contains the file(s) you want to 

prepare or click the Browse  icon and use the Browse for Folder dialog to locate and 
select it. 

3. If you want to move the prepared files to a different location, enter the path to the 

destination folder in the Destination Folder field (or click the Browse  icon and use the 
Browse for Folder dialog to select it). 

4. Click the Next button to display the File Preparation Settings screen. 

 

Figure 24-23. The File Preparation Settings screen. 

5. Specify the desired file preparation options. Click Next when you are done. 
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Figure 24-24. Summary of the file preparation operation. 

6. Review the task summary information and then click the Finish button to have Monarch 
Utility perform the task.  

Monarch Utility performs the specified task and then displays the process log. 

In the following figures, we used Monarch Utility to change the string “Betty Yoder” to 

“Betty Red.” 

 

Figure 24-25. Report before Monarch Utility preparation. Note that that contact name is still 
“Betty Yoder.” 



 

 

Monarch 14.2 Learning Guide   421 

 

 

Figure 24-26. Report after Monarch Utility preparation. Note that the contact name is now 
“Betty Red.” 
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Conclusion 

Congratulations! You have just completed the lessons in the Monarch Learning Guide. We hope 
you have found them to be a helpful introduction to Monarch’s capabilities.  

For additional information not covered in the Learning Guide, we suggest you thoroughly 
explore Monarch’s help system. To do so, select File, click on the drop-down button of the 

Help  menu, and then select Help Topics from the main menu. You may also click the 

Help  button on any dialog within Monarch to access context-sensitive help.  

Updated documentation is available in http://docs.datawatch.com.   

We also encourage you to visit the online Datawatch community at 
https://community.datawatch.com/welcome. 

Technical assistance is available to registered Monarch owners. Refer to the Appendix C - 

Contacting Technical Support section of the Monarch Help file for more information. 
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